
DiversityCollection 
DiversityCollection (Version 3) is part of the database framework DiversityWorkbench. Within
this framework the application DiversityCollection is confined to the management of specimens
in scientific collections. In this context it is designed to document any action concerning the
collection, storage, exchange and treatment of specimens in a collection and is also
appropriate to store observation data. DiversityCollection is distinguished from other collection
management systems by its focus on biological relations between organisms collected
together as one or more specimens (e.g. host, parasite and hyperparasite, symbionts etc.).
Any module within the Diversity Workbench is focused on a specific data domain.
DiversityCollection keeps only data connected with the handling of collection specimens and
observations. Data of other realms like e.g. taxonomy are handled in separate modules. For an
overview of the available modules see DiversityWorkbench. DiversityCollection might also be
used as a stand-alone application.   

The image below gives you an overview of the main parts of DiversityCollection. The 4 squares
indicate the possibility of a hierarchy where for example one organism can grow on another. 

The image below gives an overview of some typical data depicted in DiversityCollection
together with the symbols used throughout the program. A typical specimen may have been
collected at a CollectionEvent during an expedition . The site of the CollectionEvent may
be localized and characterized . The collectors collected twigs of the plant and fungi

from the roots. They store the samples as herbarium sheets and specimens preserved
by other methods in a collection . The manager sent some of the samples for which he
had a request from a requester to another collection. The samples were collected as part

Page 1

http://www.diversityworkbench.net/Portal/


of a project . Certain parts were cultivated , analysed and processed . The organisms
on the specimen were identified several times. Images were taken for the EventSeries,
the CollectionEvent, the CollectionSpecimen as well as organisms and part of this specimen.

 

DiversityCollection 3 is based on Microsoft SQL-Server 2008 and the .Net Framework, Version
3.5. 

For licence and copyright see the licence section. 
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Installation
To run DiversityCollection you need the database and the client. All parts can be downloaded
for free from http://www.microsoft.com/downloads/ and
http://www.diversityworkbench.net/Portal/. 

The image below gives an overview of the installations and files needed.

 

Client

The client is based on the .Net framework version 3.5 from Microsoft. If not already present,
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you need to install the framework first. Download and install the Microsoft .NET Framework
(e.g. dotnetfx35.exe)  - start the program and follow the installation instructions (see
http://www.microsoft.com/downloads/ for the latest versions). Version 2.0 is compatible with
older operating systems like Windows 2000. For later operating systems use the latest version
available. 

Download the files for DiversityCollection from http://www.diversityworkbench.net/Portal/
provided as a zip archive. Copy all files (DiversityCollection.exe , DiversityCollection.chm 
, DiversityWorkbench.dll  ) into your DiversityWorkbench directory. To print barcodes of the
font Code 39 the file Code39.ttf   must be copied to the folder C:\WINNT\Fonts. 

After the installation make sure to get the latest updates from 
http://windowsupdate.microsoft.com/.

 

Database

For the installation of a local database see the section Installation of the database.
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Menu
Overview of the menu in DiversityCollection

Connection

  Database ... Choose one of the databases available on the server. Only
databases to which the user has access permission will be listed.

  Module connections ...
Edit the connections to the other modules within the
DiversityWorkbench.

  Transfer previous settings
Transfer the settings for IP-Address and port of the server, name
of the database, login etc. of a previous version of the client to
the current version.

  Quit
Quit the application and stop all processes started by the
application.

Query
  Show query Show or hide the query list.
  Predefined queries All predefined queries will be listed.

  Scan mode
Change to scan mode to open the data set of a specimen by
scanning the barcode.

Grid

  Specimen ... Change to the grid mode to edit the data set of the Specimen in a
list.

  Organisms ...
Change to the grid mode to edit the data set of the Organisms in
a list.

  Parts ... Change to the grid mode to edit the data set of the
SpecimenParts in a list.

  Collection events ... Change to the grid mode to edit the data set of the
CollectionEvents in a list.

  Event series ...
Change to the grid mode to edit the data set of the
CollectionEventSeries in a list.

Data
  Import

         Import wizard ... Import data from tab-separated text files.

         Specimen scans ... Import scans of specimen labels.

         Import list ... Import tab-separated lists.

         Reimport list ... Reimport tab-separated lists which have been exported including
the key columns.

  Export
         Export list ... Export a tab-separated file with the data of the specimen.
         XML Export data as an XML-file.
         ABCD Export data as an XML-file according to the ABCD standard.

         GPI/JSTOR Export data as an XML-file according to the GPI/JSTOR standard.

         Floristic lists Export data in a specific format.
         BIB ... Export data according to the demands of the BIB portal.
         Naturgucker ... Export data according to the demands of the Naturgucker portal.
         CSV (bcp) Export data of the entire database as csv files.

         Cache DB Export data of selected projects into a cache database.
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         Withhold data Edit the withholding reasons for the selected data.

  Replication ... Synchronisze the content of 2 databases.

         Set server ...
Define the replication provider and server respectively for the
replication.

         Download ...
Download data from the data provider and server respectively in
your local database.

         Upload ...
Upload data from your local database to the replication provider
and server respectively.

         Clean database ... Clean your local database.

  Backup database ... Create a backup of the entire database.

  Transfer Transfer data sets.

         To project ... Transfer the selected specimen into an additional project.

         To transaction ... Transfer the selected specimen into an additional transaction.

  All annotations ... Edit all annotations in the database.

  Remove specimen ... Remove the selected specimen from the database.

  Remove from project ... Remove the selected specimen from an additional project.

  Save data set Save current data set.

Administration
  Change password ... Changing the password of a user.

  Analysis ... Administration of the analysis methods used for the specimens.

  Collections ... Administration used for the collections.

  Customize display ...
Customizing the display of the window e.g. the material categories
and taxoniomc groups which should be visible when creating a new
entry.

  Database Administration of the database.

         Descritption ...
Administration of the descriptions and messages within the
application.

         Documentation ... Documentation of the structure of the database.

         Logins ...
Administration of the logins of the server and their permissions in
the databases.

         Maintenance ...
Maintenance of database entries, especially, if connected to other
modules.

         Queries ... Creating and editing predefined queries.

         Rename database Rename the current database.

         Set published address Setting the address published for links by other modules.

  External datasources ... Administration of the external data sources of data imported into
DiversityCollection.

  Methods ... Administration of the methods used for CollectionEvents, Analysis
and Processing.

  Processing ... Administration of the processing procedures applied in the
collection.

  Projects ... Administration of the projects.

  Tools ... Administration of the tools used for analysis and processing.

  Transaction management Management of transactions, managers, loans etc.

         Transactions ... Administration of the transactions e.g. loans, exchange etc.

         Expired loans ...
Administration of expired loans. This menu entry will appear when
there are expired loans in collections where the current user is a
curator.

         Loan requests ... Administration of loan requests for the collections for which a user
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is a collection manager. This menu entry will appear when there
are loan requests for the managed collections where the current
user is a collection manager.

         My requests ...
Administration of the loan requests of a user. This menu entry will
appear when a user placed requests for specimen.

         Requesters ... User having the right to place requests for specimen of a
collection.

         Managers ... Administration of the users who manage collections and are e.g.
responsible for the administration of the transactions.

Help
  Manual Opens the online manual.

  Feedback ... Opens a window for sending feedback.

  Feedback history ... Opens a window for browsing former feedback.

  Statistics ... Overview of changes within the projects and edited specimen.

        Info Show the version of the program and corresponding information.

  Websites< /td> Websites related to DiversityCollection.

         Download applications ... Download DiversityCollection from the website of the
DiveristyWorkbench project.

         Information model ... Inspect the information model on the website of the
DiveristyWorkbench project.

         Diversity mobile ... Website of DiversityMobile, the mobile application for collecting
data stored in DiversityCollection.

Update 
  Update database ... Update the database to the current version.

  Update client ... Download the current version of the client.
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Manual

The online manual DiversityCollection.chm must be placed in your application folder
together with the application DiversityCollection.exe and the library DiversityWorkbench.dll. To
get information on any topic in the application DiversityCollection and to open this manual
simply click on the field you require information on and press F1. To open the manual from the
menu choose Help -> Manual.
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Version
For information on the version of the client application choose Help, Info...

The current version in the example above is 2.5.3.6. As an administrator you may set the
versions of the database and the client. Choose Administration - Versions from the menu.
A form will open as shown below giving you an overview of the version settings.
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Update of database and client
DiversityCollection is still in development. Therefore regular updates for the database and the
client will be provided. When you start the program and connect to a database, the program
will check, if it is compatible with the database or if the database needs an update. In any of
these cases an update entry in the menu will appear. If a new version of the client is
available, this menu will contain an update client ... entry. Click on it to open the webpage
where you may download the client as shown below. 

If you are the owner of the database (Database role = dbo) and the database needs to be
updated, the menu will contain an update database ... entry. Select this entry to open a
window as shown below to run the provided update scripts, delivered with the client software.
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These scripts need to run consecutively, so e.g. to update from version 2.5.1 to 2.5.4 you
either have to run the script DiversityCollectionUpdate_020501_To_020504 or the scripts
DiversityCollectionUpdate_020501_To_020502, DiversityCollectionUpdate_020502_To_020503
and DiversityCollectionUpdate_020503_To_020504. The program will guide you through these
steps and check for the scripts. All you need to do is click the Start update button.  
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License
This manual is copyrighted work licensed under a Creative Commons License.

All material in this manual is the property of the contributing authors and fully copyrighted. By
choosing this way of publication, the contributing authors have agreed to license the work
under a Creative Commons License permitting reproduction, distribution, and derivative works,
requiring attribution, notice, and share-alike, and prohibiting commercial use.

 

For information about the license of the client software choose Help, Info...

The client software is free software: you can redistribute it and/or modify it under the terms
of the GNU General Public License as published by the Free Software Foundation. 

The client software is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU General Public License (GPL) for more details. 
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Feedback
If you have suggestions for improvement, need any changes in the program or encounter an
error you can give a feedback to the administrator. Click on the [ALT] and [PRINT] buttons to
get a screen shot of your current form. After creating the screen shot choose Help -
Feedback from the menu to open the feedback window as shown below.

 

Click on the button to insert the screen shot and give a comment about your

problem. Then click on the button to send your feedback to the administrator. If
you would like to receive a message when the problem you described is solved, please enter
you e-mail address in the field below the description. 

To inspect your former feedbacks choose Feedback history... from the menu. A window
will open where you can browse your past feedback together with the state of progress. 

In case you do not have access to the central database for the feedbacks the program will
open your mail client to send an e-mail. In case of bugs in the program it would be helpful, if
you attached the file DiversityCollectionError.log located in your application directory (see
image below). 

Error logging
If any error messages show up while working with the application, you can find further
details concerning the part of the application where the error occured and the parameters
involved in the file DiversityCollectionError.log located in your application directory. 
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Tutorial - first steps
This tutorial will guide you through the first basic steps to enter a single data set in
DiversityCollection. After the installation, make sure you have access to the database. To
start the programm double click on the DiversityCollection.exe in the directory where you
copied the files of DiversityCollection. The main window will open.

 

If you open this window for the first time, you need to connect to the database. Click on the 
button or choose Connection -> Database... from the menu. A window will open where

you may enter your account information and choose the database (see image below, for
further information see database access). 
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After connecting to the server and choosing a database click on the OK button to return to
the main form. As indicated by the symbol in the right upper corner, you are now connected
to the database. The tooltip of the button will show your current login information (see
below). 

 

This tutorial is continued in the sections listed below. 

 section New data set
 section CollectionEvent
 section Localisation
 section CollectionEventSeries
 section CollectionSpecimen
 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - Creation of a new data set 
To enter a new data set click on the button in the upper left panel (see point 1 in image
below). In case of accession numbers being available in the database, the software will ask
whether you wish to take the next free number (see accession for further information). If you
click on the OK button, the program will try to find the next free accession number starting
with your current accession number. 

Finally you will find a new entry in the specimen list on the left and the trees for the specimen
(see point 2 in image below) and the storage as shown below.  

 

If you did not specify an accession number, the entries will look like in the image above,
otherwise the accession number will be shown. To enter your data for the specimen click on
the entry in the upper tree as shown below (see point 3 in image below). This will open the
fields where you may enter the details for the specimen in the area on the right of the tree
(see point 4 in image below).
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In the panel in the middle of the form several buttons will appear where you may enter
additional information for this specimen. 

With these buttons you may enter information for the:
- CollectionEvent 
- CollectionSpecimen 
- Relation between specimen 
- Organisms and identifications 

This tutorial is continued in the sections listed below. 

 section CollectionEvent
 section Localisation
 section CollectionEventSeries
 section CollectionSpecimen
 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - CollectionEvent 
To enter information about the CollectionEvent (when and where the specimen was collected)
click on the button (see point 1 in image below). 

   

This will add an entry for the CollectionEvent in the upper tree as shown below. Select this
entry in the tree (see point 2 in image below) to open the fields for the CollectionEvent. To
see the projected contents of any data field simply place your mouse in the field. An
explanation will appear as for the field Description of the locality:

 

See the Event part for further details. 

Then enter the date (see point 3 in image below) of the CollectionEvent. If you click on the
drop-down button as shown in the image below, a calendar will open where you may select
the date. Then enter the description of the locality (see point 4 in image below). To store the
data entered so far click on the button (see point 5 in image below).
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Now you have the possibility to enter more details about the locality like coordinates, named
places, etc. by clicking on the button (see point 6 in image above).

This tutorial is continued in the sections listed below. 

 section Localisation
 section CollectionEventSeries
 section CollectionSpecimen
 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - Localisation 
To enter more information on the CollectionEvent like coordinates, named places, etc. click on
the button (see image below). 

 

Now you may select an option from the following list:

 

The three most important options are:
- New Coordinates WGS84
- New Named Area (Diversity Gazetteer)
- New Altitude (mNN)

 

New Coordinates WGS84

You may add the exact coordinates for the locality with the assistance of Google Maps. Click
on the button (see first image of this site) and choose New Coordinates WGS84 (Google
Maps uses WGS84). This will add a new entry in the overview. Select it (see point 1 in the
image below) to open the details for this entry. Here click on the button (see point 2 in
image below). 

Page 21



 

A window will open as shown below where you may set the coordintes simply by dragging the
map with your mouse. The coordinates correspond to the center of the map, symbolized with
the . Click on the OK button to store the coordinates.
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In the main window the coordinates will be stored at two positions - see image below. In the
upper area you may set the values and choose a different format for display as shown here -
the more familiar form with degrees, minutes and seconds. Change the values and click on
the button to change the original entry. At the same time the numeric values are stored in
fields which can not be edited by the user (see below). If not already present, the program
using the webservice GeoNames will enter the altitide and the name of the closest named
locality.  

 

 

New Named Area (Diversity Gazetteer)

To enter a name of a place using the DiversityGazetteer choose New Named Area
(DiversityGazetteer) from the list. In the overview tree in the middle of the window an entry
will be inserted as shown below. Select it to open the detail fields for this entry (see point 1
in image below). 
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To open the connection to the DiversityGazetteer click on the button (see point 2 in image
above). A window will open as shown below. Enter a search string - for example the city you
wish to find (see point 3 in image below) - and start the query with a click on the button
(see point 4 in image below).

 

In the middle of the form the results of the query will be listed. Select one of these. To guide
you to the correct entry details to this place are listed in the area right of the list. The base
will show a map corresponding to the coordinates connected to this entry. After selecting the
correct entry (see point 5 in image above) click on the OK button to return to the main
window (see point 6 in image above). As shown below the data retrieved from the gazetteer
will be written in several areas. Next to the name of the place the DiversityGazetteer provides
the coordinates and the country as shown below.
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The area where you entered the name now changed to a locked state and will prevent you
from changing the entry (see image below). Next to the field with the place you find the link
to the external module. Double-click it for more details. 

 

If you wish to remove the connection to the external module click on the button. This will
keep all entries (country, place, coordinates) but remove the connection to
DiversityGazetteer. 

 

New Altitude (mNN)

As a last information about the locality we enter the altitude. Click on the button (see first
image of this site) and choose New Altitude (mNN) (see point 1 in the image below). Select
the new entry in the overview to open the data fields (see point 2 in the image below). Let's
suppose you have only feet values available - change the display format to feet (see point 3
in the image below). Enter your values (see point 4 in the image below) and click on the 
button (see point 5 in the image below) to save your entries. Now your values are converted
to meter (the internal format of DiversityCollection) automatically. If you now change the
display format to meter, you can see the result. The program calculates an average value for
the altitude and accuracy in meter corresponding to the accuracy of your original values (see
below). The original values of your entry are saved in the Notes field. 
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This tutorial is continued in the sections listed below. 

 section CollectionEventSeries
 section CollectionSpecimen
 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - CollectionEventSeries
If you wish to organize your CollectionEvents, you may use the CollectionEventSeries. To
create a new EventSeries select the ColletionEvent (see point 1 in image below) and click on
the button (see point 2 in image below).  

 

In the tree the entry for the new EventSeries will appear (see point 3 in image below). Select
this entry in the tree to enter the details about the EventSeries (see point 4 in image below).

   

To build a hierarchy for your CollectionEvents and CollectionEventSeries choose the created
EventSeries in the tree (see point 1 in image below) and create a new secondary EventSeries
(see point 2 in image below). 

Then enter the date (see point 5 in image below) of the CollectionEvent. If you click on the
drop-down button as shown in the image below, a calendar will open where you may select
the date. Then enter the description of the locality (see point 6 in image below). To store the
data entered so far click on the button (see point 7 in image below).
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Select the entry of the new EventSeries (see point 3 in image below) and enter the details of
the EventSeries (see point 4 in image below).

 

Finally drag the CollectionEvent to its position within the hierarchy of the
CollectionEventSeries entries (see point 5 in image below). 

 

To include an extisting event in a hierarchy of the CollectionEventSeries select the
CollectionEvent and click on the button. For more details see the section 
CollectionEventSeries.

 

This tutorial is continued in the sections listed below. 

 section CollectionSpecimen
 section Collector
 section Collection specimen relations
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 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - CollectionSpecimen 
To set the accession number for the CollectionSpecimen select it in the overview (see point 1
in image below) and enter the accession number (see point 2 in image below).  

 

To search for the next free accession number click on the corresponding button as shown
above (see point 3 in image above). A window will open as shown below. Start the search for
a free accession number. If the query ended successful, click OK to include the new
accession number in your data set.

 

Project

To restrict the access to your data set add it to a project (click on the button - see point 4
in image above). A dialog will open where you may select a project from the projects defined
in DiversityCollection (see image below). The project will then be added to the list of the
projects for this specimen. 
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This tutorial is continued in the sections listed below. 

 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - Collector 
Collectors

Now we will add the collectors of the specimen. In the overview select the specimen and click
on the button to insert a new collector (see point 1 in image below). Select the collector in
the overview (see point 2 in image below). Now we use the module DiversityAgents to search
for a certain person. Click on the button to open the interface of the module (see point 3 in
image below).

 

In the interface for DiversityAgents enter search criteria (see point 1 in image below) and
click on the button to start the query (see point 2 in image below).

Select the correct entry from the query result (see point 3 in image above) and click on the
OK button (see point 4 in image above) to store the name in DiversityCollection. 

The next collector will have no connection to the module DiversityAgents. To insert this
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collector click on the button again (see point 1 in image below) and select it (see point 2 in
image below). Type the start of the name in the field for the name (in this example "Mei"

would be a good choice) and click on the drop-down button (see point 3 in image below)
to select a name from the list of collectors already stored in the database. Finally if the
collector has a field number, enter said number (see point 4 in image below). 

 

 

This tutorial is continued in the sections listed below. 

 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - Relations between specimen  
There are two types of relations possible:

1. relation to a specimen within DiversityCollection
2. relation to a specimen not administrated in the local database.  

 

1. Internal relations

To enter a relation to a specimen in DiverisityCollection select the specimen in the tree (see
point 1 in image below) and click on the button (see point 2 in image below). 

 

A window will open where you can search for the related specimen. In the window enter your
restrictions (see point 1 in image below) and start the query (see point 2 in image below).
Select the related specimen from the result list (see point 3 in image below) and click OK (see
point 4 in image below) to insert the relation.

 

In the window select the entry for the relation (see point 1 in image below) to display the
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fields for the details. Then enter the type of the relation (see point 2 in image below).  

 

 

2. External relations

To enter a relation to a specimen in a foreign collection insert a relation (see point 1 in image
below) and select it in the overview (see point 2 in image below). Enter the name of the
specimen (see point 3 in image below) and the type of the relation (see point 5 in image
below).

 

If there is a data set for the collection available you may select it from the list (see point 4 in
image above). Otherwise you first have to add this collection to the list. If you have
permission to edit the collections, choose Administration -> Collections from the menu to add
a collection. See the section Collection for details. 

For further information on relations turn to the section Relation.
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This tutorial is continued in the sections listed below. 

 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - Organisms and identifications
To focus on the specimen and its organisms hide all other entries from the tree by clicking on
the corresponding buttons (see point 1 in image below). To enter the organism choose the
specimen entry in the tree (see point 2 in image below). Then select the organism from the 
list.

 

This will insert an entry for the organism underneath the entry of the specimen (see
image below). To enter details for this organism select the entry in the tree (see point 3 in
image below and image above). 

To enter an identification for this organism select it in the tree (see point 4 in image above)
and click on the button (see point 5 in image above). This will insert a data set for the
idenfication of the organism underneath the organism as shown above. Select this entry to
enter the details of the identification.

To enter more organisms living on the plant select the plant in the tree (see point 1 in
image below) and create new organisms as described above (see point 2 in image below). 
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Now let's enter the taxonomic name of the plant. Select the entry for the identification in
the tree (see point 1 in image below). As a simple method to enter a taxonomic name simply
type it in the field Tax. name (see point 2 in image below). To save the data set and display
the taxonomic name in the tree click on the button (see point 3 in image below). 

Now insert an identification for the fungus (see point 1 in image below).  
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Select the identification in the tree and click on the button (see point 2 in image above) to
open a remote query as shown below. Choose the database DiversityTaxonNames_Fungi (see
point 1 in image below), enter the conditions for the query, e.g. the beginning of the
taxonomic name (see point 2 in image below) and start the query (see point 3 in image
below). From the result list select the taxonomic name (see point 4 in image below) and click
OK (see point 5 in image below) to transfer the selected name to the main form.  

The name of the selected taxon together with the link to the datasource (see image below)
will be inserted in the field for the taxonomic name. The taxonomic name can not be directly
edited as long as the name is linked to a datasource (indicated by the yellow background). To
remove the link you need to use the button. To see the entire information on the linked
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name as stored in the datasource click on the button.

As as an example for the last variant enter an identification for the insect (see below). Select
the identification in the tree (see point 1 in image below) and click on the button (see
point 2 in image below) to open a remote query. 

A window for the access to webservices and other modules will open as shown below. Here
select CatalogueOfLife (see point 1 in image below) as a datasource. This will query the
webservice of Catalogue of Life for a taxonomic name. Enter the beginning of the taxonomic
name (see point 2 in image below) and start the query (see point 3 in image below). From
the result list select the taxonomic name (see point 4 in image below) and click OK (see point
5 in image below) to transfer the selected name to the main form. 
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The name of the selected taxon together with the link (see image below) to the data source
will be inserted in the field for the taxonomic name. The taxonomic name can not be directly
edited as long as the name is linked to a data source (indicated by the yellow background).
To remove the link you need to use the button. To see the entire information on the linked
name as stored in the data source click on the button.

 

 

This tutorial is continued in the sections listed below. 

Page 41



 section Specimen parts and storage
 section Searching the database
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Tutorial - Specimen parts and storage
To enter the data connected with the storage of the specimen select the specimen entry in
the bottom tree view (see point 1 in image below). In the command panel at the right of the
tree view a button will appear where you may select the type of the stored material. In the
hierarchy select "herbarium sheets" as shown below (see point 2 in image below). 

A dialog will appear where you are required to enter the collection where your specimen are
stored (see below).

Select the collection from the list or the hierarchy and click OK to close the dialog. The
bottom tree will now contain the selected material with all organisms (see below).
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Let's assume that the insect is not present in the specimen, but e.g. has only been observed
during the collection of the sample. To document this remove the entry for the insect from
the Show in label list to the Units not in part list: Select it (see point 1 in image above) and
remove it (see point 2 in image above) (click on the < button). The result is shown below.

To see the exact position within the collection click on the button at the left side of the
tree. The tree will change as shown below where all the collections and subcollections
together with the parts of the specimen are listed (see below).
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To print a label for a stored part of the specimen select it in the tree (see point 1 in image
below) and click on the button in the upper right corner to open the area for the label (see
point 2 in image below). Click on the button (see point 3 in image below) to select a
Schema file (e.g. Standard.xslt). Then click on the button to generate a label (see point 4
in image below). 

Turn to the Section part for more details.
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This tutorial is continued in the sections listed below. 

 section Searching the database
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Tutorial - Query
To search for data in the database use the query sector in the left part of the window. To
select the query conditions click on the button in the top panel. A window will open as
shown below.

 

With the Maximum number of results you may limit the package size which should be
retrieved from the server. For a slow connection to the database server choose a low value
(e.g. 100 as set by default). 

The Limit for drop-down lists restricts the maximum number of drop-down lists which should
be created. For a slow connection to the database server choose a low value. The default is
set to 0 which means no drop-down lists will be created.

Click on the Check none button to clear the previous selection. Then select the entries 

 Project -> Project
 Specimen -> Accession number of specimen
 Specimen -> The user who created the data set
 Specimen -> The date when the data set was created
 Event -> Collection date
 Organism -> Organism present
 Organism -> Only observed
 Storage -> Material category
 Image -> Type

Click OK to close the window. Your query conditions will be displayed as in the image below.
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Project -> Project: Here you may choose from a list of possible entries. Select your current
project.

Collection specimen -> Acc. Nr.: From the operator drop-down list choose "~" and enter
the first letters of your accession number. You may include wildcards. Other options are e.g.
"-" for a range or ">" for a lower limit. The conditions will be interpreted as text! So 2 will
appear after 10 etc.

Collection specimen -> Creat. by.: From the operator drop-down list choose "=" and
choose your user name from the list.

Collection specimen -> Cre. dat.: From the operator drop-down list choose "=" and choose
the current date with the help of the calender.

Collection event -> Date: >From the operator drop-down list choose "=" and enter the
current year in the last field.

Organism -> Presence: From the operator drop-down list choose "•" which means that an
organism is present.

Organism -> Only obs: Uncheck the checkbox to find organisms which were not only
observed.

Part of a specimen -> Mat.cat.: Use the button on the right of the combobox to open the
hierarchy and select "herbarium sheet".

After all query conditions are set, click on the button to start the query. In the result list
you should find the specimen created in this tutorial. To save you current query click on the 

button on the left of the button. A window will open as shown below. For more details see
the section Save query. 
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Queries - overview
To search for specimens in the database you may choose from 3 options:

With the user defined queries you may define any query condition - this is the default query
mode. You may save and load these queries. 

The predefined queries are defined by the system administrator and are accessible via the
menu Query - Predefined queries. To return to the user-defined queries click on the Show
query conditions button.

With the scan mode you may use a barcode scanner to search for a specimen. To work with
the scan mode select the Scan mode in the Query menu. To return to another query mode
deselect the Scan mode.
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Result list
The result list displays the specimens found in a query.

The specimens may be displayed with their accession number, their identifications or their
storage location etc. as shown in the images above. To view further information on the
chosen field simply place the mouse in the field. A text box will appear with the description of
the field (see below). 

 

You may restrict the maximum number of specimens and query options (click on the 
button), if you have for example a slow connection to the database. As a default the
maximum number is set to 100. If the number of data sets according to your query is higher
than the maximum value set in the query options, it will be indicated in the header of the list. 

To ensure that restrictions set in the query conditions will be applied to the specimen list
make sure that you choose matching restrictions and order columns as shown below. In the
upper example corresponding fields were used for restricting the query and the display (Tax.
name). Here the query results will be restricted to said field. 
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In the second example a different field for the restriction was chosen (Last ident. <> Tax.
name). The query result in consequence will list all data sets with entries found in the field
Tax. name and entries which match the restriction (see below).

 

To search for specimens enter the restrictions in the fields for the search conditions and click

on the button. The specimens found in the database will be shown in the result list. To

add specimens with differing search conditions click on the button. If the list of items is
longer than your maximum number of returned items you may browse the next items with the 

button. If you wish to remove entries from the selected list, choose them in the list and

click on the button. This will not delete the data from the database but remove them
from your query result.

Here are some examples you may select for display in the result list:

AccessionNumber: One entry is shown for each specimen with its corresponding accession
number.

Last identification: The last identification for every unit in a specimen is shown in the list. As
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there can be several units in one specimen, several entries for one specimen may appear in
the list.

Storage location: The storage location of every part of a specimen stored in the collections is
shown in the list. As parts of a specimen can be stored in several collections under different
names, several entries for one specimen may appear in the list.

Collecting number: The collecting number given by the collector of every sample of a specimen
is shown in the list. A specimen may have several collectors each with a different number.
Therefore, several entries for one collection specimen may appear in the list.
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Query
There are two ways to search for specimens in a collection. The options for a fast search are
displayed in the main window beneath the list of the items. You may change this arrangement

using the / button to place the query options on the left side of the item list.

To search for specimens enter the restrictions in the fields for the search conditions and click

on the button. The specimens found in the database will be shown in the specimen list. To

add specimens with differing search conditions click on the button. To clear all entries in

the query fields use the button. You may save and load the queries you define using the
and buttons. If the list of items is longer than your maximal number of returned items, you

may browse the next items with the button. To move back to the previous block of items

click on the button. If you wish to remove entries from the selected list, choose them and

click on the button. This will not delete the data from the database, but remove them
from your query result. With the and buttons you may change the order of the results
between ascending and descending

Within the query options you have several possibilities to specify your search restriction. Use
the drop-down menu to switch between operators. The available operators are shown in the
table below. 

Operator Meaning Example
Text
∼ search for an entry like ... Pinus s[iy]lvestris % (you may use wildcards)

= search for an entry exactly equal to ... Pinus silvestris L.

≠ search for an entry not like ... Pinus s[iy]lvestris % (you may use wildcards)
∅ search for an entry where a value is missing ...
• search for an entry where a value is present ...
- search for an entry between ... and ... 2000 - 2005
| search within a list of entries, separated by "|" 2000 | 2003 | 2005
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Numeric
= search for an entry exactly equal to ... 2006
< search for an entry lower than ... 2006
> search for an entry higher than ... 2006
- search for an entry between ... and ... 2000 - 2005
| search within a list of entries, separated by "|" 2000 | 2003 | 2005
∅ search for an entry where a value is missing ...
• search for an entry where a value is present ...
Date
= search for an entry exactly equal to ... 20.3.2006
< search for an entry lower than ... 20.3.2006
> search for an entry higher than ... 20.3.2006
∅ search for an entry where the date is missing ...

• search for an entry where the date is present and complete
...

Hierachy
= search for an entry exactly equal to ... M-Fungi
≠ search for an entry which is not equal to ... M-Fungi
∅ search for missing entry ...
• search for present entry ...
Δ search including children in a hierarchy ... M-Fungi
XML
/ Search for entries containing a given XML node settings
¬ Search for entries not containing a given XML node settings
∅ search for missing entry ...
• search for present entry ...
Geography
Use button to set geography
‡ Search for entries with a maximal distance of ... POINT(24.24 45.243) | 50 km
O Search for entries within an area POLYGON(34.5 ...
¤ Search for entries outside an area POLYGON(34.5 ...
• search for present entry ...

For yes/no fields exists a checkbox with 3 options: = yes, = no, = undefined

For a search within a list (using the "|" operator) you may double click in the text field to open
a window where you can enter your values. To separate the values either use the "|" sign or
a new line as shown in the image below. 
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Query annotation

The query for annotations deviate from the standard query (see below). Additionally, you may
specify a type of the annotation (Annotation , Problem , Reference ) and the linked
table (see Annotation). 

To hide the area containing the search fields click on the button. If the search area is

hidden and you wish to start a new search, simply click on the button.

To change the displayed fields for searching specimens click on the button to change the
query options.

Scan mode

To search for a specimen with the help of a barcode-scanner select the Scan mode from
the Query menu. The query part will be hidden and the field for the accession number will be
accessible for the entry via the scanner. If the field for the entry of the accession number 

is not activated, move the mouse to the field to activate it. Once you
scan the barcode the program will start the search for the specimen in the database.

Grid mode

To edit the data in a data grid choose the Grid mode from the Query menu. The query part
will be hidden and a table will appear where every data set from the query result list is
restricted to one line. Please keep in mind, that in this view, you can only see a limited part of
the data. For example, you will only see the last identifications for an organism. The selection
of the visible fields can be adapted in the tree above the list. 

To replace a part of a text in a column select the column, enter the text which should be
replaced and enter the replacement in the corresponding fields (see below). To start the
replacement click the button. 
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Save query
If you wish to save a current query, click on the button. A window will open as shown
below where you may specify the title and description of you query.

After you entered title and description of the query, click OK to specify the query group. A
window will open as shown below.
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Choose a group from the tree or create a new one and click OK. The new query will be
included in the selected group. 
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Finally, you may edit the titles and descriptions of the groups and queries. Click the button
to store the changes. To delete items from the tree select the item and click on the button.
Click OK to save the new query and close the window.

Load query
If you wish to load a query which has been stored previously, click on the button. A window
will open as shown below. 
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Choose a query from the tree and click OK to close the form and filter the data sets according
to the selected query.
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Query options
The maximum number of items shown in a query result may be set in the window for the query
options. The default value is set to 100. If you have a fast connection to your database or
need to see a different number of results, you may change this value to any number.
To change the displayed search fields click on the button. This opens a form where you can
select and deselect the fields shown for searching specimens. You might also change the
maximum number of items which will be shown in the result list. 

The limit for the creation of drop-down lists is by default set to 0. This means no drop-down
lists will be created. If you set the limit to e.g. 1000 and connect to a database, the
programm will create a drop-down list based on the entries in the database. For slow
connections you may set this to a lower value to speed up the start of the program. If you
set the value to 0, no drop-down lists will be created.

To search for a field within the database use the search function which will check the names
and descriptions of the fields and mark them as shown below. 
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After having edited the query options click OK to store you selection. The new selection will
become active for the next query. 
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Wildcards in SQL
There are 4 different possibilities for wildcards in SQL:

%    any string consisting of no, one or many characters, e.g. Pinus % will find anything like
Pinus, Pinus sylvestris, Pinus strobus etc. 

*     any string consisting of no, one or many characters, e.g. Pinus * will find anything like
Pinus, Pinus sylvestris, Pinus strobus etc. 

_     a single character, e.g. Pinus s_lvestris will find Pinus sylvestris and Pinus silvestris etc. 

[]      any character out of a given range like [abcde] or [a-e], e.g. Pinus s[iy]lvestris will find
Pinus sylvestris and Pinus silvestris. 

[̂ ]   any character not in a given range like [̂ abcde] or [̂ a-e], e.g. Pinus s[̂ i]lvestris will
find Pinus sylvestris but not Pinus silvestris. 
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Predefined queries
Besides setting queries for specimens via the query options you may define separate
predefined user-specific queries. These are listed in the menu topic Query - Predefined
queries.  

If you choose one of these predefined queries, the query options will be hidden and the
command of the query will be shown at the base of the specimen list. The first line shows the
title of the query, the next lines contain the description followed by the part of the query
command which restricts the selection of the data sets (= WHERE-clause of the
SQL-statement).

 

To return to the user-defined query click on the Show query conditions button. 

If you are an administrator, you may create new queries for users. To create a predefined
query choose Administration - Queries... from the menu. A window will open as shown
below, where you may create, edit and test your queries.
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In the upper field you define the WHERE-clause of the SQL string of your query. Keep in mind
that the queries can refer to different tables, depending on the order column chosen by the
user. Thus, queries in DiversityCollection should start with the reference to the primary key of
the main table (CollectionSpecimenID in table CollectionSpecimen and depending tables). The
lower field contains the description for the query as shown in the user interface. To test a
query use the [Test count] and [Test query] buttons.
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Editing the data
The main window of the DiversityCollection client contains two main areas. On the left you
find the query and the results of this query. On the right the data of the data set selected in
the results list is shown. The upper part of the data area shows images, labels etc. In the
lower part you find two trees that give you an overview and access to the data. The data of
an entry selected in one of the trees is shown in the data editing section. 

Common comments

To see the descriptions of the fields, just move the mouse over the field you want to know
more about. A tip-text window will open, showing the description of the expected content of
this field (see image below). These desriptions are also available in the documentation for the
tables. 

 

The description of some of the drop-down fields are too long to be shown in the drop-down
column. However, for a selected entry you can place your mouse over the hierachy selector.
A tip-text window will appear (see image below) where the full text of the description is
shown. 
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Grid mode
To edit the data in a data grid choose the Grid mode for the specimen , the organisms

, the CollectionEvents or the CollectionEventSeries from the menu. A window will open
where every data set from the query result list is restricted to one line for a specimen, an
organism, a CollectionEvent or a CollectionEventSeries respectively. Please keep in mind you
can only see a limited part of the data while in this view. For example only the last
identification of an organism will be displayed. This is demonstrated in the image below where
two organisms, indicated with the red arrows, will not appear in the grid. If you use the grid
mode for the organisms, all organisms will appear with their last identification. 

 

Customize visibility of fields

The selection of the visible fields can be adapted in the tree above the list. Change the
selection of the columns and click on the [Set columns] button. 

 

 

Customize column width and sequence

To adapt the width of the columns or the height of the rows either drag the border with the
mouse or double click the border to get the optimal size for one column. You may also click on
the button for an optimal height of the rows or the button for an optimal width of the
columns. To change the width and sequence of the columns simply use your mouse to drag
the columns to the position of your choice or adapt the width to your preference. These
changes will be saved for this session as well as for the next time you use the grid mode. To
return to the original sequence of the columns click on the [Reset sequence] button. 
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Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

 

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text which should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. To append a string to all entries in the
selected fields click the button. To remove all entries from the selected fields click the 
button. 

 

Transfer from spreadsheet

You can transfer data from a spreadsheet e.g. Excel or Calc. Copy the columns of this data
from the spreadsheet and then insert it in DiversityCollection. Click in the upmost left cell
where this data should be transferred to and use the context menu (click the right mouse
button) to insert the data. 

 

Editing

Some columns can not be edited directly but are linked to external modules or services. These
columns appear as buttons. Simply click on the button to call the service. If a value is linked
to an entry in an external module, the background will change to yellow and you will not be
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able to change the text. 

 

Together with the links (in the example above Link to DiversityAgents) you can select columns
that provide the posibility to release the links to the modules (e.g. Remove link for collector in

image above). These columns will appear as buttons . Simply click on the button related to
a link to release the link to the corresponding module. After that you can edit the text field
containing the linked value.

Some values are linked to a list of values. Use the drop-down list to change the value in one
of these columns. 

If you click in the empty line at the base of the data grid, you will be asked if you wish to
create a new data set. The program will ask you for a new accession number and the project
of the new data set. Another way to create a new data set is the copy button . Simply
click in the line you wish to create a copy of and then click on the copy button . For details
see the Data section. A copy of the data set will be inserted at the base of the data grid. 

In the grid view for the organisms a part of the columns can not be edited. These columns
contain data which can be related to several organisms. This is indicated by a gray
background. 

 

Saving the data

To save all changes click on the button. To undo all changes since the last time the data
sets were saved click on the button. To save the changes in the current data set use the

button. To undo the changes in the current data set click the button. If you click the
[OK] button, you will be asked whether you would like to save the changes before the window
will be closed. If you click the [Cancel] button or close the window your changes will not be
saved. To save the data shown in the grid in a tab delimited file click on the button. 
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Grid mode for CollectionSpecimen
To edit the data of the specimens in a data grid choose the Grid mode for the specimen 
from the menu. A window will open where every data set for a specimen from the query result
list is restricted to one line. Please keep in mind you can only see a limited part of the data
while in this view. For example only the last identification of an organism will be displayed. This
is demonstrated in the image below where two organisms, indicated with the red arrows, will
not appear in the grid. If you use the grid mode for the organisms, all organisms will appear
with their last identification. 

 

Customize visibility of fields

The selection of the visible fields can be adapted in the tree above the list. Change the
selection of the columns and click on the [Set columns] button. 

 

 

Customize column width and sequence

To adapt the width of the columns or the height of the rows either drag the border with the
mouse or double click the border to get the optimal size for one column. You may also click on
the button for an optimal height of the rows or the button for an optimal width of the
columns. To change the width and sequence of the columns simply use your mouse to drag
the columns to the position of your choice or adapt the width to your preference. These
changes will be saved for this session as well as for the next time you use the grid mode. To
return to the original sequence of the columns click on the [Reset sequence] button. 
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Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

 

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text that should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. If the selected column is a link to a module
or webservice, a button will appear where you can search for a linked data set. The insert
will set the selected column and related columns according to the linked data set. Thus, if you
choose e.g. a value from the DiversityGazetteer, the coordinates and the country will be
changed as well. Click on the link to see all related information. To reset the link use the 
button. To append a string to all entries in the selected fields click the button. To remove
all entries from the selected fields click the button. 

 

Transfer from spreadsheet

You can transfer data from a spreadsheet e.g. Excel or Calc. Copy the columns of this data
from the spreadsheet and then insert it in DiversityCollection. Click in the upmost left cell
where this data should be transferred to and use the context menu (click the right mouse
button) to insert the data. 

 

Editing

Some columns can not be edited directly but are linked to external modules or services. These
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columns appear as buttons. Simply click on the button to call the service. If a value is linked
to an entry in an external module, the background will change to yellow and you will not be
able to change the text. 

 

Together with the links (in the example above Link to DiversityAgents) you can select columns
that provide the posibility to release the links to the modules (e.g. Remove link for collector in

image above). These columns will appear as buttons . Simply click on the button related to
a link to release the link to the corresponding module. After that you can edit the text field
containing the linked value.

Some values are linked to a list of values. Use the drop-down list to change the value in one
of these columns. 

If you click in the empty line at the base of the data grid, you will be asked if you wish to
create a new data set. The program will ask you for a new accession number and the project
of the new data set. Another way to create a new data set is the copy button . Simply
click in the line you wish to create a copy of and then click on the copy button . For details
see the Data section. A copy of the data set will be inserted at the base of the data grid. 

In the grid view for the organisms a part of the columns can not be edited. These columns
contain data which can be related to several organisms. This is indicated by a gray
background. 

 

Saving the data

To save all changes click on the button. To undo all changes since the last time the data
sets were saved click on the button. To save the changes in the current data set use the

button. To undo the changes in the current data set click the button. If you click the
[OK] button, you will be asked whether you would like to save the changes before the window
will be closed. If you click the [Cancel] button or close the window your changes will not be
saved. To save the data shown in the grid in a tab delimited file click on the button. 

 

Inserting new data

To insert a new data set simply click in the last empty line of the data grid. The programm
may ask you to specify a project in which the new data should be placed. In the grid for the
organisms a window will open as shown below. 
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Here you have the option to insert the new data set of the organism in the last specimen in
the grid or to create a new specimen for the organism. In the second case you can specify
the accession number of the new specimen. Use the [Find Acc. Nr.] button to search for the
next free accession number in the database which matches your entry in the [Accession
number] field.

For new data sets you can specify certain project settings e.g. the material category of a
part of the specimen. The taxonomic group of a new organism will correspond to the first
organism in your last specimen unless you specify a certain taxonomic group in the project
settings for the project you are working in. To enter or change a setting you need the
module DiversityProjects. For further information please turn to the documentation provided
with this module. 

 

Copy data

To copy a data set select the line of the data grid you wish to create a copy of and click on
the button. A window will open where you can choose several options for your copies. In
the first tab choose in which way the CollectionEvent - if present - for the new data sets
should be created.  
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In the Accession number tab you can search for or enter the accession number you wish to
use for your new data set (see below).
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In the Number of copies tab you can specify the number of copies. If you checked Create
an accession number for the new data set, the program will list all accession numbers
which will be created (see below).

 If you do not wish to create new accession numbers for the copies the list will not be shown
(see below). 

Page 76



 

  

Page 77



Grid mode for the organisms
To edit the data of the organisms in a data grid choose the Grid mode for the organisms 
from the menu. A window will open where every data set for an organism from the query result
list is restricted to one line. Please keep in mind you can only see a limited part of the data
while in this view. For example only the last identification of an organism will be displayed.  

 

Customize the window

To change the width and sequence of the columns simply use your mouse to drag the columns
to the position of your choice or adapt the width to your preference. These changes will be
saved for this session as well as for the next time you use the grid mode. To return to the
original sequence of the columns click on the [Reset sequence] button. 

To adapt the width of the columns or the height of the rows either drag the border with the
mouse or double click the border to get the optimal size for one column. You may also click on
the button for an optimal height of the rows or the button for an optimal width of the
columns. 

The selection of the visible fields can be adapted in the tree above the list. Change the
selection of the columns and click on the [Set columns] button. 

 

Analysis

In this grid you can edit up to 10 different types of analysis, however, only the last analysis
will be shown for each type. By default the available analysis types will be generated
dynamically depending on the data. If you need an additional type in the grid, simply return to
the main form and enter the required type in one of the data sets. If you wish to specify
which analysis you want to see in the grid, you can set the list in the options. Click on the 
button to open a window as shown below. 
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Here you can restrict the range of the dates of the analysis and the types of the analysis
which should be displayed. To change the entries in the list use the and buttons to add
or delete entries. 

 

Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

 

Handling the data

Some columns can not be edited directly but are linked to external modules or services. These
columns appear as buttons. Simply click on the button to call the service. If a value is linked
to an entry in an external module, the background will change to yellow and you will not be
able to change the text. 

 

Together with the links (in the example above Link to DiversityAgents) you can select columns
that provide the posibility to release the links to the modules (e.g. Remove link for collector in

image above). These columns will appear as buttons . Simply click on the button related to
a link to release the link to the corresponding module. After that you can edit the text field
containing the linked value.

Some values are linked to a list of values. Use the drop-down list to change the value in one
of these columns. 

If you click in the empty line at the base of the data grid, you will be asked if you wish to
create a new data set. The program will ask you for a new accession number and the project
of the new data set. Another way to create a new data set is the copy button . Simply
click in the line you wish to create a copy of and then click on the copy button . For details
see the Data section. A copy of the data set will be inserted at the base of the data grid. 

In the grid view for the organisms a part of the columns can not be edited. These columns
contain data which can be related to several organisms. This is indicated by a gray

Page 79



background. 

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text which should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. To append a string to all entries in the
selected fields click the button. To remove all entries from the selected fields click the 
button. 

To save all changes click on the button. To undo all changes since the last time the data
sets were saved click on the button. To save the changes in the current data set use the

button. To undo the changes in the current data set click the button. If you click the
[OK] button, you will be asked whether you would like to save the changes before the window
will be closed. If you click the [Cancel] button or close the window your changes will not be
saved. To save the data shown in the grid in a tab delimited file click on the button. 

To copy a data set select the line of the data grid which you wish to create a copy of and
click on the button. A copy of the selected data set will be added at the base of the
spreadsheet.  
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Grid mode for the parts of the specimen
To edit the data of the parts in a data grid choose the Grid mode for the Parts...  from
the menu. A window will open where every data set for a part from the query result list is
restricted to one line. Please keep in mind you can only see a limited part of the data while in
this view. For example only the last processing or analysis of a certain type of a part will be
displayed. 

 

Customize the window

To change the width and sequence of the columns simply use your mouse to drag the columns
to the position of your choice or adapt the width to your preference. These changes will be
saved for this session as well as for the next time you use the grid mode. To return to the
original sequence of the columns click on the [Reset sequence] button. 

To adapt the width of the columns or the height of the rows either drag the border with the
mouse or double click the border to get the optimal size for one column. You may also click on
the button for an optimal height of the rows or the button for an optimal width of the
columns. 

The selection of the visible fields can be adapted in the tree above the list. Change the
selection of the columns and click on the [Set columns] button. 

 

Analysis

In this grid you can edit up to 10 different types of processings, however, only the last
analysis will be shown for each type. To specify which analysis you wish to see in the grid
click on the button to open a window as shown below. 

Here you can restrict the range of the dates of the analysis and the types of the analysis
which should be displayed. To change the entries in the list use the and buttons to add
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or delete entries. For taxonomic groups which miss certain types of analysis the columns will
be blocked. 

 

Processing

In this grid you can display up to 5 different processings, however, only the last processings
will be shown. You can define a time range for the processings which should be displayed and
/ or restrict the processing to a certain type (see image below). For material categories which
miss certain types of processings the columns will be blocked. 

 

Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

Selecting of the data

To restrict the data in the grid you can filter an entry. Select the entry for which you want to
filter and click on the button. To remove data from the grid select the rows which should be
removed and click on the   button.   

 

Handling the data

Some columns can not be edited directly but are linked to external modules or services. These
columns appear as buttons. Simply click on the button to call the service. If a value is linked
to an entry in an external module, the background will change to yellow and you will not be
able to change the text. 
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Together with the links (in the example above Link to DiversityAgents) you can select columns
that provide the posibility to release the links to the modules (e.g. Remove link for collector in

image above). These columns will appear as buttons . Simply click on the button related to
a link to release the link to the corresponding module. After that you can edit the text field
containing the linked value.

Some values are linked to a list of values. Use the drop-down list to change the value in one
of these columns. 

If you click in the empty line at the base of the data grid, you will be asked if you wish to
create a new data set. The program will ask you for a new accession number and the project
of the new data set. Another way to create a new data set is the copy button . Simply
click in the line you wish to create a copy of and then click on the copy button . For details
see the Data section. A copy of the data set will be inserted at the base of the data grid. 

In the grid view for the parts a part of the columns can not be edited. These columns contain
data which can be related to several parts. This is indicated by a gray background. 

 

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text which should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. To append a string to all entries in the
selected fields click the button. To remove all entries from the selected fields click the 
button. 

To save all changes click on the button. To undo all changes since the last time the data
sets were saved click on the button. To save the changes in the current data set use the

button. To undo the changes in the current data set click the button. If you click the
[OK] button, you will be asked whether you would like to save the changes before the window
will be closed. If you click the [Cancel] button or close the window your changes will not be
saved. To save the data shown in the grid in a tab delimited file click on the button. 

To copy a data set select the line of the data grid which you wish to create a copy of and
click on the button. A copy of the selected data set will be added at the base of the
spreadsheet.  
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Grid mode for the CollectionEvents
To edit the data of the CollectionEvents in a data grid choose the Grid mode for the
event from the menu. A window will open where every data set for a CollectionEvent from
the query result list is restricted to one line. Please keep in mind you can only see a limited
part of the data while in this view. For example only a part of the localisation will be displayed
(see below). 

 

Customize the window

To change the width of a column simply use your mouse to adapt the width to your
preference. To hide or show parts of the window use the button for the setting of the
visible columns, the button for the hierarchy tree and the button for the images in the
upper right corner of the window. If the hierachy tree is visible ( , see below), you have
access to the CollectionEventSeries which are linked to the CollectionEevents. Here you can
edit the hierarchy via drag & drop. Please keep in mind that ramifications within the hierarchy
can only be realized using EventSeries with CollectionEvents placed within and specimen

placed within the CollectionEvents. To insert a new EventSeries use the button below
the tree. 
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To change the width and sequence of the columns simply use your mouse to drag the columns
to the position of your choice or adapt the width to your preference. These changes will be
saved for this session as well as for the next time you use the grid mode. To return to the
original sequence of the columns click on the [Reset sequence] button. 

 

Customize visibility of fields

The selection of the visible fields can be adapted in the tree above the list. Change the
selection of the columns and click on the [Set columns] button. 

 

 

Sorting of the data
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To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

Formatting the grid

To adapt the width of the columns or the height of the rows either drag the border with the
mouse or double click the border to get the optimal size for one column. You may also click on
the button for an optimal height of the rows or the button for an optimal width of the
columns. 

 

 

Handling the data

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text which should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. To append a string to all entries in the
selected fields click the button. To remove all entries from the selected fields click the 
button. 

 

Editing

Some columns can not be edited directly but are linked to external modules or services. These
columns appear as buttons. Simply click on the button to call the service. If a value is linked
to an entry in an external module, the background will change to yellow and you will not be
able to change the text. 

 

Together with the links (in the example above Link to DiversityAgents) you can select columns
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that provide the posibility to release the links to the modules (e.g. Remove link for collector in

image above). These columns will appear as buttons . Simply click on the button related to
a link to release the link to the corresponding module. After that you can edit the text field
containing the linked value.

Some values are linked to a list of values. Use the drop-down list to change the value in one
of these columns. 

 

Saving the data

To save all changes click on the button. To undo the all changes since the last time the
data sets were saved click on the button. To save the changes in the current data set use
the button. To undo the changes in the current data set click the button. If you click
the [OK] button, you will be asked whether you would like to save the changes before the
window will be closed. If you click the [Cancel] button or close the window your changes will
not be saved. To save the data shown in the grid in a tab delimited file click on the 
button. 
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Grid mode for the CollectionEventSeries

To edit the data in a data grid choose the Grid mode for the CollectionEventSeries from
the menu. A window will open where every data set for a CollectionEventSeries from the query
result list is restricted to one line (see below).  

 

Customize the window

To change the width of a column simply use your mouse to adapt the width to your
preference. To hide or show parts of the window use the button for the setting of the
visible columns, the button for the hierarchy tree and the button for the images in the
upper right corner of the window. If the parts are shown, the icon will have red backgound

e.g. .

History and feedback

To inspect the history of a data set click on the button. A window will open as described in
the History chapter. To send a feedback use the  button. Details are described in the
Feedback chapter. 

Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
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arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

 

Handling the data

To save the changes click on the button. To insert new data sets use the button for a
CollectionEventSeries and the button for a CollectionEvent. 
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CollectionEvent
Specimens stored in a collection are gathered during a CollectionEvent. This CollectionEvent
keeps information about the geographic locality, the habitat, the collection date etc. During a
CollectionEvent several specimens may have been collected. To create a new event for a
specimen click on the button. If a specimen has not been assigned to a CollectionEvent,
you can assign the specimens to an existing event with a click on the button. If you assign
the specimen to an existing event, a window will open where you can search for the events
already included in the database as shown below. Choose an event and click OK to assign the
specimen to this event. If you click OK without selecting any CollectionEvent, the current
CollectionEvent will be removed from the CollectionSpecimen.

 

In the tree view the CollectionEvent is symbolized by a icon as shown below. 

 

The CollectionEvents can be organized in a hierarchy either by using CollectionEventSeries or
sampling plots. If your CollectionEvents belong e.g. to an expedition, you should preferably
use CollectionEventSeries for the organization. 

 

If your samples are taken e.g. on a regular basis from permanent sampling plots, you may
prefer to use the module DiversitySamplingPlots to document the geography and other details
of the sampling plots and use the CollectionEvents only to document the collection date. 

 

To edit the data of the CollectionEvent choose it in the tree view to open the detail fields as
shown below. If the collection date does not correspond to a certain day, you may use the 
Suppl. field to enter e.g. a range or a series of dates or the T.span field to document a
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certain time span.

 

The text shown in the tree view is composed of the date of the CollectionEvent and the
description of the locality. For each CollectionEvent you can enter several geographical
locations and properties. To see the locality according to the coordinates stored in the
database you can check the Maps. For each CollectionEvent you can enter images related to
this event.

If other specimens were collected during the same CollectionEvent, they will be displayed
once the entire hierarchy of the EventSeries is shown. To do this click on the button in the
panel on the left side of the tree. See EventSeries for further details. You can also move a
specimen to another event by drag and drop. 

Besides of a plain text description of the methods used during the CollectionEvent, you may
insert methods as defined in the chapter Methods. Use the and buttons to add or remove
methods from the list (see below)

Data is stored in the table CollectionEvent. 
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CollectionEventSeries
If you need a hierarchical order of your CollectionEvents or to organise your CollectionEvents
e.g. to document expeditions respectively, you can do this with a CollectionEventSeries . For
a better differentation between events and CollectionEventSeries you have a blue text in the
hierarchy as well as the editing part and a different icon . A CollectionEventSeries can
contain other CollectionEventSeries and CollectionEvents. Information about the geographic
locality, properties of the collection site, date of collecting etc. is stored in the  
CollectionEvent. To show or hide the CollectionEventSeries you have two options. In the panel
of the left of the tree the button will show the superior EventSeries of the current
CollectionEvent as shown below. 

 

The button will show the entire hierarchy of the EventSeries as shown below.

 

To edit the data of an EventSeries select it in the tree to display the detail fields as shown
below.

New EventSeries

To insert a new CollectionEventSeries click on the   button. If there are no
CollectionEventSeries so far, the CollectionEvent will be placed within the new
CollectionEventSeries. If there are CollectionEventSeries present, the new
CollectionEventSeries will be placed below the selected CollectionEventSeries. To assign an
CollectionEvent to an existing CollectionEventSeries already available in the database click on
the icon.

To move an item within the hierarchy just drag it with the mouse to whatever position it
should be placed in. Keep in mind that specimens can only be placed in CollectionEvents and
CollectionEvents only in CollectionEventSeries.
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Removing EventSeries

If you want to delete a CollectionEventSeries or a CollectionEvent, remove all depending
CollectionEventSeries, CollectionEvents and specimens and click on the  button. A specimen
can not be deleted here. 

If you want to remove a CollectionEvent from a CollectionEventSeries, click on the 
button to open the window for selecting a CollectionEventSeries. Then select nothing but
simply click OK to remove the link to the CollectionEventSeries. 

Images

The images for a CollectionEventSeries are displayed below the data of the
CollectionEventSeries (see below). To add images to a CollectionEventSeries click on the 
button, to remove an image use the button. 

 

To zoom a sector of the image simply move the mouse over the image. A red square will
indicate the zoomed area. To set the size of the image to the original resolution click on the 

button. To adapt the size of the image to the available space in the form click on the 

button. To change the orientation of the image use the appropriate buttons ( flip

horizontally, flip vertically, rotate right, rotate left). To view the image in a separate
form click on the button. If the image should not be published e.g. on the internet, enter
any reason in the Withhold reason field. Besides images you can also store other media. 

Hierarchy

If you want to change to another specimen listed in the CollectionEventSeries, select it in the
hierarchy and click on the  button. 

The current specimen together with the event and all superior CollectionEventSeries will be 
highlighted. 

Geography

The CollectionEventSeries can contain a geographical object (using WGS84) such as a point, a
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line, an area etc. To edit or show the geographical object related to the CollectionEventSeries
either click on the button in the details next to the notes field or click on the button in

the control to show the maps and use the GIS editor .

Storage

The data of the CollectionEventSeries is stored in the table CollectionEventSeries. 
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Event images
The specimens stored in a collection are gathered during a CollectionEvent. To insert an image
related to a CollectionEvent click on the  button. If you want to delete an image, click on
the  button.  For more details see the section Images.

If for any reason an image should not be published i.e. shown on a website, enter the reason
in the field Withholding reason. Only images where this field is empty will be shown e.g. on
websites. 

Data is stored in the table CollectionEventImage .
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Geography
As additional information to the description of the locality you can use several localisation
systems, e.g. georeferencing. These entries are marked with a icon in the tree as shown
below.

 

To add a new entry choose the localisation system from the drop-down list as shown below.
Only items which are not already set for a CollectionEvent will be shown. The items visible in
the drop-down list can be customized. 

If a localisation should be removed, select it from the list and click on the  button.

 

GIS editor

To define an area for the locality you can use the GIS editor. For further details please see
the help sections for the corresponding pages.

 

Coordinates (WGS84)

If you use geo-coordinates as georeferencing system (coordinates WGS84), a button  will
appear which will provide you with the possibility to set or correct the coordinates via Google
Maps. Just click on the  button and a window will open with a map provided by Google Maps
as shown below. If there are already coordinates provided by a different localisation e.g. by
the DiversityGazetteer, these will be taken as a starting position. Thus, you may use an entry
for a named area (DiversityGazetteer) as an approximate localisation and use additional
coordinates for a more accurate localisation. 
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If you start with existing geographic coordinates (WGS84) in your data, the system will use
these as starting point. You can zoom the map, drag it to another position and change from
map to satellite mode. The actual position is symbolized by the  symbol in the middle of
the map. The current coordinates are shown in the field at the buttom of the map. To include
these coordinates in your data simply click OK.

With the Set start coordinates button you can set the coordinates which GoogleMaps
should use as a starting position.

Please keep in mind that Google Maps coordinates are based on WGS84. 

If there are no entries for the altitude and the named area, this data will be retrieved from the
webservice ws.geonames.org and entered into the database. The source will be documented
in the Notes field. Subsequent changes in the coordinates using the GoogleMaps function will
update the altitude and named area entries provided they are derived from a webservice
(ws.geonames.org) as documented in the Notes field. 

Please keep in mind that the place names provided by ws.geonames.org may differ from
those depicted in GoogleMaps.

 

To enter the localisations listed above simply enter the Coordinates WGS84, the Altitude
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and Named area will be added automatically.

 

 

Named areas - DiversityGazetter

To edit the details of an entry select in the list to open the fields in the form on the right. The
localisation system DiversityGazetteer is linked to the module DiversityGazetteer within the
DiversityWorkbench and providing information on geographical names as shown below.  

 

 

TK25 (MTB) 

If you choose MTB or TK25, the button will open a window where you can set the TK25 as
well as the quadrant (see image below). Choose the quadrant depending on your preferred
resolution. The thick line shows the current quadrant, the thin line the entire TK25. The
needle in the center is placed at your current position. If you click on it, a message box will
display the TK25 information as shown below. 
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If you click [OK], the TK25 values together with the coordinates of the center of the selected
quadrant will be entered into the database.

 

Conversion of values 

The values for any localisation system are stored in two text fields. You can enter your values
as simple text. This may, however, prevent any calculations with said values. Thus, you
should preferably enter your values according to the measurement units available. Whatever
obsolete measurement units like feet or Fahrenheit may exist, within the DiversityWorkbench
measurement data is stored in units according to the Système International d'Unités (SI). For
those who still need to use these obsolete units DiversityCollection provides a possibility to
convert them into their modern counterparts. To enter a numeric value choose the unit you
prefer from the list. The form will change as shown below.

 

You can then edit the values and click on the  button to incorporate the changed values
into your data. The system will calculate the corresponding value for storage in the database
together with the default accuracy. You may correct this accuracy if you have more exact
values. To indicate that the shown values are calculated from the values in the database the
fields have a green background. When you save the data DiversityCollection will store
geographic coordinates and the average altitude, if available, in separate fields.

The altitude, the exposition or the slope may be entered as one value or as a range of two
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values. If you use the conversion function and have only one value, make sure that the
second field is empty.

Available units: meter and feet. 

Available units: Orientiation (N, NE,
... ) and degree rel. to North. 

Available units: degree and
percent. 

The accuracy and uncertainity respectively will be calculated as an approximation in parts
derived from Wieczorek, J. 2001 (MaNIS/HerpNet/ORNIS Georeferencing Guidelines. University
of California, Berkeley: Museum of Vertebrate Zoology) and in parts according to Wieczorek,
J., Q. Guo, and R. Hijmans 2004 (The point-radius method for georeferencing locality
descriptions and calculating associated uncertainty. International Journal of Geographical
Information Science 18: 745-767). The unit of the accuracy will always be the unit stored in
the database according to the Système International d'Unités (SI) and degrees for angles
respectively.

The data for the geography is stored in the table CollectionEventLo calisation. 
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Maps of samples in the database
If there are WGS84 coordinates available for your collection site, an event series or single
organisms, you can use GoogleMaps to display these locations.

To use this service you need access to the internet. Click on the button in the 
control to show the maps. Here you can display maps of CollectionEventSeries, 
CollectionEvent, Organism as well as Distribution maps. To display the maps you can
either use the browser, the GIS viewer or the GIS editor. By default the map will show
the location of the CollectionEvent using the browser as shown below. 

For the CollectionEventSeries, the CollectionEvent or the Organism you can use any
geographical object like points, lines, areas, etc. to describe the location. The browser will
always display these objects as points (see left image below) whereas with the GIS editor you
can see and edit the real objects (see right image below). 
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The data of the geographical objects is stored in the table CollectionEventSeries for the
collection event series,the table CollectionEventLo calisation for the colletion event and the
table IdentificationU nitGeoAnalysis for the organisms.
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Sampling plots
If your samples are collected at constant sampling plots, you may use the module
DiversitySamplingPots to describe said SamplingPlots. For a better differentation between
events and the SamplingPlots there is a brown text in the hierarchy as well as a different icon

. A SamplingPlot can contain other SamplingPlots and CollectionEvents. Information about
the geographic locality and properties of the collection site can be stored in the SamplingPlot,
while the collecting date must be stored in the CollectionEvent. To show or hide the
SamplingPlots you have two options. In the panel on the left of the tree the button will
show the superior SamplingPlots of the current CollectionEvent as shown below. 

 

The button will show the entire hierarchy of the SamplingPlots as shown below.

 

If you select a SamplingPlot in the hierarchy, two buttons will appear in the bar to the left of
the tree. With the button you can retrieve a taxon list for the SamplingPlot. With the 
button you can retrieve a summary of the information on a SamplingPlot (see image below). 
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To edit the data of a SamplingPlot please use the module DiversitySamplingPlots.

The link to the module DiversitySamplingPlots is stored in the table CollectionEventLo
calisation. 
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Habitats and properties of the collection site
For the description of the habitat select the CollectionEvent or an existing collection site
property . The description is entered in the field Description of the habitat (see below).

To enter a new property of the collection site select the CollectionEvent or an existing
collection site property . Then choose the type of the property you wish to enter from the
drop-down menu as shown below. Only items which are not already set for a CollectionEvent
will appear in the list. You can customize the selection of visible items. 

 

The list is dependent on the availability of terminologies for site descriptions. Details for the
property can be entered if you choose the item in the hierarchy. The person responsible for
the entry as well as notes can be entered in the corresponding fields as shown below.

 

To delete entries use the  button. You can enter a value by either typing the name of the
collection site property or by selection from the module DiversityScientificTerms. To search for
properties from this module click on the  button. The current user's name will be inserted as
the responsible user. You may change this by either typing or through selection from the
module DiversityAgents.

The data concerning the habitats is stored in the table CollectionEventProper ty.
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Specimens
Specimens are the entities stored in a collection. For handling the data use the appropriate
buttons (new specimen ,copy , delete ). See the Data section for further details.
Directly attached to the specimen is the data about accession, label, exsiccatae, notes,
reference and the availability. A specimen may be composed of several units. Any problems
concerning the specimen should be entered into the problems field. 

The header of the main window shows some important parameters for the selected specimen.
On the left side the accession number is shown. In the center you find the last identification
of the main IdentificationUnit according to the display order. The next field shows the internal
IDs (field CollectionSpecimenID in table CollectionSpecimen and CollectionEventID in table
CollectionEvent) and the Versions for the specimen and the CollectionEvent. For details
about the version of a data set see the Version topic. The availability of a specimen can be
changed by entering an appropriate reason in the field Withholding reason. 

If the specimen is a type, the header will show the type state and the identification
connected with the type (see below).

To inspect the history of a specimen click on the button. For further details see the History
section.

With the buttons you may control the upper part of the window with the maps , the
images for the CollectionEvent and the Specimen as well as the label print . The

buttons, with the corresponding sector visible in the window, are depicted with a red 
background. If there are images available and they are hidden, the background will turn

yellow . 

The data is stored in the table CollectionSpecimen . 
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Data
The controls for handling data sets in the database are located in the left upper part of the
window as shown in the image below. A step-by-step introduction for the creation of new
data sets is provided in the Tutorial.

- To SAVE the changes in a data set click on the button. If you select another data set
from the results list, the current changes will be saved automatically.

- To UNDO the changes in a data set, click on the button. This will recover the original
data unless the changes have been saved or changes were done in certain tables or
hierarchies were the data must be stored to display the hierarchy.

- To create a NEW entry in the database click on the button. This will create a new
record of a specimen and show it in the results list.

- To COPY the data of a specimen record choose it from the list and click on the button.
If you want to create multiple copies of your specimen, use the corresponding function in the 
grid mode. If the specimen you want to copy is linked to a collection event, a window will
open and provide you with several copy possibilities as shown below. 

The field [New accession number]: You can change this number manually or search for
another number using the [Find the next free accession number after:] button. If you
change the accession number to a value that is already present in the database, you will get
a warning and the color of the field will change as shown below.

If you do not want to create an accession number, just uncheck the [Create an accession
number for the new dataset] checkbox. By default all organisms and identifications will be
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copied into the new data set. If you dont want to copy this infomation, uncheck the [Copy
all organisms and identifications into the new data set] checkbox. 

If the original data set contains information about the collection, you have 3 options to handle
the data. By default the new specimen will be placed into the same collection event, which
means no new data set for the collection event will be created (see image below). The
second option will create a copy of the original data for the collection event and connect the
copy of the specimen record with the new event. The last option will only copy the specimen
data and establish no connection to any collection event. If you decide not to copy anything,
just close the window. 

After all options are set just click the OK button to create the new entry.

 

- To DELETE a data set select it in the list and click on the button.
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Tree for the specimen
The upper tree in the window provides an overview for all the data linked with the specimen.
With the buttons in the left panel you may hide or show certain nodes in the tree. If for
example you do not wish to see the collectors, simply click on the button and they will be
hidden in the tree. The button will change to a grey version and the background will turn
yellow to show that there is hidden data of the collectors. 

If the CollectionEvent is part of a CollectionEventSeries, a drop-down button will appear
where you may select between 3 states: 

 = show the parent EventSeries
 = show the entire hierarchy of the EventSeries

 = hide the EventSeries

If the CollectionEvent is linked to a SamplingPlot, a drop-down button will appear where you
may select between 3 states: 

 = show the parent SamplingPlots
 = show the entire hierarchy of the SamplingPlots

 = hide the SamplingPlots

If both options are available, you may choose between the CollectionEventSeries or the
SamplingPlot hierarchy. If the entire hierarchy for the EventSeries or the SamplingPlots is
displayed, the items not inculded in the current data set will be desplayed with gray icons,
e.g. . To change to one of these use the button. For the Events, the EventSeries, the
Plots and the Specimen a button will appear which will give you access to a taxon list of
the selected item. 

The panel on the right side of the tree is for editing the data, for example the button will
insert a new collector. For further details see the special sections.  
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Display order
The display order defines the sequence in which the units within this specimen will appear on
e.g. a label. The first unit will be printed in the header of the label, others are included in the

text below. You can change the display order by using the  buttons. If a unit should
not appear on the label, transfer it to the hide list using the  button. The  button
returns it to the list to be shown on a label. The first unit can not be transferred to the hide
list. The upper section shows the display orders of the units within the whole specimen. The
lower section shows the display orders in a specimen part. If you print a label without
reference to a part, the display order for the entire specimen as in the upper section will be
used. This part is also accessible if you click on the button in the right panel of the upper
tree, which will appear if you e.g. select the specimen.     

If you print a label with reference to a part, the display order for the part as in the lower
section will be used. This area will be shown when you select a specimen part in the lower
tree. In addition to the display order you can specify whether an organsim is present in a
selected part of a specimen.
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Accession
The accession of a specimen in a collection is documented with its accession number and the
date of the accession if available.

If the specimen was received from another collection, this may be documented with the name
of the depositor and the number in the original collection (Dep.Nr). 

If the current project (= as selected in the query list) contains a duplicate of the accession
number, a button will appear. This gives you the opportunity to switch to the specimen with
the duplicate accession number .

If a new specimen is entered you can use the button to search for the next free
accession number. A window will open as shown below, where you can begin the search. The
search will start with the number you provide as a starting point. 

 

The system will try to find the next free number based on the accession numbers available in
the database. As accession numbers can be assigned to a specimen as well as a part of a
specimen, you have the option to include accession numbers in both places in the query. Click
OK to use the recommended number for the specimen.

Data concerning the accession and deposition are stored in the table CollectionSpecimen.
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Specimen images

To see the specimen images activate the icon in the image selector . If you choose
the option View - Show existing images from the menu, the images will automatically be
shown. Each specimen may be documented with several images. The images may be stored
locally with its path or as a reference to the module DiversityResources within the
DiversityWorkbench. To enter a new image click on the button. For more details see the
section Images.

To delete an image select it from the list and click on the button (see below).

To document the relation of an image to an organism or a part of the specimen choose the
corresponding entries from the drop-down lists. To restrict the display of the images to either
images which are related to a certain part or a certain organism within the specimen click on
the button in the corresponding areas. The buttons will receive a red backgroud    to
remind you of the restriction. Next to the image list a button will appear which enables you
to show all images again. 

To enter a description for an image click on the button (see the chapter Image description
for further details).

The data is stored in the table CollectionSpecimenIma ge.
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Projects
Every CollectionSpecimen may be assigned to any number of projects. To assign a specimen
to a project click on the button. To remove it from a project select the project from the list
and click on the button.

 

If there are projects, to which you have no access to, these will be listed in a separate list at
the top as shown below.

 

To transfer all selected specimen into an additional project choose Data -> Transfer -> 
To project... from the menu. A window will open where you can select the project to which
the specimen should be added.

To remove all selected specimen from an additional project choose Data -> Remove from
project... from the menu. A window will open where you can select the project from which
the specimen should be removed. The last project in which a specimen is placed can not be
removed.

 

The data is stored in the table CollectionProject.

Details of the projects within the DiversityWorkbench are stored in the database
DiversityProjects. To access further information on a project click on the button. To edit
details in projects you require the application DiversityProjects.exe in your application
directory and access to the database DiversityProjects. To synchronize the projects listed in
DiversityProjects you may use the synchronize function in the user administration window as
shown below. If DiversityProjects is not available, you may create a new project by clicking
the button. If DiversityProjects is available, use the synchronize function

.
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The ER-chart below shows all tables with direct relations to the project tables. For more
details see the sections Analysis, Processing and Image description.
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Notes and problems
To enter notes or problems connected with the specimen select it in the hierarchy. The data
form will open the corresponding fields. The Original notes are the notes found on the label of
the specimen, made by the original collector or from a later revision. Additional notes are
those made by the editor of the specimen record, e. g. doubtful identification or locality. 

In the Problems area enter the description of a problem which occurred during data editing.
Typically these entries should be deleted after help has been obtained. Do not enter scientific
problems here. Use Additional notes for such permanent problems! 

The data is stored in the table CollectionSpecimen.

For notes on data created by users with no permission for editing see the chapter Annotation
.  
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Organisms and identifications
Each specimen can contain several organisms and each organism may have been identified
several times as shown in the image below.

 

To see the list of organisms within a Specimen, CollectionEvent, EventSeries or SamplingPlot
use the taxon list function.
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IdentificationUnit
The items or organisms in one CollectionSpecimen are regarded as IdentificationUnits. One
specimen can contain several IdentificationUnits e.g. an insect (1) feeding on a fungus
(2) growing as a parasit on a plant (3). To add a new organism use the drop-down menu as
shown below to select the taxonomic group to which the new organism belongs to.

 

To specify the taxonomic groups that are shown in the drop-down menu select Administration
- Customize display ... from the menu. 

The organisms of the specimen are shown in the tree. To edit the relations between the
organisms simply drag and drop. The name of the organism under which the specimen is stored
in the collection is underlined. To delete an organism select it in the tree and click on the 
button.

To enter details about one of the organisms like e.g. gender or life stage, select it in the tree.
The fields for the details of this organism will be displayed in the right area of the window as
shown below. 

A description for an IdentificationUnit can be entered with the unit, where you can type your
description. You may also use the combobox to select a description as found for the same
taxonomic group in the database or select a predefined description from a hierarchy. An
additional description can be entered for an IdentificationUnit within part of a
CollectionSpecimen.

Taxonomic hierarchy - family and order

The entries for the family and the order of the taxon are either set when linking to a
taxonomic database or set manually when no link to a taxonomic database exists.
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If no link to a taxonomic database exists you may enter the family and the order after clicking
on the button. To transfer these entries to other specimens with the same genus use the
maintenance functions as described under Maintenance - family and order.

Parts of units

If a unit contains parts which have to be documented, you can do this by setting the relation
to the substrate to "Part of". 

 

In the tree the backgroud of a part will be grey as shown below for the unit-tree und the tree
depicting the storage of a sample. The name of the part will correspond to the identifier set
for this part. The icon will correspond to the description of the part provided you choose one
of the preset options contained in the drop-down list. You may of course enter any
description for the unit. A unit that is part of another unit can not get an identification.
Identifications are restricted to the main unit.

  

 

Parent-child relations

If a unit is a child of a parent in the genetical sense, choose "Child of" as type of the relation.
If there are 2 parents like mother and father that you want to document, click on the 
button next to the relation type. A window will open where you can choose among the
organisms (= units) in your sample. The second parent will be indicated with the symbol in
the tree (see below). 

For details about exsiccatal series and analysis see the related topics. You can sort your
IdentificationUnits e.g. for display on a label with the display order button. Each
IdentificationUnit can have several identifications.

If there are images which are related to the current organism, the button for the restriction of
the images will be enabled ( → ). Click on it to restrict the images to this organism. The
button will get a red backgroud   to remind you about the restriction and in the image list a
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button will appear that enables you to show all images.

The data for the organisms is stored in the table IdentificationUnit.
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Analysis
The organisms in a specimen can be analysed by analysis types defined in the database. In
the tree the analysis entries are symbolized with a icon. Only the types of analysis that
were assigned to the group of the organism can be selected. An analysis always refers to an
organism and may also refer to a part of a specimen. An analysis that refers to a part of a
specimen will be shown in the tree for the parts as shown in the examples below. 

To show or hide the analysis items in the tree use the button in the left panel. This button
has 3 states. In the default state the analyis entries will be shown as above. If you click 
a second time it will change to the hierarchy mode and the entries will appear as shown in
the tree below. The last state will hide the entries.

To insert a new analysis select the organism which has been analysed in the upper tree. Then
select the type of the analysis from the drop down list as shown below. 

To delete an analysis, select it in the tree and use the button in the panel on the left. To
edit the details of an analysis, select it in the tree and enter data into the fields as shown
below. To enter or inspect an URI given for a single analysis, click on the button. 

If an analysis refers to a part of the specimen, you can document this by choosing the
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respective part from the list (see field Part above). The analysis will then be shown in the
tree for the parts of the specimen as well. Alternatively you may directly choose the organism
in the part tree and create the analysis for this part of the organism in the part tree. If you
used any tools defined in the tool section, you can include the usage of these tools.

If you require further information about an analysis click on the button to open the window
for the analysis administration. If you have the proper rights you can edit the analysis types
used in your collection as shown below. This window is also accessible via the menu entry 
Administration - Analysis... 

For the import and export of data it is sometimes necessary to know the IDs of the analyis
types. To see the IDs, click on the ID button to display them as shown in the image below.
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The types of an analysis are restricted by the taxonomic group of the organism or object to
be analysed and from the projects. You may edit the list of taxonomic groups resp. projects,
which can use a certain analysis, using the and button. For details about handling data
see the data section. If you add a taxonomic group or a project to an analysis, all children of
this analysis will be available for these taxonomic groups resp. projects as well. Thus, in the
example above it is sufficient to enter the taxonomic group and the project in the analysis
Mammals to have access to all analysis within this superior analysis as shown in the tree. The
different types of analysis are organized in a hierarchy. Some of the entries may only serve for
structuring purposes (e.g. Mammals as shown above) and should not be used to document the
analysis of the specimen. To ensure this, check the checkbox [Only hierarchy]. 

There are 3 states for result lists in the main form. (1) No result list will be generated if a
measurement unit is defined, for example if you specify "mm" as the measurement unit. (2) If
no measurement unit is defined, the programm will collect all values given so far and present
these values as a list. (3) Some types of analysis need categorized values. Enter these values
together with their description in the Result list as shown below using the and buttons
respectively. To show values different from the entries in the Result column change the
entries in the Display text column.
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If you want to access or inspect an URI given for an analysis type, click on the button. The
URI related to the analysis will then be displayed in the window below. 

To view the history of a dataset, click on the button. A window with the history will open.
For more details see the section History.
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Geography of organisms
The geograhical position (using WGS84) of organisms can be captured related to the date to
e.g. document a migration or the distribution of an organism. In the tree the geograhical
entries are symbolized with a icon as shown below. 

To display the corresponding map activate Maps and click on the button. To edit an already
existing geography use the GIS editor. 

Page 124



Identification
Each organism or unit may have been identified several times. The identifications are listed in
the tree under the organism as shown in the image below. To create a new identification
choose the organism from the tree and click on the icon. The last identification will always
be taken as the valid one and set at the top of the list. To insert an older identification at the
base of the list click on the icon.

 

To hide / show the identifications in the tree click on the icon on the right panel next to the
tree. To enter a confirmation of an identification choose it in the tree and then click on the 
button. To move an identification to the end or the start of the list use the or button
respectively. To delete an identification select it in the tree and click the  button. To enter
details for an identification choose it in the tree. You can then enter the details in the form
opening on the right side of the tree as shown below.

 

The taxonomic name of an organism can be selected from either the names already available
in DiversityCollection or from the module DiversityTaxonNames. To choose from the local

names type the beginning of the name and click on the drop-down button  to get a list of
available names. You can use wildcards according to SQL. 

To select a taxonomic name from an external database click on the button. A window will
open where you can search for a taxonomic name. In the database the data for the
identification is stored in the table Identification.
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Taxon lists

To see the list of organisms within a Specimen , CollectionEvent , EventSeries or
SamplingPlot click on the button which will appear, if you select one of the corresponding
items in the tree (see below). 

A window will open as shown below where you can gather additional information stored in the
module DiversityTaxonNames.

To retrieve information stored in the module DiversityTaxonNames for names which are linked
to this module select the taxonomic group of the organism. Then select the option [Include
information from taxonomic lists]. A combobox will appear where you may select the taxonomic
database. Next, select the project in the combobox and finially the analysis. After all options
are selected, click the button to requery the data. To export the results in a tab-separated
list use the button.
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Storage and trees for the parts of the
specimen
In the tree at the base of the window the parts of the specimen with their related data are
shown. This tree depicts the parts either in accordance to their relation to each other in the
specimen tree (click on the icon in the panel on the left) ...

 

... or depending on the collections where the parts are stored (click on the icon in the panel
on the left). 

 

With the buttons in the left panel you may hide or show certain nodes in the tree. If e.g you
do not wish to see the processings, simply click on the button and they will be hidden in the
tree. The button will change to a grey version and the background will turn yellow, to show
you that there is hidden data of the processings.

The panel on the right of the tree is for editing the data, for example the button will insert
a new transaction. For further details see the sections Transaction and Processing.
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Parts of the specimen
A specimen can contain several parts which may be stored in several collections. These parts
may represent different material categories, e.g. herbarium sheets, microscopic slides etc. The
parts are shown in the part tree under the main tree. This tree depicts the parts either in
accordance to their relation to each other in the specimen tree (click on the icon in the
panel on the left) - see first image below - or in relation to the collections where the parts are
stored (click on the icon in the panel on the left) - see second image below. Here the two
parts of the specimen are located in two collections. To add a new part use the drop-down
field in the panel on the right of the tree and choose the material category of the new part.
The material categories which appear in this list can be customized. You can set the default
collection for new parts. If the default collection is not set, you will be asked to name the
collection of the new part. If the part is derived from another part, select this in the tree
before creating the new part. The new part will then be added as a child of the old part. You
can later edit these relations by drag & drop. If you wish to create a copy of a part, use the 

button in the panel on the right side of the tree. 

If an organism is present in a part of the specimen, it will be shown in the tree. To edit its
presence select the specimen part in the tree and edit the Display order as shown below. 

In the expample above, all organisms are present in the specimen. However, the fungus 
Cystotheca lanestris was chosen not to appear on the label and was transferred to the Hide
list. This is symbolized by a grey icon in the tree. You may enter a description for an
organism as a whole or for the organism within a certain part. The slide, symbolized by the 
icon, was created from the sample. Thus, in the specimen tree it is shown as a child of the
specimen symbolized by the icon. Concerning the organisms only the fungus Arthrocladiella
is found on the slide. Thus, in the tree it is the only organism shown as child of the slide. In
the display order the two other organisms appear in the Units not in part list (see below).
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To move the organisms between the lists use the > and < buttons. In the list Show in label
you may change the sequence of the organisms with the and buttons in the panel at the
base of the list. The organism at the top will be the one taken as the main organism, e.g. for
printing a label. To edit the details of a part select it in the tree to open the fields as shown
below.

The identifier, e.g. the taxonomic name under which the specimen can be found in the
collection is entered in the field Storage location. You can search for this entry in the query.

To search for a free accession number use the button (see chapter Accession). To enter

the storage location you may use the drop-down button to select from the identifications

within the specimen. The drop-down button for the Notes will provide you with a list of all
entries in this field, filtered with your entry in the text field. You may use wildcards like "%" or
"_" (see Wildcards).

In the collection tree, the specimen are shown with their dependence upon each other based
on their location in Collections. To get information about a collection simply select it in the
tree. If you have the required rights, you may use the button to open the administration of
the collections. This form is accessible under the menu entry Administration - Collections...
as well.

The material category of a specimen part is indicated by the icon in the hierarchy. 

Here some expamples:
bones: bones or skeleton from vertebrates
cultures: living cultures of organisms
drawing: original line or color drawing
herbarium sheets: capsules or sheets as stored in a botanical collection
icons: icons, images etc. stored in a botanical collection
micr. slide: glass plate with sections of specimen for microscopic studies
specimen: specimen stored in a collection

Specimens can be included in a transaction. Every stored part of a specimen may be treated
with several processings.

If there are images which are related to the current part, the button for the restriction of the
images will be enabled ( → ). Click on it to restrict the images to this part. The button
will recieve a red backgroud    to remind you of the restriction and in the image list a
button will appear which enables you to show all images.

To edit the parts of the specimens see the chapter Grid for parts.

The data is stored in the table CollectionSpecimenPart .
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Processing
Every specimen can be processed, e.g. for preparation or preservation. Processings can be
applied to a specimen or a part of a specimen. In the hierarchy for the parts the processings
are indicated by the icon and a blue text. If there are any processings available, they will
be indicated by the icon in the tool bar. Please keep in mind, that the availability of the
processings depend upon the material category and the current project as described below.
You can hide or show the processings in the hierarchy with a click on the icon. The
images below show a processing in the collection and the specimen tree for the parts
respectively.

You can enter a new processing for either the entire specimen or a part of the specimen. To
do this select the specimen or part in the hierarchy and choose a processing from the list as
shown below.

To delete a processing select it and click on the button. To edit the data for a processing
select it in the hierarchy. The window will show you the fields related to the processing as
shown below. If you used any tools defined in the tool section, you may include the usage of
these tools. 

In the window select the type of your processing from the list.
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If you have the required rights you may edit the processing types in the menu entry 
Administration - Processing...

In this window you can define the processings used in your collection. To add a new
processing click on the button, to delete a processing select it and click on the button.
The processings are related to material categories within the database. To add a new material
category or projects, which should be connected to the selected processing, click on the 
button in the panel right of the material categories or the projects. A window will open where
you need to select the desired material category or project respectively (see below).

The processing types are organized in a hierarchy. Some of the entries may only serve for
structuring as Mazeration in the example below and should not be used to document the
processing of specimen parts. To ensure this check the checkbox [Only hierarchy]. For the
import and export of data it is sometimes necessary to know the ID's of the analysis types. To
see the ID's of the data sets click on the ID button. The ID's will then be displayed as in the
image shown below.

To view the history of a data set, click on the button. A window with the history will open.
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For more details see the section History.

The data of the processing is stored in the table CollectionSpecim enProcessing. 
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Collector
The people or groups responsible for the gathering of the specimen are stored in the table 
CollectionAgent. There may be several collectors for one specimen. In the tree the collectors
are symbolized by the icon as shown below.

 

To hide or show the collectors in the tree use the icon in the left panel (it will change to a
grey version with a yellow background when the authors are hidden). To insert a collector
choose either the specimen or an existing collector in the tree and then click on the icon in
the right panel. Select a collector in the tree to enter details. In the right part of the window
the detail fields will appear as shown below.

 

If a collector should refer to a dataset in the module DiversityAgents (where more details like
addresses may be stored) click on the   button. The sequence of the collectors (e.g. for
print on a label) as shown in the tree can be changed by with the   and  buttons in the
panel on the right side of the tree.

To remove a collector select the entry in the tree and click on the  button.

You can search for the gathering numbers of the collectors in the query.

Data of the collectors is stored in the table CollectionAgent. 

Page 133



Relation
Each specimen may have relations to other specimens. This can be documented by adding
relations to these specimens. To add a relation select the specimen in the tree (symbolized by
the barcode ). You may then either add a relation to a local specimen using the button or
add a relation to a remote specimen using the button. To show or hide the relations in the
tree use the and buttons.

 

Internal relation    

To add an internal relation to a local specimen use the button. A window will open where
you may search for the related specimen. 

 

Select the related specimen from the query result list and click OK to close the window and
establish the relation. In the left image below you can see an internal relation while the
image on the right shows a reverse relation from another specimen.  
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In the case of internal relations you can navigate to the related specimens using the 
button.

 

External relation   

To add an external relation to a specimen which is not administrated in the database
DiversityCollection use the button. In the image below you can see a relation to a specimen
in an external collection.

  

To delete a relation select it in the tree and click on the  button. 

 

Editing the data

To edit the data for a relation click on the entry in the tree. In the right part of the window
the details of the data set will be shown (see below).
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The data is stored in the table CollectionSpecimenRelation.
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Exsiccatae
A Specimen may be part of an exsiccatal series. These series are administrated in the
DiversityWorkbench module DiversityExsiccatae. To enter the exsiccatal series select the
Specimen, the Organism or IdentificationUnit in the tree. With the Specimen the exsiccatal
series is shown at the base of the data form as shown below.

 

As there may be several Organisms with separate exsiccatal numbers in one Specimen the
numbers are handled together with the IdentificationUnits. Select the concerned Organism to
enter data in the form as shown below. 

You can either type the name of the exsiccatal series or choose one from the module

DiversityExsiccatae. If you click on the , a window will open showing the link to the entry
as derived from the module.

 

The data on the exsiccatal series is stored in the table CollectionSpecimen, the data on the
number and the taxon is stored in the table IdentificationUnit. 
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Images
To insert a new image click on the  button. A window will open where you can enter the
path and file name of the image. Click on the button to search for a web address of an
image as shown below.

To use an image available as a local file click on the button to search in your local
directories. You can upload this file via a webservice to the server of an institution providing
the DiversityMediaService. To use this service you may rename your image either using a GUID
or according to the accession number including date and time. Use the upload button to
upload your image to the server.
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To delete an image select it from the list and click on the  button.

To zoom a specific sector of an image simply drag the mouse over the preferred area of the
image. A red square will indicate the zoomed area. To set the size of the image to its original

resolution click on the  button. To adapt the size of the image to the available space in the

form click on the  button. To change the orientation of the image use the appropriate
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buttons (  flip horizontal,  flip vertical,  rotate right,  rotate left). To view the
image in a separate form click on the button. If the image should not be published e.g. on
the internet, enter any reason in the Withhold. reason - field. Next to images you can store
other media. 

For the description of a medium see the chapter Image description.

Data is stored in the tables CollectionSpecimenIma ge, CollectionEventImage ,
CollectionEventSer iesImage and CollectionImage. 
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Tools
The tools are used for the analysis of the organisms or the processing of the material. To
administrate these tools choose Administation ->  Tools ... from the menu. A window will
open as shown below. 

There are 2 list where you can define for which analysis or processing the selected tool may
be used. The tools may contain a definition for the usage defined via XML
(targetNamespace="http://diversityworkbench.net/Schema/tools") (use the button to see
the current definition) and depicted as a tree as shown above. To insert a previous defined
usage definition click on the button to search among the usages defined for other tools. To
insert a new usage for the tool click on the button. If a usage should only allow predefined
values, select the usage in the tree and click on the button to add and the button to edit
the predefined values. With the button you may remove usages or predefined values. 

In the main form you are able to add tools to an analysis or a processing. Choose the
respective item in the tree and click on the button for the Tools (see below). Depending on
the tools available for the analysis or processing respectively you may select from a list or
tools. 

You may add several tools for one analysis or processing as shown below. Tools are indicated
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with a yellow background. To edit the value of a usage or setting select it in the tree and
click on the button. After changing content click on the button to save your changes.

To view the history of a data set click on the button. A window with the history will open.
For more details see the section History. For any comments to this part of the application use
the feedback function.
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Methods
The methods used for collection events, the analysis of the organisms or the processing of
the material. To administrate these methods, choose Administation -> Methods ... from
the menu. A window as shown below will open. 

There are 2 lists where you can define for which analysis resp. processing the selected
method may be used. If the checkbox For collection event is checked, this method may be
used for collecting specimen. The methods may contain several parameters as shown above.
To insert a parameter click on the  button. If a parameter should only allow predefined
values, check the Use dedicated values for a parameter checkbox and add values using
the  button. With the buttons you can remove parameters or predefined values. 

To view the history of a dataset, click on the button. A window with the history will open.
For more details see the section History. For any comments to this part of the application, use
the feedback function.

In the main form you can add a method to a collection event, an analysis or a processing.
Choose the respective item in the tree and click on the button to add a method (see
below). Depending on the selected method, you get a list of parameters for which the values
can be set. For the parameters where default values are available, these will be inserted when
adding the method. 
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You may add several methods for one analysis resp. processing or collection event as shown
above.
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Image description
Creating and editing templates

To enter a description for an image or a medium a before designed description template for
the current project is required. To be able to create a template you need to be an 
admininstrator or data manager. To define the template choose Administration - Image
description ... from the menu. A window will open as shown below.

To enter or remove description fields use the and buttons respectively. To search for a
template from another project click on the Search template button. A window will open
where you can choose from templates defined for other projects as shown below.

 

Description of the image

To edit a description of an image or medium select it from the list and click on the button.
A window will open as shown below where you can edit the description according to the
template. If the template has changed or you want to add description fields from another
project, click on the Get missing fields button.
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Media

Next to images you can store audio and video files. Click on the [>>>] button
(see below)

 

to open Windows Media Player and play the content of the media. You must have Windows
Media Player installed to use this function. For the description of a medium see the chapter
Image description. 
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DiversityMediaService
The webservice DiversityMediaService provides the possibility to upload media files like images,
audio recordings, etc. to a server. The usage of this webservice includes several preconditions
(please turn to your administrator):

 You need an account in the DiversityWorkbench module DiversityAgents with your login
in DiversityCollection linked to this account

 Your project has to be registered on the server
 You have to rename your media file according to the settings of the server e.g. using a

GUID (see image below) 

Use the upload button to upload your image to the server.
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Annotation
You can add an annotation for a collection event, a collection specimen, a part of a
collection specimen or an organism (= identification unit). 

The available types are annotation, problem and reference. To add an annotation,
select the corresponding data in the tree view. In the tool panel on the right of the tree view
a button will appear: if no annotations have been added so far or if there are
annotations for this entry. A window will open as shown below.

To add an annotation, click on the button and select the type of the annotation. The
annotation will be shown in the tree with the details listed below (see image below). 

Enter your annotation in the text box as shown above. You can enter a title or subject for
your annotation or select one from the list. You may enter a link and a source as shown
above. The source may be related to the module DiversityAgents. 
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For the type reference (see above) you may enter a link to the module DiversityReferences.  

To delete an annotation you have to be either an  administrator or a data manager. Select
the annotation and click on the button. 

If you want to see all annotations of the current specimen choose Data - All annotations...
from the menu. All annotations will be listed as shown below.

Data for the annotations are stored in the table Annotation.
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GIS editor

To use the GIS editor, click on the button in the control to show the maps and
choose the appropriate option ( GIS- edit) from the first drop-down list in the maps control.
With this editor you can document locations with any geographical object (lines, areas, ...)
different from a simple point. If coordinates are available for your data set, the GIS editor will
load a map (Google Maps) as background. To insert the geographical object defined for e.g.
the locality click on the button. To set the format for point symbols use the controls for
the symbol, color, size and line thickness above the GIS editor. To redraw the maps with new
settings click on the button. 

With the GIS editor you can edit the geographical information for the CollectionEventSeries 
, the CollectionEvent and an Organism . Furthermore you can create distribution maps 
for any sample selection. 

The GIS editor has several states which are needed to handle geographical objects. For a
detailed description see the GIS tutorial. 
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Introduction
The Diversity GIS Editor is a tool to create, visualize, edit and archive samples within a
geographical environment. It may be used as a stand-alone application or as a component of
the Diversity Workbench by other applications, e.g. DiversityCollection or
DiversitySamplingPlots.

In combination with a background map, equipped with world coordinates, collections of
Microsoft SQL Geometry Objects (points, lines and areas) may be displayed and edited in their
geographical context. The screen and world coordinates of the objects will be calculated and
shown in the status line. Color, thickness and transparency of the elements can be adjusted.
The working area which keeps the maps and objects may be shifted or zoomed.

The background map could either be loaded from a storage device or created with an online
map server tool provided by the editor. Other maps without world coordinates may be
adjusted to the background map easily by setting 3 pairs of reference points on the
background and the new map. The calculated world coordinates will be assigned and stored
when the new map is saved.

A GPS functionality has been integrated. If a GPS device is connected, the current position
will be displayed and - if an applicable background map is loaded - marked on the map.

The data transfer between application and GIS editor is made by interface function calls. In
that way geometry objects of a Diversity data base may be loaded to the editor, modified or
extended and sent back to the application, which then updates the data base.
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Chapter 1:   GIS Editor Layout
The layout of the Diversity GIS Editor could be divided into 3 regions:

 Control Panel
 Sample List
 Working Area

Control Panel

 

The Control Panel consists of the following elements:

 7 buttons to load , save , delete , print or add samples, switch GPS 
and to open the Settings window 

 2 text boxes for sample Identifier (ID) and Description (Text)
 7 radio buttons to select the operation mode (Map, Shift, Adapt, Edit, Point, Line,

Area)
 1 button to switch to a new object, if the current sample is composed of multiple

lines or areas
 4 controls to adjust color and transparency of the samples (for stroke and fill) or to

zoom the working area
 Status lines with screen and world coordinates (if any) and an appropriate symbol 

, , or 
 A hint about the user interaction, which is possible or expected

Sample List

The Sample List is the container for added maps or objects. Each entry is composed of the
following elements:

 Identifier of the sample
 Delete button to remove the sample
 Toggle button to hide or show the sample

The toggle button is illustrated with a small picture of the associated sample. Switching these
controls using the left mouse button will hide or show the corresponding sample. Using the
right mouse button will show the corresponding sample and hide all others, except the
background map. If the number of samples in the list do not fit into the window area, a scroll
bar will be displayed.
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Working Area

This is the drawing space containing loaded maps and objects. In Shift mode the area could
be moved or zoomed.
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Chapter 2:   GIS Editor Usage
The GIS Editor has 7 operation modes which are described in the following chapters:

 Map: Create an online map from the map server
 Shift: Move the working area with the mouse or zoom it with the slider
 Adapt: Calculate world coordinates for a new image using reference points of the

background map
 Edit: Modify the current object and all visible samples of the Sample List
 Point: Create a number of object markers on the background map
 Line: Create a line string or a collection of line strings on the background map
 Area: Create an area or a collection of areas on the background map

When starting the GIS Editor as a stand-alone application the start-up operating mode usually
is the Map mode. This is to remind the user that a background map with world coordinates is
necessary to work with geographic objects.

Chapter 2.1:   Map Mode

 

In Map mode the editor connects via Internet to the SNSB Google Maps service or
alternatively to the Open Street Maps service, regarding on the GIS-Editor Settings, and
displays an online map which can be moved, zoomed and switched as usual. The status area

shows the or respectively the symbol. The size of the map area adapts
to the size of the working area, even when resizing the window.

In case of Google the controls for moving, zooming, map type, the scale and the overview
window in the bottom right corner are displayed by default. The map can be adjusted to the
user's needs as follows: 
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 Select map area: Press and hold left mouse button and move the mouse, or use the
Google shift control

 Zoom map: Turn the mouse wheel (if any), double click (left mouse button) on a
location or use the Google zoom control

 Switch map type: Use Google map type control
 Hide Google controls: Click right mouse button to hide, left mouse button to show them

again
 Hide overview window: Toggle arrow box in the bottom right corner of the window to

hide or show it

In case of Open Street Maps the pan and zoom control is displayed by default. It can be
switched off or on by clicking the left mouse button anywhere within the map area. The layer
switch control is hidden and can be opened by pressing the or closed again by pressing the

button on the right side. The map can be adjusted to the user's needs as follows: 

 Select map area: Press and hold left mouse button and move the mouse, or use the
OSM pan control

 Zoom map: Turn the mouse wheel (if any), double click (left mouse button) on a
location or use the OSM zoom control

 Switch map type: Open the layer switch and select a layer
 Hide or show pan and zoom control: Click left mouse button to toggle the control

If an appropriate area has been selected, just press the Add button , then the area will be
scanned and added to the Sample List as a reference map. This may take a couple of
seconds, depending on size of the map area and processor power. A little image of the map
will appear on the toggle button in the Sample List. The Google controls should be switched
off before adding to get a neat map image.

The mode will be switched to Shift mode automatically and the status symbol will change to 

indicating that world coordinates are present. The screen and world coordinates will be
shown in the status lines if the mouse is moved over the map surface.

The maps are subject to the Mercator projection, which is the GIS Editor's precondition for
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every bitmap used as a reference map. While the screen coordinates are linear in horizontal
and vertical direction, the world coordinates are non linear in vertical direction.
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Chapter 2:   GIS Editor Usage

Chapter 2.2:   Shift Mode

 

This is the quasi default mode of the GIS Editor. The cursor changes to a move shape 
when touching the background map. The map is "frozen" and exists as an image sample on the
working area. Changing the map region or resolution is no longer possible. But the Shift Mode
provides 2 features:

 Move the working area
 Zoom the working area

Moving the working area

Press and hold the left mouse button and move the mouse to shift the working area within the
display window. This is useful when having loaded a map from a storage unit which is larger
than the GIS Editor's window, or in combination with zooming the working area.

Zooming the working area

Place the mouse cursor at the slider control, press and hold the left mouse button and move
the control left to zoom out or right to zoom in to the working area. The range of the zoom is
from factor 0.6 to 3.0. The current value is displayed beneath the zoom control. Double click
the slider control to reset the zoom to default value 1.0.

Enlarging the working area makes it more easy to place objects precisely. The relevant area
then could be selected by moving the zoomed working area. Downsizing the working area
gives an overview of large map regions.
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Please note that the resolution of the map itself does not change any more when zooming in.
But objects on the map are created in vector graphics, so the markers, lines or areas will
remain sharp and clear while zooming. And they will adapt there thickness smoothly to the
size.
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Chapter 2:   GIS Editor Usage

Chapter 2.3:   Area Mode

This mode is used to create areas (polygons) on the background map. The cursor changes to
a cross line when touching the background map. Each click on the left mouse button sets a
new point of the polygon. Every click on the right mouse button clears the last point set. The
closed polygon defined by the points is displayed completely at any time. When holding the
left mouse button the point can be placed while the lines of the polygon are shown as a
"rubber band" display.

 

To create more than one area for a sample, just click the button. This will finish the
current polygon and start another one. It could be repeated without limitation of the number
of polygons.
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Setting the color

The areas are created as filled polygons, this means they have a border line (stroke) and a
filling. The color of stroke and filling can be set independently or simultaneously by clicking the
appropriate check boxes beneath the Color list box. Clicking on the list box will open a drop
down menu with the complete set of 141 predefined brushes. Use the scroll bar to navigate to
the preferred color and select it with the left mouse button.

Setting the transparency

Besides the color the transparency of the area could also be set for stroke and filling. In each
edit mode the slider control is used for that. The area stroke or filling changes smoothly from
invisible at the left till completely opaque on the right slider position. The value beneath the
slider control indicates the opaqueness in a range from 0% to 100%. The default settings are
100% for stroke and 25% for filling.

Before adding the polygon to the Sample List an Identifier (ID) and a Description (Text) should
be written to the text boxes in the control panel.

Clicking the Add button will put the current area(s) as one sample into the Sample List. The
toggle button will show a small picture of the first area of the sample. The ID will be displayed
above the buttons. Furthermore a tool tip will be created for the sample holding the ID and
Description, which will pop up when moving the mouse over the toggle button or over the
polygon in the working area.
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Chapter 2:   GIS Editor Usage

Chapter 2.4:   Line Mode

This mode is used to create line strings on the background map. The usage is adequate to
the Area Mode. The cursor changes to a cross line when touching the background map. The
points of the line strings can be set or cleared by clicking the mouse buttons. Clicking the 

button will switch to the next line string for the sample.

 

Color and transparency can be set for the line strings using the appropriate controls, but only
for stroke, because the line strings do not have a filling. Thus checking the Fill box will have
no effect. After adding the lines to the sample list a small picture of the first line string will
appear on the toggle button.
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Chapter 2:   GIS Editor Usage

Chapter 2.5:   Point Mode

This mode is used to create Points (object markers) on the background map. The usage is
similar to the Area Mode. The cursor changes to a cross line when touching the background
map. The object markers can be set by clicking the left mouse button, clicking the right
mouse button will clear the last markers one by one again. The button has no impact,
because each Point represents a complete object and needs not to be finished before creating
the next one.

 

The shape of the object markers can be selected from a number of predefined Point symbols
and icons within the Settings window, e.g.:

Pin: Assel: Fish: Mollusc:

Cross: Bird: Fungus:
Myxomycet
e:

X: Bryophyt: Insect: Plant:
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Circle: Echinoderm: Lichen: Reptile:

Square: Evertebrate: Mammal: Vertebrate:

Diamond:

Color can be set for the symbol markers using the appropriate controls. It depends on the
selected point symbol, whether it just has a stroke (e.g. "Cross") or also a filling (e.g. "Pin").
Transparency can be set for both, the symbol and icon markers. The stroke thickness and the
size of the markers can be set in the Settings menu. After adding the object markers to the
sample list a small picture of the collection will appear on the toggle button.
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Chapter 2:   GIS Editor Usage

Chapter 2.6:   Edit Mode

This mode is used to modify all samples (objects and images) which are currently visible on
the working area. It applies to the elements of the Sample List as well as to the current
sample.

Changing the position or shape of objects (points, line strings, areas)

To change an object one has to move the vertices ("corner points") which are defining it. To
do so just move the mouse close to a vertex to localize it. As soon as the corner has been

grabbed the cursor changes its shape to a hand symbol .

Now press the left mouse button and hold it, then move the mouse to change the position of
the vertex accordingly. The shape of the object or the marker will change in the same
manner. Release the mouse button when the preferred position has been set.

Note that areas and line strings cannot be moved in total while keeping their shapes!

Changing the position or shape of images (maps)

Images (e.g. maps) can be moved completely (keeping their aspect ratio), scaled in horizontal
and vertical direction and skewed within an affine transformation. Editing an image can be
divided into 4 stages by grabbing and moving the following corners:

1. Top-left: Moving the total image by keeping its aspect ratio 
2. Bottom-right: Squeezing or stretching the image horizontally and vertically
3. Bottom-left, top-right: Skewing the image in an affine way by keeping the corner

points top-left and bottom-right at its positions
4. Bottom-right again: Skewing the image in an affine way by keeping the corner points

top-left and bottom-left at its positions

Stages 1 to 4: 

Changing color and transparency

Color and transparency can be set independently (or simultaneously) for the objects using the
appropriate controls and check boxes for Stroke or Fill. The setting will affect all visible
objects, so objects which should not be changed have to be switched off before with their
toggle buttons. The color of images could not be changed, of course, but the transparency
can be set if the Fill box is checked. The transparency of the background map cannot be
changed. 
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Chapter 2:   GIS Editor Usage

Chapter 2.7:   Adapt Mode

Essential for visualizing Geographical Objects is a background map with world coordinates. The
GIS Editor's Map mode offers a convenient way to create such a map, but it is restricted for
the use of Google or OSM maps which are present in the web and are providing world
coordinates. It would be nice to load scans of e.g. topographical or even historical maps into
the working area and use them as background maps, but the problem is how to assign world
coordinates to them.

The Adapt mode solves this in an easy way by executing the following steps. As a
precondition a background map having world coordinates (e.g. a Google map) must be present
which covers the area of interest of the new map to be referenced.

1. Load the new map image using the Load button . The image will be placed top left
inside the working area.

2. Select Adapt mode by checking the Adapt radio button. The cursor changes to a

pointer symbol having a green border when touching the new image and having a
red one when touching the background map.

3. Now 3 reference points must be set alternately on background and new map to assign
the appropriate locations (e.g. distinctive landmarks like road crossings). The last point
can be modified as long as the map is not changed. The cursor always tells you what
reference point will be set, according to its color and the number of dots in the

middle: 
Note: It is reasonable to select distant points close to the edges of the new map,
because this will give more accurate results. 
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4. When all reference points have been set and the cursor touches the alternate map, it

changes to the finished shape . The next click will place the new map into the
appropriate background map area. 

Page 167



The adapted image has been transformed to fit into the current world coordinates of the
background map. Now the new map can be added to the sample list by pressing the Add
button . When it is finally saved to disk by pressing the Save button , the new assigned
world coordinates will be saved, too, in an XML file with the same name (see Chapter 2.9:
Save Samples).

Sometimes it is difficult to place the new map and the reference map side by side, because
the window is too small, and zooming out would blur the details needed for setting the
reference points. If the new map covers the background map, the reference points can be set
anyway 

 for the new map by making it opaque with the transparency slider
 for the background map by making the new map transparent (less than 10% opacity)

with the slider 
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Note: The Fill box must be checked to change the transparency of the new map. The
background map's transparency cannot be changed.
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Chapter 2:   GIS Editor Usage

Chapter 2.7:   Adapt Mode

Essential for visualizing Geographical Objects is a background map with world coordinates. The
GIS Editor's Map mode offers a convenient way to create such a map, but it is restricted for
the use of Google or OSM maps which are present in the web and are providing world
coordinates. It would be nice to load scans of e.g. topographical or even historical maps into
the working area and use them as background maps, but the problem is how to assign world
coordinates to them.

The Adapt mode solves this in an easy way by executing the following steps. As a
precondition a background map having world coordinates (e.g. a Google map) must be present
which covers the area of interest of the new map to be referenced.

1. Load the new map image using the Load button . The image will be placed top left
inside the working area.

2. Select Adapt mode by checking the Adapt radio button. The cursor changes to a

pointer symbol having a green border when touching the new image and having a
red one when touching the background map.

3. Now 3 reference points must be set alternately on background and new map to assign
the appropriate locations (e.g. distinctive landmarks like road crossings). The last point
can be modified as long as the map is not changed. The cursor always tells you what
reference point will be set, according to its color and the number of dots in the

middle: 
Note: It is reasonable to select distant points close to the edges of the new map,
because this will give more accurate results. 
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4. When all reference points have been set and the cursor touches the alternate map, it

changes to the finished shape . The next click will place the new map into the
appropriate background map area. 
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The adapted image has been transformed to fit into the current world coordinates of the
background map. Now the new map can be added to the sample list by pressing the Add
button . When it is finally saved to disk by pressing the Save button , the new assigned
world coordinates will be saved, too, in an XML file with the same name (see Chapter 2.9:
Save Samples).

Sometimes it is difficult to place the new map and the reference map side by side, because
the window is too small, and zooming out would blur the details needed for setting the
reference points. If the new map covers the background map, the reference points can be set
anyway 

 for the new map by making it opaque with the transparency slider
 for the background map by making the new map transparent (less than 10% opacity)

with the slider 
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Note: The Fill box must be checked to change the transparency of the new map. The
background map's transparency cannot be changed.
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Chapter 2:   GIS Editor Usage

Chapter 2.8:   Load Samples

A background map is required before objects (areas, line strings, points) can be loaded. When
loading a shape file, the objects will be displayed at the background map according to their
coordinates and added to the Sample List automatically. The GIS Editor is able to read
MS-SQL Geo Object files (.shp1) as well as ArcView Shape Files (.shp), which are using
geographical or Gauß-Krüger coordinates.

When loading an image without world coordinates, it will be displayed top left in the working

area. If no background map is loaded yet, the Screen symbol is shown in the status line,
followed by the screen coordinates of the current cursor position.

When loading an image with world coordinates and no background reference map exists, it will

be displayed top left in the working area. The World symbol is shown in the status line,
followed by the screen coordinates and the world coordinates of the current cursor position.

When loading an image with world coordinates having an existing reference map, it will be
embedded in the background map according to its coordinates. If the new image does not
overlap with the reference map, the image exists virtually in the coordinate system, but
possibly could not be seen because it is too far away from the reference map. In this case a
warning will be displayed: 

When loading an image it is displayed, but not yet added to the Sample List. The user has to
add it manually by pressing the Add button . This is because the user should have the
opportunity to adapt the image to the background map to be stored later on with applicable
coordinates.
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Chapter 2:   GIS Editor Usage

Chapter 2.9:   Save Samples

To save a background map which is currently displayed in Map mode just press the Save
button instead of the Add button . A save file dialog will pop up to name the file, the
map and its coordinates will be saved and added to the sample list.

A background map is required before objects and images can be saved. Saving samples means
saving their type, attributes and world coordinates in files. When pressing the Save button 
, it applies to all visible samples on the working area, except the background map. A current
sample will be added to the sample list before it is saved.

If objects are visible, a save file dialog will open and a name for the target file(s) must be set.
Objects (areas, line strings, points) will be saved in respect to the selected formats of the 
GIS-Editor Settings:

 If MS-SQL is enabled, all visible objects will be collected and stored in one GIS Editor
shape file in ASCII text format (extension .shp1). The file contains the objects'
attributes and MS-SQL Geo Object definition strings. If altitude calculation is enabled in
the GIS-Editor Settings, these values are stored, too.

 If ArcView is enabled, for each object 3 ArcView compatible shape definition files in
binary format will be created: A shape file, an index file and a dBase file holding the
description (extensions .shp, .shx, .dbf).

If images are in the Sample List, they are already present on disk and will not be saved twice.
Instead for each image an XML file will be created with the calculated world coordinates of
the image and will be stored under the same location and name as the image. This does not
apply to the current background map.

If Save Working Area is enabled in the GIS-Editor Settings, a scan of the complete working
area including its objects is made and stored in an image file, which name has been set in the
save file dialog. 
To save only a part of the working area the Frame box must be checked in the GIS-Editor
Settings, too. Then a rectangular frame of the given dimensions is displayed, which defines
the part of the working area that will be saved. It can be dragged to the right position using
the left mouse button (click, hold and shift), and it can be resized by grabbing and moving the
corners of the frame.
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Chapter 2:   GIS Editor Usage

Chapter 2.10:   Delete Samples

To delete a single object of the Sample List just press the small Delete button left of the
Toggle button. The sample will be removed from the list and the working area, the other
sample entries will be rearranged. 

Pressing the large Delete button in the Control Panel will remove all samples of the Sample
List, except the reference map. A warning is shown before: 
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Chapter 2:   GIS Editor Usage

Chapter 2.11:   Print Samples

Pressing the Print button in the Control Panel will open a print dialog to select a printer and
adjust the settings. Then it will print the complete working area including all visible objects.
This feature is useful e.g. for documentations.
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Chapter 2:   GIS Editor Usage

Chapter 2.12:   GPS Tracking

When pressing the GPS button in the Control Panel the hardware will be scanned for a GPS
device. All available serial ports are opened and checked if they are delivering valid GPS data.
This takes 2 seconds. Be sure that the correct baudrate for the GPS device has been set in
the Settings menu (standard rate: 9600). 

If no device is detected the button will be released. If a device has been found the button
changes the color according to the numbers of satellites which have been fixed by the device:
Red up to 3 satellites, yellow up to 5 and green if 6 satellites or more are available.
The number of satellites, longitude, latitude and altitude delivered from the GPS device are
displayed in the info line of the Control Panel beneath the status.

The current position will be shown by a GPS marker if an appropriate background map has
been loaded. If GPS Track in the Settings window is checked, the movement of the position
will be drawn as a line string on the background map. The color and stroke thickness are
similar to the last adjustment for lines. When switching off the GPS button again, the track will
be added to the sample list automatically and could be saved for future documentation
purposes.
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Chapter 2:   GIS Editor Usage

Chapter 2.13:   Settings

Pressing the Settings button in the Control Panel will open a dialog to adjust these GIS
Editor settings which are not frequently changed:

Setting the file formats for saving objects

At the moment 2 formats for object files are supported: 

 MS-SQL Geo Objects (.shp1)
 ArcView shape files (.shp, .shx, .dbf)

Microsoft SQL Geo Objects are part of a standard for storing geometry and geography data in
an SQL database, as used by the Diversity modules. They are more or less a well defined text
string containing the geometrical type (e.g. Polygon, Line, Point) and the geographical
coordinates (longitude, latitude, optional altitude) of an object. 
Together with the GIS Editor attributes (e.g. color, transparency) they are stored in a
proprietary GIS Editor shape file in ASCII text format. This file can easily be read and changed
using a text editor.

ArcView is a common Desktop GIS tool and saves its data in binary files. The GIS Editor can
create ArcView compatible files to store the samples, which then may be read from ArcView
GIS tools. 3 files are required for each type of shape: A data file with extension ".shp", an
index file with extension ".shx" and a description file in dBase format with extension ".dbf". 

The advantage of the first format is the transparency and readability of the data file, which is
just one single text file. But storing huge samples is very time consuming. If the samples
consist of more than 10,000 points, an error message is displayed and they are not saved in
this format: 
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Using the ArcView format makes the data files compatible with many applications. Huge
samples can be stored much faster. But each type of sample requires a separate set of output
files, because different types of objects within one file are not supported so far. So a sample
list containing 10 objects will produce 30 data files (file name with an appended index, which
is incremented for each sample). Furthermore the attributes like color, transparency and
stroke thickness will not be saved. 

Currently there is just one format supported for storing image coordinates. They are written
into an XML file which is also used in DiversityMobile modules. Saving the coordinates in this
format is required for the GIS Editor, so it cannot be disabled.

Saving the working area

Selecting this box and later on pressing the Save button will additionally scan the working
area including all visible objects and save it as an image file under the name provided in the
save file dialog, see Save Samples. This is useful for documentations. 
Note: There are copyright restrictions on maps or aerial images which are created with the
Google maps viewer. Please contact Google before using them for publications to grant a
license, or use Open Street Maps captures, which could be used freely under the Creative
Commons Attribution Share Alike license conditions.

When checking the "Frame" box just a rectangular part of the working area is saved. The pixel
size of the frame has to be defined in the adjacent "Width" and "Height" fields. This is
convenient if the resulting image should have well defined dimensions, e.g. fit the resolution of
a smartphone display. This feature is only active when the Save Working Area box is checked.
After closing the Settings window a rectangular frame of these dimensions is displayed on the
working area which defines the part to be saved.

GPS Track

When checking this box the movement of the GPS marker on the background map will be
tracked by a line string. After switching off the GPS button the line string will be added to the
sample list automatically.

Altitude for geo objects

This box applies to MS-SQL Geo Objects only. If checked, the appropriate altitude of the
object points (longitude, latitude) will be stored in the file, too. This is not recommended for
sample objects with a lot of points or vertices, because for every point the Geonames server
has to be contacted to request the associated altitude value. This could slow down the
saving procedure immensely.

Setting the stroke thickness

The stroke thickness for area, line strings and point symbols can be set by using the
appropriate slider. The value of the thickness is shown in the label box left of the slider.
Double clicking the slider will reset the thickness to its default value 1.

Setting the Point symbol

The symbol for the points can be selected from the drop down menu. The symbol size can be
set using the slider below the menu. The point symbol display will change accordingly.
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Setting the GPS baudrate

It is essential to set a suitable baudrate for a connected GPS device according to its
specification. The rate can be selected from the list of the drop down menu. If no GPS device
is available, Demo mode could be chosen to see the behaviour of the functionality.

Setting the Map Mode viewer

The radio buttons offer the choice of the viewer for creating a background map. Currently
Google Maps and Open Street Maps are provided.

GIS Editor Info

Clicking the Info button will display a window containing GIS Editor version and license
information.

Saving the settings

Finally pressing the OK Button will save the settings, pressing the Cancel button will discard
them.
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Access to the data
To get access to the data, you have to fulfil several requirements. In DiversityCollection, you
must be a member of one of the user groups. You can only access data, which is listed in the
projects you have access to. For external users data may be blocked by entries in the data
witholding reasons or due to a data embargo.
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Availability of data sets
The data of certain parts of the database can be blocked for remote access. If you want to
prevent access for the whole dataset, enter your reason in the field Withholding reason in
the header (see below). 

If you want to block only the access to the data of the collection event or the collector,
choose them in the tree and enter your reason for withholding the data in the corresponding
fields. The data will only be published, if these fields are empty. 

Within the database a user has only access to the data of those projects for which he has
permission. If a data set belongs to a certain project, it is stored in the table
CollectionProject. To prevent publication of the data it can be blocked for the whole data set
(table CollectionSpecimen), for the locality and collection site information (table
CollectionEvent) and for the collectors (table CollectionAgent) - see overview below - and for
all image tables: CollectionSpecimenIma ge, CollectionSpecimenPart , CollectionEventImage ,
CollectionEventSer iesImage and CollectionImage. 

 

To edit the withholding reasons for all specimen selected in the main window choose Data -
Export - Withhold data... from the menu. A window will open as shown below, giving a

summary of all withholding reasons set for the selected specimen and related data.  
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To edit the withholding reasons for certain entries choose the corresponding page where the
details are listed as shown below. 

To block all data enter a new reason for withholding the data and click on the Add
withholding reason to all ...  button or the ... only to selected button, if only the
selected entries should be blocked. To remove the withholding reason from all data sets click
on the Remove withholding reasons for all ... button or the ... only from selected
button, if only the selected entry should be published. 

 

Data embargo

To mark data to be not published for a certain period you can define a data embargo and
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include the data in this data embargo. 

 

Permissions for projects

The user's access to the data within the database is stored in the tables shown below. The
tables UserProxy and ProjectProxy are related to the Diversity Workbench modules
DiversityUsers and DiversityProjects respectively. See User administration for further details.
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Projects
Every CollectionSpecimen may be assigned to any number of projects. To assign a specimen
to a project click on the button. To remove it from a project select the project from the list
and click on the button.

 

If there are projects, to which you have no access to, these will be listed in a separate list at
the top as shown below.

 

To transfer all selected specimen into an additional project choose Data -> Transfer -> 
To project... from the menu. A window will open where you can select the project to which
the specimen should be added.

To remove all selected specimen from an additional project choose Data -> Remove from
project... from the menu. A window will open where you can select the project from which
the specimen should be removed. The last project in which a specimen is placed can not be
removed.

 

The data is stored in the table CollectionProject.

Details of the projects within the DiversityWorkbench are stored in the database
DiversityProjects. To access further information on a project click on the button. To edit
details in projects you require the application DiversityProjects.exe in your application
directory and access to the database DiversityProjects. To synchronize the projects listed in
DiversityProjects you may use the synchronize function in the user administration window as
shown below. If DiversityProjects is not available, you may create a new project by clicking
the button. If DiversityProjects is available, use the synchronize function

.
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The ER-chart below shows all tables with direct relations to the project tables. For more
details see the sections Analysis, Processing and Image description.
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Login administration
To administrate the logins on the database server, their permissions and roles respectively as
well as access to projects choose Administration - Logins ... from the menu. A window will
open as shown below. 

To see the activity of a login click on the button. A window will open as shown below listing
all databases and tables together with the timespan (From - To) and the number of data sets
where any activity of the current login has been found.

To create a new login click on the button. A window will open as shown below.
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Here you can enter the name of the new login, the password and the information about the
user which will be stored in a DiversityAgents database. You may either create a new entry in
this database or select an existing one: Click on the button to search for a name in the
database (see below).

To edit the access for a login on the server select the login in the list. If a login should be
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disabled , uncheck the enabled checkbox (see below).

All databases on the server will be listed with the current database showing a yellow
background. The databases where the login has no access will be listed in gray while the
databases accessible for a login are black. 

To allow the access to a database select the database from the list and choose database as
shown below. 

Use the > and < buttons to add or remove roles for the login in the database (see below). 

Depending on the database you can edit the list of projects accessible for a login (see below).
Projects are related to the module DiversityProjects. To get additional information about a
project select it in the the list and click on the button.  

Starting with database version 02.05.35 next to the projects with full access, a second list
provides projects with Read Only access (see image below). Use the and buttons to
move projects between Accessible and Read Only. 
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To load additional projects click on the Load projects button. A window will open as shown
below. Projects already in the database will be listed in green, missing projects in red (see
below). Check all projects you need in your database and click the Start download button.

Depending on the database you can edit the settings of a login as shown below.

If you wish to use settings already defined for another login, click on the Search template
button. A window (see below) will open where you can choose among the settings defined for
logins in the database. 
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Security
A user may be in 8 groups with diverse rights in the database. Here certain higher groups have
all rights of lower groups in addition to special rights for the higher group, e.g. the group User
may only read data of certain tables while Typist has the rights of User and additionally may
edit the data in certain tables - see overview below.

Summarized overview of the group permissions

Role Permissions in addition to lower role and user group respectively Included rights
Administrat
or Delete data, edit user permissions DataManager

CollectionM
anager Administration of collections, handling loans etc. StorageManager

DataManag
er Delete data, edit image descripton templates Editor

Editor Create new entries and delete details (not entire data sets) Typist
Requester Has the right to place requests for specimen  
StorageMa
nager Administration of stored parts, handling loans etc. User

Typist Edit data User
User See the data of the data tables, add annotations

If you are an Administrator you may add a user to one of these groups.

Any user may have access to several projects.
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Collection management
Collections are managed by collection managers (see Administration -> Transaction
management -> Collection managers ... in the menu), who organize the transfer of
specimen between collections and track the exchange balances . Any transfer of
specimen is organized via transactions (see Administration -> Transaction management
-> Transaction ... in the menu). To be able to place a request for specimen from a
collection you must be in the group of requesters (see Administration -> Transaction
management -> Loan requesters ... in the menu) for the requested collection and a
collection manager for the requesting collection. An overview is given in the image below.
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Collection
The organisms in a specimen can be stored in several collections. To see the place where a
specimen or parts of it are stored use the lower tree and click on the icon to select the
display according to the collections as shown below.

In the tree shown above select the collection to display the data fields as shown below. 

To be able to edit the details of a collection, you must be a collection manager of said
collection. The restrictions for the access for editing the collections are defined in the 
CollectionManager section. 

At the base of the fields you find the default collection, used for the creation of new
specimen parts. Specimen parts that are not created as a part of another part will be placed
in this collection. Use the button to edit this entry. 

Administration of the collections

If you need further information about a collection click on the button or choose
Administration - Collections... from the menu to open the window for the collection
administration (this menu entry is only available for collection managers). This will open a
window (see below) where you can edit the collections used in your database for which you
are a collection manager. 
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Specimen placed in the collections

The specimens stored in a selected collection are listed in the specimen list. You can hide /

show this list using the /  button. The specimen list will appear as shown below. Click on
the collection in the tree view to fill the list and see the specimen that contain parts which
are placed in the current collection. To transfer the parts of certain specimen from the
current collection to another collection, choose them in the list and click on the button. To
change to a specimen from this list click on the button. 

Creating new collections
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To create a new collection use the button either above the Query results or the botton
right of the hierarchy, where the new collection will be placed underneath the collection
selected in the hierarchy. To copy a collection either use the button or the button. The
latter will copy the collection including all child collections. To set the superior collection, use
the button. 

Images

To show the images related to a collection, click on the button. This will open the area for
the images as shown below. Use the and buttons to add or delete images of your
collection. For further details about handling images see chapter Images.

 

To view the history of a dataset, click on the button. A window with the history will open.
For more details see chapter History.

For details about handling data see the Data section. Data of the collections is stored in the
table Collection. 
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Collection manager 
Collection managers are users with the right to edit the transactions for a collection, including
loan, purchase, inventary etc. To administrate the collection managers you must be in the
administrator group. Choose - Administration - Collection managers from the menu to
open the editing window for the collection managers as shown below. 

Use the < and > buttons to edit the list of the collections for which the selected collection
manager can create and edit transactions. 

For details about handling the collections see the Transaction section. Data of the collection
managers is stored in the table CollectionManager. 
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Collection user 
The access of users to collections can be restricted. To edit the collection list for a user
choose - Administration - Collection users ... from the menu. A window will open, where
you can add or remove collections a user has access to as shown below. The access includes
all subordinate collections. This means adding a collection to the list a user has access to also
grants the user access to the subcollections as defined in the hierachy of the collection. In
the example shown below the second entry is not necessary as it is already included in the
first entry.

Use the < and > buttons to edit the list of the collections for which the selected user has
access to. 

If a user has no collections in the list, all collections are available for this user. 

A collection manager has access to the collections he is allowed to manage as well as those in
the list as a collection user. 

Data of the collections is stored in the table CollectionUser. 
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Collection requester
Collection requesters are users with the right to place requests for loans in other collections.
To edit collection requesters you must be a collection manager for the requested collection.
Choose - Administration - Collection requesters from the menu to open the editing
window for collection requesters as shown below. The list on the left contains all users that
are in the group Collection requesters. See UserAdministration for further details. Select a user
in this list to edit the accessible collections for this requester.

Use the < and > buttons to edit the list of the collections for which the selected requester
can place a request. If the option Include subcollections is choosen, the requester can send
requests for all subcollections of a collection. Otherwise the requests can only be sent for the
collections in the list. The subcollections are shown in the hierarchy below the list. 

For details about handling the collections see the Transaction section. Data of the collection
requesters is stored in the table CollectionRequester. 
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Transactions - Request  
To enter a request for a loan you need to be in the user group or a
DiversityCollectionRequester (see UserAdministration for further details). This is done by the
CollectionManagers for their collections. To enable a user to place requests choose 
Administration - Loan requesters ... from the menu. A window will open as shown below.

As a CollectionManager you may give requesters access to the collections you manage. Click
on the < or > buttons to add or remove collections from the list for which a user may place a
request. If the option Include subcollections is choosen, a user is able to request specimens
stored in subcollections of the administrating collection. To give you an overview of the
subcollections the hierarchy of the collection is shown in the tree below the list.

If you are a CollectionManager and there are requests for your collections, the administration
menu will contain a Loan requests ... entry. Choose it in order to open a window listing
the requests for specimen in your collections.

If you have entered a request for specimen in a foreign collection, the administration menu will
contain a  My requests... entry. To inspect your request choose this entry from the menu
to open a window as shown below. The window will show your requests and loans from foreign
collections. 

To enter a new request click on the button. Use the button to search for specimen in the
collection and the button to remove unwanted specimen from your list.
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Transactions
Prerequisites 

The transfer of a specimen between collections is handled with transactions. There are two
prerequisites to use transactions in DiversityCollection. You are required to be in the user
group or a CollectionManager (see UserAdministration) and the collections in which you have
the right to handle transactions must have been assigned to you is shown in the 
CollectionManagers section.

Visibility of transactions

A specimen may be involved in diverse transactions between collections like loan, purchase,
gift or exchange. The transactions are shown in the tree for the parts of a specimen and
symbolized with a icon. For specimens which are still on loan a icon is shown while a
returned loan is symbolized with a icon (see image below). A data embargo will be
symbolized with a icon. If there are older accession numbers linked to a specimen involved
in a transaction, these numbers can be documented together with the entry of the
transaction of the respective part of the specimen. 

           

If you are a CollectionManager, you may take a look at the details of a transaction. Select the
specimen part in the tree and click on the button which will be shown in the details next to
the name of the transaction. This will open the window for the transactions as described
below. 

 

To edit the transactions choose Administration - Transactions from the menu. A window
will open as shown below. In the tree at the top the relations between the transactions are
shown. To create a transaction dependent on another transaction choose the superior
transaction in the tree and click on the button in the panel right of the tree. With the 
button you may create a copy of a transaction. To delete a specimen from the list click on
the button. To transfer all selected specimen in an existing transaction choose Data -> 
Transfer -> To transaction... from the menu and choose the transaction where the
specimen with all their parts should be included. In two following dialogs you may restrict the
transfered parts to a certain collection or material category. The data for the transactions is
stored in the tables Transaction and CollectionSpeci menTransaction. 

To view the history of a data set click on the button. A window with the history will open.
For more details see the section History.

Data entry 

On this page you may edit the data of a transaction. Every transaction is linked to an
administrating collection (symbolized by the key ) and can be edited exclusively by
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CollectionManagers of this collection. To appoint managers choose Administration -
Managers from the menu.

 

The transactions can be organized in a hierarchy as shown in the image above, if e.g. you
wish to keep together all loans to a certain institution. To create a transaction of an inferior
transaction choose the superior transaction in the tree and click on the button in the panel
at the right side of the tree. To create of copy of a transaction, use the button and the 
button to delete it. 

Depending on the type of the transaction additional tab pages will appear for creating
documents.

Tabs  Transaction
types

Data entry Loan Borro
w 

Exch
ange
 

Gift Purchase Request Inventory Embargo 

Sending Loan Borro
w 

Exch
ange
 

Gift Purchase 

Confirmati
on Loan Borro

w 

Exch
ange
 

Gift Purchase Request 

Reminder Loan Borro
w 

Exch
ange
 

Gift Purchase 

Partial
return

Loan Borro
w 

Return Loan Borro
w 

Printing Loan Borro
w 

Exch
ange Gift Purchase Request Inventory 
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Document
s Loan Borro

w 

Exch
ange
 

Gift Purchase Request Inventory 

Balance
Exch
ange
 

 

Common notes

On the tab pages for generating documents you need to specify a xml-schema for your
document. Click on the button to choose one of the predefined schemas or create your
own. To edit the schema files (*.xslt) you may use a text editor or software like e.g. EditiX. If
you do not specify a schema for your form (i.e. the field for the path of the schema is empty
- see below), you will see the XML output created by the database as shown below.

 

To choose a schema click on the button and select a schema from the list.
DiversityCollection contains several ready to use schemas in the folder Transaction -
Schemas. 
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Feel free to change these schemas according to your own needs (editors are available e.g.
from http://www.altova.com/). Choose the schema you need and click on the button to
create a document. To print the document use the button. To store the current document
for later reference in Documents click on the button. An example for a document is shown
below.

The specimens will be listed with their accession number, an optional label of the part and the
material category to ensure discrimination in case a specimen contains more than one part
(see image below).

If a transaction entry has no address or transaction partner linked to an entry in the module
DiversityAgents, where addresses are stored, the program will try to find an address in one of
the superior transactions from the transaction partners found there. If no address exists in
these transactions, the program will try to get an address from the collections. Therefore, a
transaction partner linked to DiversityAgents is only necessary if either there are no addresses
for the collections or you wish to use a different address. The search path as described is
summarized in the image below.   
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Transactions - Sending  
In the sending tab page of the transaction window you can create the covering note for a
sent sample. To choose a schema click on the button and select a schema from the list.
DiversityCollection contains several ready to use schemas in the folder Transaction -
Schemas. 

To add a specimen to the list, you can use a barcode scanner. The code detected by the
scanner will be displayed in the field behind the symbol and entered in the list below. If no
scanner or barcode is available, use the combobox underneath, enter the first letters of the
accession number of the specimen and select your specimen from the drop down list. In case
your scanner is reading only parts of the barcode try to adjust the timer intervall - click on
the button to open a window as shown below.

 

To restrict the selection of the specimens and parts of the specimens, you can check the 
Restrict to collection ... and Restrict to material ... options. To remove a specimen from
the list, use the button under the specimen list. If you want to see the details of a
specimen, choose it in the list and click on the button. Click on the button to create the
document as shown below.

Page 208



Transactions - Confirmation  
On this page you may create an inquiry letter for a package sent, e.g. if a parcel was sent to
a loan taker and no confirmation that the parcel reached its destination was returned so far.

With the button choose the schema you need. Click on the button to create a document.
To print the document use the button. To store the current document for later reference in
Documents click on the button.
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Transactions - Reminder  
If a loan is due to return or a loan taker did not meet the deadline, you may create a prompt
note here. 

With the button choose the schema you need. Click on the button to create a document.
To print the document use the button. To store the current document for later reference in
Documents click on the button. 

In the upper right list the missing specimen and at the lower right list the returned specimen
are listed.
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Transactions - Partial Return 
If parts of a loan were returned, create a letter of acknowledgment here.

With the button choose the schema you need. Click on the button to create a document.
To print the document use the button. To store the current document for later reference in
Documents click on the button.

 

You have two options to enter returned specimen. Use the and buttons respectively to
move items between the lists or use a barcode scanner . Move the mouse cursor into the
field for barcode detection and scan the barcode. The specimen will be automatically inserted
into the list for the returned specimen. In case your scanner is reading only parts of the
barcode try to ajust the timer intervall. Click on the button to open a window as shown
below. Here you may set the interval to a value which is compatible with your scanner. If you
wish to see the details of a specimen, choose it in the list and click on the button.
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Transactions - Return  
If a loan is returned, you may create a letter of acknowledgment here. With the button

choose the schema you need. If all specimen were returned, click on the button. This will
include all remaining specimen into the list of the returned specimens. With the date field you
may define a different date as start, if e.g. you started to register the returned specimen
several days earlier. Click on the button to create a document. To print the document use
the button. To store the current document for later reference in Documents click on the 
button.

 

To transfer the items from the Specimen on loan list to the Sent specimen list click on the
button. After all documents are generated and saved, click on the button above the Sent

specimen list to enter the changes into the database.
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Transactions - Printing / Inventory  
In addition to special pages for creating letters along with a loan, this page provides the
possibility to print cover letters, inventories etc. You may restrict the selected specimen to
the current collection, include subcollections or all related collections - simply activate the
corresponding checkboxes. 

To add a specimen to the list you may either use the combobox or a barcode scanner. To use
the barcode scanner move your mouse cursor into the pink field on the right of the scanner.
In case your scanner is reading only parts of the barcode, try to adjust the timer intervall.
Click on the button to open a window where you may set the timer intervall to a different
value. To remove a specimen from the list select it and click on the button.

With the button choose the schema you need. Click on the button to create a preview of
the document. To print the document use the button. To store the current document for
later reference in Documents click on the button. 
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Transactions - Documents  
This page stores all the documents created or received along with a transaction.

 

 

To add a document scan it and create a screeshot of said document. Then create a new

entry (click on the  button) and insert the screenshot with the button.
In the lower part you may enter any text related to the document. 
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Transactions - Balance  
This is the balance for the exchange between two collections. 

With the button choose the schema you need. Click on the button to create a document.
To print the document use the button. To store the current document for later reference in
Documents click on the button. To include either the subcollections of any related
collection or the collections of the current transaction select the corresponding checkboxes. 
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Transactions - Embargo  
If specimens should not be published for a certain period, you are able to create a transaction
of the type embargo and add parts of the specimen in question to this embargo. If a specimen
is part of an embargo, it is shown as in the image below for current and past or future
embargos . 

To create an embargo choose Administration -> Transaction management ->
Transaction from the menu, create a new transaction and choose the type embargo for the
new transaction. The period of the embarge is defined by its Beginning and End (see below). 
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Maintenance
To open the maintenance form choose Administration -> Maintenance ... from the menu.
With the maintenance functions you can update values cached from other modules or external
webservices. DiversityCollection can be linked with several other modules of the
DiversityWorkbench. If you link a data source to another module, the URI of the data set in
the other module together with one or several cached values will be stored in
DiversityCollection. Due to changes in the source modules these cached values may differ
from the original values. To get the actual values you can use the synchronize functions
for taxonomic names, family and orders, people, exsiccatal series, geographical names and

references. Further functions provided by maintenance are a search for duplicate
accession numbers, the insert of updated taxonomic names, the removal of orphaned
CollectionEventSeries and CollectionEvents, the search for additional geographical
information based on WGS84 coordinates and the conversion of coordinate systems.
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Maintenance - Taxonomic names
To synchronize the entries for the taxonomic names derived from the module
DiversityTaxonNames choose Administration -> Maintenance... from the menu. A window
will open as shown below. To synchronize the taxonomic names for entries linked to the
module DiversityTaxonNames choose the tab Collection <-> TaxonNames. There are two
ways to synchronize taxonomic names. You may either Synchronize taxonomic names
based on the link via an URI for entries where the link to a taxonomic database is already
established or you may Synchronize taxonomic names missing a connection where no link
is established and you can query for identical names in one of the databases. 

Synchronize taxonomic names based on the link via an URI

The taxonomic names are stored in the field TaxonomicName in the table Identification. Select
a taxonomic database and a project which should be synchronized. Start the query with a

click on the  button. 

 

 

If you synchronize your data with a webservice as shown in the image below, you can specify
the taxonomic group as well.
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The form will list all differences found. To update the database click on the 

button. If you wish to have a more detailed look on your data, you need
to check the Include accession number checkbox before starting the query. A button

will appear which will take you back to a single data set in the database.

Synchronize taxonomic names missing a connection

Select a taxonomic database and a project within this database, a project in the collection
database and a taxonomic group to search for identical names. Start the query with a click on
the Check for identical names button. You may either restrict the search to an exact match
(= Compare whole name) or to the first parts of the name (= Compare first parts) as
shown below. If the names do not match exactly, you may either update the name (= Update
similar name) in the collection database or import the name from the DiversityTaxonNames
as a new identification (= Insert as new name - see options in the window depicted below).
If you choose the option Restrict to last identification, the former idenfications of an
organism will be ignored. In the result list only matching names will be checked (column OK).
The other results will be marked indicating the difference. Yellow indicates a difference in the
authors while red indicates differences in main parts of the name. To use these similar names
check them in the OK column. 
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The form will list all matches found. To insert the links to the database click on the 

button. If you wish to have a more detailed look on your data, you need
to check the Include accession number checkbox before starting the query. A button

will appear which will take you back to a single data set in the
database. 

 

Synchronize taxonomic names missing a connection with Index Fungorum

To synchronize the taxonomic names with the webservice of Index Fungorum select
IndexFungorum as Taxonomy database. You may either compare the entire name or the first
parts of the name (see image below and description above). If the name in your data does not
match the name in Index Fungorum perfectly, the name will be marked with a yellow
background (see below). 
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Names where several similar names were found will be marked with a blue background. To
select one of the similar names click on the Select valid name button. A window will open
as shown below listing all similar names found in Index Fungorum. Select one name and click
OK to use it. 
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Maintenance - Family and Order
To synchronize the entries for the family and order of taxa derived from the module
DiversityTaxonNames choose Administration -> Maintenance from the menu. A window will
open as shown below. To synchronize the higher taxonomic entries for entries linked to the
module DiversityTaxonNames choose the tab Family and order. These entries are stored in
the fields FamilyCache and OrderCache in the table IdentificationUnit.

In the upper part you may synchronize your data with the entries in taxonomic databases like
DiversityTaxonNames_Fungi. Select a taxonomic database, a project and a taxonomic group,
then choose whether you wish to synchronize the family or the order. If you wish to inspect
single data sets you need to check the Include accession number checkbox. Then click on

the  button to start the query. 

The form will list all differences found as shown below. To update the database click on the 

button. 
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In the lower part you may synchronize your entries within the database. Choose a project,
the taxonomic group and if you wish, the family or the order and click on the 

button to start the query. To import the higher taxa to the data set

click on the button. 

 

If you wish to have a more detailed look on your data, you need to check the Include

accession number checkbox before starting the query. A button will
appear which will take you back to a single data set in the database.
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Maintenance - identifications
If you wish to add updated taxonomic names for specimen in the database, you can use the
bulk insert function. Choose the project, the taxonomic group and the taxonomic name for
which the new identification should be added. As shown in the window below you may enter
additional information about this identification. By default the [Only last identification]
option is checked to prevent you from searching in older identifications. If you uncheck this
option, the program will search for any identification, irrespective whether it is the last or an
older identification. 

If you wish to check single data sets check the [Include accession numbers] option. A new

button will appear which will enable you to close the window and turn to
a specimen selected in the table. 

To search for names click on the [Test] button. The found names will be listed in the table as
shown below. To insert the new identification click the [Start insert] button.
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Maintenance - Accession number duplicates
The database will warn but not prevent you from entering an accession number several times
e.g. via an import. To check for duplicate accession numbers choose Administration ->
Maintenance from the menu. A window will open as shown below. On the tab page 
Specimen you may restrict the query to a project. To start the query simply click on the
Check for duplictes button. 

The form will list all duplicates found as shown above. To switch to a data set in the database

select it in the table and click on the button.
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Maintenance - Exsiccatae
To synchronize the abbreviations of the exsiccatal series titles which are linked to the module
DiversityExsiccatae choose Administration -> Maintenance... from the menu. A window will
open as shown below. On the tab page Collection <-> Exsiccatae select the project for
which the titles should be synchronized. The title is stored in the field ExsiccataAbbreviation in
the table CollectionSpecimen. Select the project which should be synchronized and start the

query by clicking on the  button. 

The form will list all differences found. To update the database click on the 

button. If you wish to have a more detailed look at your data, you need
to check the "Include accession number" checkbox before starting the query. A button 

will appear which will take you back to a single data set in the database.
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Maintenance - Agents
To synchronize the names of collectors, determinators etc. which are linked to the module
DiversityAgents choose Administration -> Maintenance from the menu. A window will open
as shown below. On the tab page Collection <-> Agents select the project for which the
agents should be synchronized. There are 9 tables which may contain links to
DiversityAgents: Collection, CollectionAgent, CollectionEventLo calisation,
CollectionEventProper ty, CollectionSpecimen, CollectionSpecim enProcessing, Identification,
IdentificationUnit Analysis and Transaction. Choose one of these tables for the

synchronization. Then start the query with a click on the  button. The
type name is written as defined by the default display type in the module DiversityAgents - for
more information please see the documentation on DiversityAgents. 

The form will list all differences found. To update the database click on the 

button. If you wish to have a more detailed look on one of the data sets
in the list, you need to check the "Include accession number" checkbox before starting the

query. A button will appear which will take you back to a single data set
in the database. 

 

Search for possible links

You can either update the cached names for entries which are linked to DiversityAgents as
described above or you can search for possible links based on the names as shown below. In
addition to the options described above you may choose the display type for the query to find
any possible match as names may be written like "Hertel, H.", "H. Hertel" etc.

Page 228



 

Page 229



Maintenance - References
To synchronize the titles of the references which are linked to the module DiversityReferences
choose Administration -> Maintenance from the menu. A window will open as shown below.
On the tab page Collection <-> References select the project for which the reference titles
should be synchronized. There are 3 tables which may contain links to DiversityReferences: 
CollectionEvent, CollectionSpecimen and Identification. Choose one of these tables for

synchronization. Start the query with a click on the  button. 

The form will list all differences found. To update the database click on the 

button. If you wish to have a more detailed look on one of the data sets
in the list, you need to check the "Include accession number" checkbox before starting the

query. A button will appear which will take you back to a single data set
in the database.
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Maintenance - CollectionEventSeries
To delete CollectionEventSeries with no relation to CollectionEvents or other event series
choose the tab page Event series. Click the List unrelated event series button to list
these series and the Delete unrelated event series button to delete them. 
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Maintenance - CollectionEvent
CollectionEvents - unrelated events

Provided you have the proper rights you can remove unlinked data sets in the tables
CollectionEvent and CollectionEventSeries. To delete events which are not linked to any data
in the database use the tab page CollectionEvents - Remove unrelated events.
These unrelated data sets may e.g. be derived from specimens which were transferred to
another CollectionEvent. Click on the [List unrelated events] button to list all events which
are not related to a specimen. The found CollectionEvents will be listed in the upper part of
the form. The lower part shows the localisations and the event properties related to these
CollectionEvents. These must be deleted first before you can delete the events related to
these data sets. Otherwise only the events with no relations to localisations or properties will
be deleted.

 

 

Country, Place and Altitude via GeoNames

If your data sets contain WGS84 Coordinates, you can use the webservice 
www.geonames.org to insert or update the country, the place or the altitude of your
collection sites. Choose the tab Set place and country, the project you wish to update
and an optional upper limit of the data sets (recommended for slow connections). Click the 
Query GeoNames button to start the query. According to the selected option (only if missing
/ when different / for all entries) the retrieved data will be marked with colors as shown in the
images below. 

Whit
e

The data set will be inserted or changed

Red An error occured
Grey According to the selected option this data set will not be inserted or changed
Yello
w

The data set has been deselected and will not be inserted or changed

Gree The data set has been inserted or changed
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In the first column you can deselect a data set for the update. To inspect a single data set
from the list select it and click on the Close window and check data set button. To
update the data set click on the Set countries button. 

As for countries, the places will be listed as shown below. 

To insert or update the selected data sets click the Insert places button. 
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The image above shows the data for the altitude. After the update all updated data sets will
be marked green (see below). 

 

Sampling plots

If your data contains references to sampling plot coordinates, you can update the locality
description according to the name of the sampling plot (see image below). Click on the Start
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search button to find links to SamplingPlots where the locality description does not
correspond to the name of the sampling plot. You can restrict the search to missing locality
descriptions and attach the name of the sampling plot to the existing entry in the locality
description. Use the Start update button to set the locality description according to your
settings and the differences found. 

If your data contains or needs coordinates, please see the corresponding chapter on adding
and calculating coordinates.
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Maintenance - Collection event coordinates
Add Coordinates

If your data contain coordinates you can add additional coordinates in a different system for
those dataset, where entries of the additional coordinate system are missing. E.g. you can
add WGS84 coordinates on the basis of Gauss Krueger coordinates. In the Add coordinates
tab choose the project you want to update and an optional upper limit of the datasets. Then
select the source coordinates and the coordinate system these should be converted into.
Click on the Start conversion button to start the conversion. Where a conversion is not
possible, the fields for the target system will be empty as shown below. Click the Insert
coordinates button to insert the new coordinates into you datasets.  

 

Calculate Coordinates

If your data contain coordinates e.g. written as non numeric entries you can try to calculate
numeric values from these entries(see below). Click the Insert coordinates button to insert
the new coordinates into you datasets.  
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Add Coordinates for TK25 entries

If your data contain TK25 (= MTB) entries you can add try to retrieve the coordinates and
geography for these entries from data in the module DiversityGazetteer (see below). Choose a
project and click on the Find differences button to search for coordinates. Click the Start
update button to update the TK25 entries with the found coordinates.  
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Maintenance - Gazetteer
To synchronize the entries derived from the module DiversityGazetteer choose 
Administration -> Maintenance from the menu. A window will open as shown below. On the
tab page Collection <-> Gazetteer select the project for which the entries should be
synchronized. There are 3 targets for the synchronization: Locality name stored in the field 
Location1 in table CollectionEventLo calisation, Country stored in the field CountryCache in
the table CollectionEvent and the Coordinates stored in the fields AverageLatitudeCache and
AverageLongitudeCache in the table CollectionEventLo calisation. Select one of these targets

for synchronization. To start the query click on the  button. 

The form will list all differences found. To update the database click on the 

button. If you wish to have a more detailed look on your data, you need
to check the Include accession number checkbox before starting the query. A button

will appear which will take you back to a single data set in the database.

To check for countries which do not match entries in DiversityGazetteer choose Country from
the list as shown below.
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The image above summarizes the options for an update of the country. You may restrict your
query to one of the projects you have access to. If you wish to check single data sets, check
the include accession numbers option before you start the query. To keep the old entry in
the Notes field check the Add original to notes option.

 

Maintenance - Gazetteer: Adding links
To set links to the DiversityGazetteer for places which are not linked so far choose the second
tab under Collection <-> Gazetteer for synchroziation of places missing a connection to the
DiversityGazetteer. Choose the database and the project and click on the Start query
button. The results will be listed as shown below.
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As many places have identical names in different regions you may restrict the query to places
within a certain hierarchy. In the example below this was done twice: First type e.g. Ger in
the Hierarchy box and select Germany from the list. Then choose within the list to receive all
levels within Germany - in this example Bavaria was chosen, restricting the query to places
within Bavaria. 

The unambigous results will be selected by default (see image above). The number of identical
names found in the gazetteer is listed in the column Number of places. Ambigous names will
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not be selected by default, you may, however, include them in the update, if matches for the
name were found. To inspect a single data set to evaluate the found place select it in the list
and click on the Inspect data set button. This will open a window showing the entire data
set. Finally, click on the Start update button to enter the results in the database (see
below). 
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Maintenance - Insert missing organisms in
specimen parts
To print a label for your samples you need to specify which of the organisms in the specimen
should be shown on the label. If for any reason the organisms where not included into the
parts as shown in the image below, you may do this belated for all data sets for a selected
project. 

Select the print tab as well as the project and click on the [Check for missing units in
parts] button. The missing entries will be listed as shown below. To insert them click on the
corresponding button. 
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Import
There are several import mechanisms: 

Import wizard for tab separated lists: Import data from foreign sources and attach further
data to data sets in the database.

Import of specimen scans: Import image data, where the accession number is a part of the
file name. Image data can be imported together with default information to the entire batch.

Import and reimport of tab-separated lists: Import data from foreign sources and reimport
after external editing.

Export
There are several export mechanisms: 

Export of tab-separated lists: Export data in a tab separated format for external analysis or
editing.

Export from Grid-Mode using the export function. 

ABCD: Export data as XML according to ABCD schema 2.06. 

JSTOR: Export data as XML according to format of JSTOR and the Global Plant Initiative
respectively. 

BIB: Export data as files according to format of the Botanischer Informationsknoten Bayern. 

Naturgucker: Export data as files according to format of the Naturgucker initiative. 

Generation of labels. 

Generation of inventary lists. 

Replication with a local database

An overview of some options for the im- and export of data is shown in the image below. The
export and reimport of tab-separated list allows external editing of the data in e.g. spread
sheet programs
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Import specimen scans
With this import routine you can import new data sets along with new images into the
database. To achieve this the image files should be named corresponding to the accession
numbers of the data sets which should be imported (e.g. M-003145 in the example below) and
an optional trailing identifier (e.g. _20070711_122541 in the example below. The image below
shows an overview of the entire import process.

To import images like scanned labels from specimens choose Data - Import - Specimen
scans... from the menu. A window for the import of images will be opened (see below).

The fields marked with  red  are mandatory. 

Image source
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To select the images you wish to import in the database click on the  button. A dialog will
open where you can select the images you wish to import into your database.

Select the files and close the window to enter the selection of the images in the list in the
form.

 

Import options and security checks

If you wish to replace data sets for images already in the database, check the Overwrite
existing images checkbox. If the images are located in a subfolder wich is named according
to the first characters of the accession number, check the Place images in subfolder of
length checkbox and specify the length of the name of the folder. If you wish to check the
URIs of the images, check the corresponding checkbox. The data sets will then only be
imported if the images are available on the web. If the filename next to the accession number
contains a trailing identifier, it must be separated by a unique character. Check the
corresponding box and enter the separating character. If you wish to assess whether the
accession numbers are correct, you can check the start and the length of the accession
number by checking the appropriate checkboxes.   

Image list

The list shows the image files selected for the import. To test if all files satisfy the specified
checks, click on the Test import button. If the file name passed all checks, the OK field for
the image will be checked after the test. Otherwise an explanation for not passing the checks
will be shown in the  Error column. 

The first column of the list shows the accession number extracted from the file name. The
second column shows the file name of the original image file and the path written in the
database. These paths may differ from the original, if you select the option for setting a
different BaseURL. If a data set for an image already exists in the database and you selected
the Append images option, the checkbox Append at the right end of the table will be
checked.

Database
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You can set several mandatory and optional values to be written in the database for all
imported data. The fields marked with  red  are mandatory. These are the collections in which
the specimens are located: the material categories of the specimens, the project, the content
type of the scans (e.g. label) and the taxonomic group of the main organism in the specimens.
If you wish to refer to a web source for the labels instead of a local file, you need to provide
the base URL as well. Optional fields are a place according to the DiversityGazetteer and the
date of the gathering event, the collector, the accession date, an identification, an exsiccatal
series and the type of the label. For explanation of the buttons see module related entries . 

To test the import and whether the images are present in the database click on the 

 button. If everything is fine click on the button to start the
import. 

Logfile: To log the list of imported images and any errors during the import check the Create
log file checkbox. This will create a log file with your name, the date and time of the import in
the directory where the image files are located.

The program will check whether an accession number is already present in the database. It
will only import the data, if the option Append images if accession number is present is
checked. Otherwise this data will not be imported.

If the images will be provided by a webserver, check the appropriate checkbox and specify
the folder or click on the  button to search for the website.

In the overview below the mandatory fields are marked with red, the optional fields with
yellow.
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Import tab-separated lists
With this import routine you can import data as tab-separated lists into the database.
Choose Data -> Import -> Import list... from the menu to open the window for import. In
the window click on the button to select the file with the data you wish to import. Use the
proper [encoding] to ensure that all special characters will be transferred correctly. If you
change the encoding after opening the file, click on the button to reload the file with the
new encoding. 

The content of the file will be shown in the upper part of the [Column mapping] tab page.
Use [Data start in line] to set the area for the import. Preceeding lines will be ignored and
depicted with a  gray background   as shown below. Every column in your file must be either
ignored or mapped to a column in the database. The lower part of the mapping section shows
your mapping while the upper part contains the first lines of your file. You can either use a
prepared column mapping or create a new one. To import a previous column mapping click on
the   button and choose one of the XML-files. 

Column mapping

For a column which should not be imported choose the  black  color from the group as shown
for the second column in the image below. These columns will be ignored for the analysis and
the import. For all other columns choose the [Table] and the [Column] your data
corresponds to. If you wish to import two different data sets in the same table, you need to
change the [Alias for table] to a unique value for this data set. 

If some columns should be transferred into one field, you have to choose a group for these
columns as shown below for columns 3 to 5, 6 to 9, ... . Simply choose a color from the group
combobox other than white or black to choose a group. To save the current mapping click on
the button. 
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To analyse the data in the file click on the [Analyse] button. During the analysis the program
may ask you to give additional information like the taxonomic groups of the imported
organisms. In the upper part of the window you may add information to be imported together
with your data from the file. The available options depend on the structure of your data. 

The image below shows the tab page where you can define the relations between two
organisms. This might be necessary if e.g. your data contains information on parasites and
hosts. The data tables which are related to an identification are listed with their aliases in the
lists for the identification tables. Use the    and    buttons to move them between the lists.
Use the    buttons to change the sequence within a list. With the [Host] option 
you define the host and the [Main] option defines which organism will be chosen as the first
to be printed e.g. on a label. 

 

 

By default one CollectionEvent will be created for each data set. 
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If the events should be joined following the entries in the file, you can choose the second
option as shown below. The import will create a new event, if there were any changes made
to the data related to the CollectionEvent, like the description of the locality, the altitude, the
coordinates etc.

 

If all the data sets belong to one EventSeries e.g. to one expedition, you can choose the
option as shown below and enter the code and description of the EventSeries in the
corresponding fields.

 

If you wish to use an existing EventSeries, click on the button and select a series from the
form. The code and description of the selected series will be shown as in the image below.

 

After your data was successfully analysed, the window will show you the result as shown in
the image below. During the analysis the program will add missing tables and columns
necessary for the import. The first data set will be shown in the form. If you wish to check
more data sets, set the number of the last position you wish to check and click on the 
[Analyse] button. The data is arranged according to the tables in the database in which they
will be imported. The underlined fields belong to the primary keys of the respective tables and
are red, if missing. These missing values will be generated during the import. If a data set
contains no values and will therefore not be imported into the database, the columns will be
shown in blue. To import these entries anyway choose the [import empty values] option. To
browse through the data sets in the preview use the buttons. 
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To import the data click on the [Start import] button. If you wish to import only part of the
data e.g. for a test, choose the [Import first ... lines] option.   
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Export
There are several options to export your data. You can either export data of the entire
database or the content of the data sets listed in the specimen list. 

Export data of the whole database

Export of the content of the entire database is possible either as a backup on the database
server or as export as csv files. See the Backup chapter for more details. 

Export data of selected specimen

For the export of selected specimen there are several options. If you want to define the
content and format which should be exported, use the List export. An export which can be
configurated my also be executed using the export functions of the grid views for Specimen,
Organisms , Parts and CollectionEvents. 

Predefined export formats are available as XML for the ABCD (see www.tdwg.org) and the
GPI/JSTOR standard as well as text files for the BIB (see www.bayernflora.de) and
Naturgucker (see www.naturgucker.net) portals.
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Export data as tab-separated lists
You can export the content of the datasets listed in the specimen list into a tab-separated
list. Choose Data - Export - Export list... from the menu. A window as shown below will
open. To change the preset path of the export file use the button. 

To start the export click on the [Start export] button. A file will be created in your
application directory, containing the exported data. A preview of the data is shown in the
lower part of the form. If you check the include columns for reimport option, the header
will contain an additional line for table names which you can use for reimporting the data. If
you check the include the SQL-Query option, the Text of the command for selecting the
datasets will be attached at the end of your report. The form will show the first lines as set in
the Show first ... datasets (range: 1 - 99) as a preview. During the first export, the list for
the fields for sorting the results [Order by:] will be filled. So if you need sorted results just
restart the export after selecting the field after the first export. 

To choose the fields you want to see in the export click on the button. A window
will open as shown below, where you can choose the fields you want to export. 
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Please keep in mind, that only the datasets listed in the specimen list of the main form will
be exported. If for example you set the maximal number for the specimen list to 100, only
these datasets will be exported, even if the number of datasets related to your query will be
more than 100. 

Please be aware, that you will get "cross joins" between the data in your database as in the
example shown below. If for example you start an export containing taxa and collectors and
you have 3 taxa and 2 collectors in a dataset this will result in 6 lines in the export: every
taxon combined with every collector (3 x 2 = 6). To evaluate the data you have to group the
results accordingly. The first line in the file corresponds to the description as shown in the
form above for the selection of the export fields. The second line shows the tables and the
third line the column within the database. The following lines contain the data. If you want to
avoid these cross joins and need only one line for each dataset, please use the export
funktion of the grid mode. 

Accession number Taxon Collector 
CollectionSpecimen IdentificationUnit CollectionAgent 
AccessionNumber LastIdentificationCache CollectorsName 
M-0013579 Arthrocladiella mougeotii (Lev.) Vassilkov Sandu, C. 
M-0013579 Arthrocladiella mougeotii (Lev.) Vassilkov Savulescu, T.
M-0013579 Blumeria graminis (DC.) Speer Sandu, C. 
M-0013579 Blumeria graminis (DC.) Speer Savulescu, T.
M-0013579 Lycium barbarum Sandu, C. 
M-0013579 Lycium barbarum Savulescu, T.
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Reimport tab-separated lists
With this import routine you are able to reimport data in tab-separated lists which have been
exported from the database. Choose Data -> Import -> Reimport list... from the menu to
open the window for the reimport. To reimport data it must have been exported using the
option [add columns for reimport] to ensure correct header lines in your file. As the client
provides no possibility to change data on the basis of lists, you may export the respective
data to a tab-separated list, change your values and reimport the data.

In the window click on the button to select the file with the data you wish to import. Use
the proper [encoding] to ensure that all special characters will be transferred correctly. If
you change the encoding after opening the file, click on the button to reload the file with
the new encoding. The content of the file will be visible as shown below. For a reimport the
data will always start in line 7, indicated by a  gray background  of the header lines.

To analyse the data in the file click on the [Analyse] button. After a successful analysis, the
window will show you the result as shown in the image below. The first data set will be shown
in the form. If you wish to check more data sets, set the number of the last position you wish
to check and click on the [Analyse] button. The data is presented according to the tables in
the database where they will be inserted. Underlined columns belong to the primary key of the
respective tables and are red, if missing. These missing values will be generated during the
import. If a data set contains no values and will therefore not be imported into the database
or updated, the colums will be shown in blue. To import these entries anyway choose the
[import empty values] option. To browse through the data sets in the preview use the

buttons. 

To import your data click on the [Start import] button. If you wish to import only a part of
the data, e.g. for a test, choose the [Import first ... lines] option. 
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Export ABCD
In the current version only the main data from DiversityCollection will be exported to ABCD. 

To export the data of the specimen selected in the specimen list following the ABCD schema
2.06 choose Data -> Export -> XML (ABCD Schema)... from the menu. A window will open
where you can set some additional parameters defined in ABCD and BioCASE respectively as
shown below. 

To start the export click on the Start export button. The data will be exported into a file in
your application directory. Click on the button to inspect the exported data (see below). 
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Export for the Global Plant Initiative / JSTOR
To export the data of the specimen selected in the specimen list according to the Global Plant
Initiative / JSTOR choose Data -> Export -> XML  -> GPI / JSTOR ... from the menu. A
window will open where you can set some additional options for the export (see below). The
data sets will be exported according to the JSTOR Plant Science Handbook (June 2011). 

If the data does not fulfill the critera of the Global Plant Initiative / JSTOR, the errors will be
listed as shown below. You have to fix these errors in your data to create a valid export file.
To start the export click on the Start export button. The data will be exported into a file in
your application directory. Click on the button to inspect the exported data (see below). 
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Export for the Botanischer Informationsknoten
Bayern (BIB)
To export the data of the specimen selected in the specimen list according to the Botanischer
Informationsknoten Bayern choose Data -> Export -> Floristic lists -> BIB ... from the
menu. A window will open as shown below. The data sets will be exported in 2 files according
to the format of BIB. 
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Export for naturgucker
To export the data of the specimen selected in the specimen list according to naturgucker
choose Data -> Export -> Floristic lists -> Naturgucker ... from the menu. A window will
open as shown below. The data sets will be exported in a file according to the format of 
Naturgucker. In the form you can choose among the taxonomic groups and analysis provided
in the selected data. 
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Label

If there is only one part in your specimen, click on the printer symbol in the button to
switch to the printing mode. If your specimen contains more than one part, choose the part of
the specimen for which the label should be generated and click on the  button in the right

panel. The image area will switch to the label view and in the data area the details
related to the label will be accessible. The sequence is shown in the image below.

 

Additional information about a label is entered in the label section (see image below). The data
is stored in the table CollectionSpecimen.&nb sp;

 

The organisms of a specimen are printed on a label according to the display order.

To print a label for a specimen you have to select a schema file. There are default schema
files available in the folder LabelPrinting/Schemas in your application directory. Click on the 

 button to open the directory. You will find several prepared schema files among which you
can choose or change them to your own needs or create new ones respectively. The schema
file LabelTemplates.xslt provides templates for the other schema files. You may give a title
for the print in the field Title. From the Collection and MaterialCategory available for the
selected specimen choose one from the list (Coll./Mat.). To generate the label for the
current specimen click on the  button. To generate labels for all specimens in your query
click on the  button. If you need duplicates of your labels change the number in the

duplicates box to the desired value. You can print 1 - 99 duplicates of one label. If there
are more than 20 specimens in the list, you receive a warning whether you really wish to
create all these labels as this could be somewhat time consuming. The labels are generated as
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XML files with XSLT-schema files, transformed to HTML-files and depicted in a browser. To
print the label click on the  button. 

If you wish to print labels for duplicates which are stored in a different collection, the
duplicate should be a child of the original specimen as shown in the example below.

 

Depending on the schema you use, the label will be marked as duplicat and contain a
reference to the original specimen (see below).

If you wish to save the generated files for later printing, click on the  button to do so. Note
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that the program will by default create a file Label.xml and in case a schema file is specified
a file Label.htm in the LabelPrinting directory which will be overwritten every time you
generate a new label. Thus, you need to save the file under a different name or in a different
directory to prevent the program to erase this data.

If you use Code 39 for your labels and wish to print the barecodes on the labels, you need
the font  , which is included in the DiversityCollection package. Place this font in
the folder where your fonts are stored (e.g.: C:\WINNT\Fonts). If the font is not available,
the Barcode will appear as the accession number between two '*' signs.

If you wish to print labels for all the specimens in the specimen list, you can restrict these to
the collection and the material category of the current specimen part (see image above).

If you do not select a schema file, i.e. the textbox Schema file: is empty, you will see
the generated XML-file as shown in the image below. The XML file is the base for all label
types you wish to generate. To create your own labels simply design your own XSLT-schema
file. See e.g. http://www.w3.org/TR/xslt for further information about schema files.

If you wish to reformat the accession number, you may choose among the options provided by
the program, e.g. conversion of arabic to roman numbers (BSPG-1988-007-00001 ->
BSPG-1988-VII-00001). Select the format from the combobox [Conversion] shown above.

Page 264

http://www.w3.org/TR/xslt
http://www.w3.org/TR/xslt


Replication
If you wish to work with your data on a local database (called subscriber), e.g. on your
labtop, not linked to a database on a central server (called publisher) and these data should
be synchronized with the data in the database on the server, you may use the replication
function of DiversityCollection. To install the database on your local computer see the 
installation section. 

To use the replication function you require the roles Replicator or Administrator. 

Add Publisher 

To define a publishing database choose Data -> Replication -> Add Publisher from the
menu. A window will open where you choose the publisher. After the publisher is set, you may
transfer data between your local database (subscriber) and the publisher. This function is
only available for administrators.

Remove Publisher 

To remove a publisher from the list choose Data -> Replication -> [Publisher] -> 
Remove from the menu (where [Publisher] is the name of the publishing database on the
publishing server). This function is only available for administrators.

 

Clean database 

Initially you may wish to remove all previous data from your local database (subscriber).
Choose Data -> Replication -> Clean database ... from the menu. A window will open
as shown below where you may choose the ranges which should be cleared: 

 Definitions = the basic definitions within the database, e.g. the available taxonomic
groups. 

 Descriptions = the descriptions and their translations of the tables and columns of the
database. 

Page 265



 Project, User = the available projects and users. 
 Basic data = basic data like the collection. 
 Data = the specimen, organisms etc. 

Choose the data ranges you wish to clear and click on the button. All tables which contain
data will be listed as shown below.

 

Choose the tables which should be cleared and click on the Clean database button. Please
keep in mind that you can not delete data from a table as long as there is data in a relateted
table depending on the data you wish to delete. The sequence of the tables is organized to
avoid these problems.

 

Download 

To download data from the publisher choose Data -> Replication -> [Publisher] -> 
Download from the menu (where [Publisher] is the name of the publishing database on the
publishing server). A form will open as shown below. Choose the project of the data and the
data ranges (see above) which you wish to download. Click on the button to list the tables
containing data. To start the download click on the Start download button.
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Merge 

To merge data from your local subscriber database with the publisher you must first choose a
project. Choose Data -> Replication -> [Publisher] -> Merge from the menu (where
[Publisher] is the name of the publishing database on the publishing server). As with the
download, choose the data ranges and click on the button. To start the upload click on
the Start merge button.

 

Upload 

To transfer data from your local subscriber database to the publisher you must first choose a
project. Choose Data -> Replication -> [Publisher] -> Upload from the menu
(where [Publisher] is the name of the publishing database on the publishing server). As with
the download, choose the data ranges and click on the button. To start the upload click on
the Start upload button.

 

Conflict 
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If the transfer of data was successfull, the numbers of the transfered data will be shown as
below.

During the download or upload a conflict may occur, if the data has been edited in both
databases. This will be indicated as shown below.

Click on the button to open a window as shown below where you can choose between the
two versions of the data as found in the publisher and the subscriber database. 

The conflicting columns are marked red. For text values the program will create a combination
of both values (see above) in a merged version of the data. Choose the prefered version of
the data and click Solve conflict button. If you can not solve a conflict, use the Ignore
conflict or Stop conflict resolution buttons respectively.

 

Report 

At the end of each transfer a report will be created with a summary for every table which has
been included.
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Export into the cache databases

To export data into the cache databases, choose Data -> Export -> Cache database
from the menu. If several cache databases are available, select one of them in the window
that will open. After a cache database has been selected a window will open as shown below.

Collection data 

Every project that has been selected for transfer into the cache database will be visible in the
Collection data tab with its own page. To display the data available in the source and the
cache database click on the Requery data for project button. For every table containing
data for the selected project a page will show the current content within the source and the
cache database. To export the data click on the Export data for project button. In the
cache database this will delete the current data of the project and import the data as availble
in the source. If for any reason the data of the project should be removed from the cache
database click on the Clear cache of project button. If no cache database has been
defined so far, use the  button to create a new cache database. You will be asked for the 
server, the port used by the server, the directory of the database files, the name of the new
cache database and finally the name of the projects database where the metadata of the
projects transfered into the cache database are stored.

 

Taxonomy 

All sources for taxa defined for the cache database (see chapter on Configuration) will be
listed with one page in the Taxonomy tab (see image below). To transfer the current
content of the taxonomy sources, use the Refresh taxon list for current source button.
To transfer the taxonomic data delete a once created cache database by using the 
button.  
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Interface 

Together with the updates of the cache database, interfaces will be defined e.g. for ABCD
(see below). To display the data of a project formated for the interface click on the Requery
data for project button.   
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Configuratation of the cache databases
The cache databases for DiversityCollection are designed as sources for preformated data for
publication in e.g. public user portals like GBIF. There may be several cache databases which
can be located on several servers. The restrictions of the published data are defined in the
main database via projects, data withholding and embargos. The publication of the data is
allways related to a project, defined in DiversityProjects, holding the metadata that will be
transfered into the cache database. Therefore every dataset copied from the source into the
cache database contains a reference to the project (ProjectID). The publication of the data
includes several steps: 

 Setting of restrictions within the original data with data withholding and embargos 
 Selection of the project 
 Transfer of the data into the cache database
 Conversion of the data into the format required by the portal

In Addition to the data transfered from DiversityCollection, the data for the taxonomy has to
be transfered from the relevant sources. The links to these sources and the project
dependent retrieval are stored in the cache database.

The image below gives an overview for the process described above.

To configure your cache databases, choose Administration -> Cache database from the
menu. A window will open as shown below.
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Creation of a cache database 

If no cache database has been defined so far, use the button to create a new cache
database. You have to be a System administrator to be able to create a cache database. You
will be asked for the server, the port used by the server, the directory of the database files,
the name of the new cache database and finally the name of the projects database where the
metadata of the projects transfered into the cache database are stored.

To delete a once created cache database, use the button.  

 

Updates of the cache database 

After the new cache database has been created or if you select an outdated cache database,
a button Update database will appear, instructing you to run updates for the cache
database. Click on the button to open a window as shown below.  

All update scripts for the database will be listed. Click on the Start update button to
update the database to the current version.  

 

Login administration 

To handle the data for the cache database a user needs access to the data on the source
database, the cache database, the project database and the taxon databases. To
administrate the users that can transfer data into the cache database use the button 
Login administration. For details see the chapter Login administration. 

 

Configuration, Projects 

Data transfer to the cache database is linked to projects . To add a project of which the
data should be transfered into the cache database click on the button. For every project
that should be transferred you have several options for configuration: 

 Restriction of transfered taxonomic groups 
 Restriction of transfered material categories
 Restriction of transfered localisations 

o Restriction of the precision of the coordinates
 Restriction of transfered images

Data types handle the data for the cache database. A user needs access to the data in the 
source database, the cache database, the project database and the taxon databases. To
administrate the users who can transfer data into the cache database, use the button 
Login administration. For details see the chapter Login administration.  
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Restriction of Taxonomic groups , Material categories , Localisation systems or
Images 

To restrict the Taxonomic groups, Material catagories, Localisation systems or Images that
are transferred to the cache database choose the corresponding options and select those
that should be transferred into the cache database in the tab pages that are added. 

Coordinate precision

To reduce the precision of the coordinates of the localisation systems transferred to the
cache database you can check the corresponding option and determine the number of digits
after the decimal point. 

 

Taxonomy 

The collection data may be linked to sources holding taxonomic information
(DiversityTaxonNames). To provide this information add all sources used in your collection
data and transfer the corresponding data into the cache database. The data in the taxonomic
sources are organized by projects, thus, you need to provide the sequence of the projects
that should be imported into the cache database for every source. A name will be imported
only once. This means that the name with synonymy to the first imported project will be
imported, all following data with this name will be ignored.
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Import wizard for tab separated lists
With this import routine, you can import data from text files (as tab-separated lists) into the
database. Choose Data -> Import ->  Wizard and then the type of data that should be
imported, e.g. import Series ... from the menu. A window as shown below will open that
will lead you through the import of the data. The window is separated in 3 areas. On the left
side, you see a list of possible data related import steps according to the type of data you
choosed for the import. On the right side you see the list of currently selected import steps.
In the middle part the details of the selected import steps are shown. 

 

Choosing the File 

As a first step, choose the File from where the data should be imported. The currently
supported format is tab-separated text. Than choose the Encoding of the file, e.g. Unicode.
The Start line and End line will automatically be set according to your data. You may change
these to restrict the data lines that should be imported. The not imported parts in the file are
indicated as shown below with a gray background. If the First line contains the column
definition this line will not be imported as well. If your data contains e.g. date information
where notations differ between countries (e.g. 31.4.2013 - 4.31.2013), choose the Language
/ Country to ensure a correct interpretation of your data. Finally you can select a prepared
Schema (see chapter Schema below) for the import. 
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Choosing the data ranges

In the selection list on the left side of the window (see below) all possible import steps for the
data are listed according to the type of data you want to import.

Certain tables can be imported in parallel. To add parallels click on the button (see below).
To remove parallels, use the button. Only selected ranges will appear in the list of the steps
on the right (see below).

To import informations of logging columns like who created and changed the data, click on 
button in the header line. This will include a additional substeps for every step containing the
logging columns (see below). If you do not import these data, they will be automatically filled
by default values like the current time and user.
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Attaching data 

You can either import your data as new data or Attach them to data in the database.
Select the import step Attachment from the list. All tables that are selected and contain
columns at which you can attach data are listed (see below). Either choose the first option 
Import as new data or one of the columns the attachment columns offered like SeriesCode in
the table Series in the example below. 

If you select a column for attachment, this column will be marked with a blue backgroud (see
below and chapter Table data).

 

Merging data 

You can either import your data as new data or Merge them wih data in the database.
Select the import step Merge from the list. For every table you can choose between 
Insert, Merge, Update and Attach (see below). 

The Insert option will import the data from the file independent of existing data in the
database. 

The Merge option will compare the data from the file with those in the database according
to the Key columns (see below). If no matching data are found in the database, the data
from the file will be imported, otherwise the data will be updated.. 

The Update option will compare the data from the file with those in the database according
to the Key columns. Only matching data found in the database will be updated. 

The Attach option will compare the data from the file with those in the database according
to the Key columns. The found data will not be changed, but used as a reference data in
depending tables.  
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Table data 

To set the source for the columns in the file, select the step of a table listed underneath the
Merge step. All columns available for importing data will be listed in the central part of the
window. In the example shown below, the first column is used to attach the new data to data
in the database.

A reminder in the header line will show you what actions are still needed to import the data
into the table:

 Please select at least one column   = No column has been selected so far. 
 Please select at least one decisive column   = If data will be imported depends on the

content of decisive colums, so at least one must be selected.
 Please select the position in the file   = The position in the file must be given if the

data for a column should be taken from the file. 
 Please select at least one column for comparision   = For all merge types other than

insert columns for comparision with data in the database are needed.
 From file or For all   = For every you have to decide whether the data are taken from

the file or a value is entered for all
 Please select a value from the list   = You have to select a value from the provided

list 
 Please enter a value   = You have to enter a value used for all datasets 

The handling of the columns in described in the chapter columns. 

 

Testing 

To test if all requirements for the import are met use the Testing step. You can use a
certain line in the file for you test and than click on the Test data in line: button. If there are
still unmet requirements, these will be listed in a window as shown below. 
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If finally all requirements are met, the testing function will try to write the data into the
database and display you any errors that occurred as shown below. All datasets marked with
a red backgroud, produced some error.  

To see the list of all errors, double click in the error list window in the header line (see below).
 

If finally no errors are left, your data are ready for import. The colors in the table nodes in the
tree indicate the handling of the datasets: INSERT, MERGE, UPDATE, No difference. Attach,
No data. The colors of the table colums indicate whether a colums is decisive , a key column
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or an attachment column.  

 

Import 

With the last step you can finally start to import the data into the database. If you want to
repeat the import with the same settings and data of the same structure, you can save a
schema of the current settings (see below). 

Schedule for import of tab-separated text files into DiversityCollection
Target within DiversityCollection: Specimen

Schedule version: 1 Database version: 02.05.41

Lines: 2 - 3215 First line contains column
definition: ?

Encoding: Unicode Language: de
 

Tables

CollectionSpecimen (CollectionSpecimen) 
Parent: CollectionEvent
Merge handling: Insert
Column in table

? Ke
y
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py

Pr
e

Po
st

Fil
e
po
s.

Tr
an
sfo
rm
ati
on
s

Va
lue

So
urc
e

Ta
ble

CollectionSpecimenID Dat
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e

AccessionNumber ? ? 0 Fil
e

IdentificationUnit_1 (IdentificationUnit) 
Parent: CollectionSpecimen
Merge handling: Merge

Column in table ? Ke
y

Co
py

Pr
e

Po
st

File
pos.

Transformations Value Source Table

CollectionSpecimenID Database

IdentificationUnitID Database

LastIdentificationCache ? 2 File

+ 3 File

+ 4 File

+ 5 File

TaxonomicGroup ? fish Interface

IdentificationUnitAnalysis_1_1 (IdentificationUnitAnalysis) 
Parent: IdentificationUnit_1
Merge handling: Update

Column in table ? Ke
y

Co
py

Pr
e

Po
st

File
pos.

Transformations Value Source Table

CollectionSpecimenID Database
IdentificationUnitID Database
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AnalysisID 94 Interface
AnalysisNumber 1 Interface
AnalysisResult ? ? 39 File

 Lines that could not be imported will be marked with a red background while imported lines
are marked green (see below).

If you want to save lines that produce errors during the import in a separate file, use the
Save failed lines option. The protocol of the import will contain all settings acording to the
used schema and an overview containing the number of inserted, updated, unchanged and
failed lines (see below).
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Import wizard - Columns 

If the content of a file should be imported into a certain column of a table, mark it with the 
checkbox. 

Decisive columns 

The import depends upon the data found in the file where certain columns can be choosed as
decisive, that means only those lines will be imported where data are found in any of these
columns. To mark a column as decisive, click on the icon at the beginning of the line (see
below).

In the example shown below, the file column Organims 2 was marked as decisive. Therefore
only the two lines containing content in this column will be imported. 

 

Key columns 

For the options Merge, Update and Attach the import compares the data from the
file with those already present in the database. This comparision is done via key columns.
To make a column a key column, click on the icon at the beginning of the line. You can
define as many key columns as you need to ensure a valid comparision of the data.

 

Source 

The data imported into the database can either be taken From file or the same value that
you enter into the window or select from a list can be used For all datasets. If you choose
the From file option, a window as shown below will pop up. Just click in the column where the
data for the column should be taken from and click OK (see below).
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If you choose the For all option, you can either enter text, select a value from a list or use
a checkbox for YES or NO.

 

Transformation 

The data imported may be transformed e.g. to adapt them to a format demanded by the
database. For further details please see the chapter Transformation. 

 

Copy 

If data in the source file are missing in subsequent lines as shown below, 

you can use the Copy line option to fill in missing data as shown below where the blue
values are copied into empty fields during the import. Click on the button to ensure that
missing values are filled in from previous lines. 
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Prefix and Postfix 

In addition to the transformation of the values from the file, you may add a pre- and a postfix.
These will be added after the transfromation of the text. Double-click in the field to see or
edit the content. For the datatype geography the pre- and postfixes will be automatically set
to enable the import. The preset values by default are set for points as geographical units.
You may change this to predefined types like lines or areas. Click on the button at the end
of the line to open the information window. Here you can choose among the types mentioned
above (see below).  

 

Column selection 

If for any reason, a column that should take its content from the imported file misses the
position of the file or you want to change the position click on the button. In case a
position ist present, this button will show the number of the column. A window as shown
below will pop up where you can select resp. change the position in the file. 

 

Multi column 

The content of a column can be composed from the content of several columns in the file. To
add additional file columns, click on the button. A window as shown below will pop up,
showing you the column selected so far, where the sequence is indicated in the header line.
The first colum is marked with a blue background while the added columns are marked with a
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green background (see below). 

To remove a added column, use the button (see below). 

 

Information 

The button opens a window displaying the informations about the column. For certain
datatypes additional options are included (see Pre- and Postfix). 
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Import wizard - transformation 

The data imported may be transformed e.g. to adapt them to a format demanded by the
database. Click on the button to open a window as shown below. 

Here you can enter 4 types of transformation that should be applied to your data. Cut out
parts,  Translate contents from the file, RegEx apply regular expressions or Replace text
in the data from the file. All transformations will be applied in the sequence they had been
entered. Finally, if a prefix and/or a postfix are defined, these will be added after the
transformation. To remove a transformation, select it and click on the button. 

 

Cut 

With the cut transformation you can restrict the data taken from the file to a part of the
text in the file. This is done by splitters and the position after splitting. In the example below,
the month of a date should be extracted from the information. To achieve this, the splitter '.'
is added and than the position set to 2. You can change the direction of the sequence with
the button Seq starting at the first position and starting at the last position. Click on the
button Test the transformation to see the result of your transformation. 
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Translate 

The translate transformation translates values from the file into values entered by the user.
In the example above, the values of the month cut out from the date string should be
translated from roman into numeric notation. To do this click on the button to add a
translation transformation (see below). To list all different values present in the data, click on
the button. A list as shown below will be created. You may as well use the and 
buttons to add or remove values from the list or the button to clear the list. Than enter the
translations as shown below. Use the save button to save entries and the Test the
transformation button to see the result.  
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Regular expression 

The transformation using regular expressions will transform the values according to the
entered Regular expression and Replace by vales. For more details please see
documentations about regular expressions. 

 

Replacement 

The replacement transformation replaces any text in the data by a text data imported may be
transformed e.g. to adapt them to a format demanded by the database. Click on the button
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to open a window as shown below. 
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Customization of the application
DiversityCollection provides several ways to adapt the forms to your needs. There are special
adaptations for the main window and for the grid view. General adaptations are performed
with the context.
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Entities, contexts, usage and
languages
DiversityCollection may be used in diverse contexts like collection management, observations
or field mapping. To ensure that a user working in a certain area will see the descriptions
corresponding to his domain the DiversityWorkbench provides the possibility to define
corresponding contexts. 

To set the context and the language for the program choose Administration - Customize
display ... from the menu. A window will open as shown below where you may select the
language and the context which should be used. By default the language will be set according
to the settings of your operating system, however, you may change it here. The default
language within DiversityCollection is english. If you select a certain context, the tables in the
lower part of the form will show you the special setting within this context. These settings are
edited as described below.   

 

For the documentation of the tables used for the storage of the entity related data please
see the section Entity tables. 

To edit the entities choose Administration - Application description ... from the menu. A
window will open as shown below where you may edit the entities defined for the programm.
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Group for the display of the entity

If in a user interface certain entities should be displayed in a group, enter the name of the
group here. 

Usage

If nothing is defined for the usage of an entity, it will be handeled according to the rights of
the user. In certain context an entity may be set to e.g. read only, inapplicable or not used.
In case of the later two possiblities the entity will not appear in the interface of the program.
For example, transaction management (e.g. loan) will not be handled with a mobile device,
thus the corresponding entities will be set to "not used". Use the [Insert new usage] button
to insert a new usage for an entity. To edit the possible usages choose Administration -
Usage ... from the menu. 

 inapplicable: An entity which may not be applied in a certain context will not be shown
in a user interface, e.g. the depositors accession number in the context observation.  

 preset: An entity will have a preset value, e.g. 'determination' for the identification
category in the context observation.

 read only: An entity may not be changed.
 hidden: An entity should be hidden from the user interface.   

Context 

The default context is General. Thus, in the beginning you will find all representations within
this context. Within the representation, when a certain context is missing, the program will
search for a representation in the parent context until a represention is found. To edit the
context choose Administration - Context ... from the menu. A window will open as shown
below where you may edit the context.
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Representation 

An entity may have differing representations in different contexts. For example a
CollectionEvent may corrrespond to an observation or gathering in other contexts. Use the
Entity and Representation menu to fill in missing entries. If an only if entity should receive a
different title or description in the user interface, enter the values in the table. If nothing is
defined in a certain context, the program will walk up the tree defined with the parent code
(see the image above) to find available values for the title or description of the entity. The
highest entry in the hierarchy is the context General with the language english. If you define
deviating values for the display text, the abbreviation or the description, you must at least
enter values in the highest entry (General, english) as a default value for all other entities.  

Language 

The default language used in DiversityCollection is english. Thus, in the beginning you will find
all descriptions etc. in english. All representations may be defined for any language. Use the
Representation menu to automatically fill in missing entries of a language. If there are changes
in the original description of tables or columns in the database, choose Representation -
Update descriptions according to database from the menu to import the updated
descriptions for the english version and context "General". 

Entity 

To insert missing entities use the Entity menu. To insert all missing tables of a database
choose Entity - Insert all missing tables ... from the menu. A window will open listing the
missing tables. Use the [Exclude: ... ] field and [Requery] button to remove certain tables
from the list, e.g. if you do not wish to define entities for log tables, enter *_log and then
click [Requery]. You may repeat this until the list contains only tables you wish to use. 
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You find corresponding functions for single tables and for entries in a table. The later function
is restricted to tables with a primary key with one column. A window will open where you map
the columns, provided for the entity documentation to columns in the table, of which you wish
to import the entries (see image below).

 

This may be necessary, if e.g. certain entries in a table should not be used in a certain
context or if you wish to translate the contents into another language. 
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Customize the main form
The main window can be customised in several parts. To change the visible parts in the main
window select Administration - Customize display ... from the menu. A window (see below)
will open where you can select the groups which should be displayed. In the first tab you can
change the visibility for the taxonomic groups and material categories.

In the second tab (see below) you can set the visibility of the localisation systems and
collection site properties. These are listed in the drop down menus for adding items to a
collection event.
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In the third tab (see below) you can add the name of responsible persons for several entries
and show/hide the controls for the exsiccata.

Page 295



Page 296



Database
The database for DiversityCollection is based on Microsoft SQL-Server 2005.

Organisation of the data

The main tables of the database are CollectionEvent corresponding to the event of the
collection and CollectionSpecimen holding the specimens collected. Connected to these tables
you find tables for additional information. 

The image below shows the main tables of the database.

 

 

The diagram shows the tables of the database marked according to their logical groups. In the
center the table CollectionSpecimen holds specimen data e.g. the accession number. On the
left you find the tables containing collection event data and on the right tables related to the
organisms and their identifications. Further logical groups are collectors, projects, storage
and transaction.

Further details: tables , application tables, access.
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Installation of the database
DiversityCollection uses Microsoft SQL-Server 2008 as database engine. If you do not have a
database server with DiversityCollection already available, you need to install the
database engine first. Downlo ad the free version of Microsoft SQL Server Express 2008 (e.g.
SQLEXPRADV_x86_DEU.exe  ) from http://www.microsoft.com/downloads/. Start the
program and follow the instructions for the installation. 

Download the database files DiversityCollection_Data.MDF  and DiversityCollection_log.LDF
 from http://www.diversityworkbench.net/Portal/ provided as a zip archive

(DiversitCollection.zip) and copy them into your database directory. 

If you plan to use the database on your local computer (SQL Server Express), start the
program DiversityCollection.exe and in the main window click on the button or choose
Connection -> Database ... from the menu. A window will open as shown below. Here
choose the option Local database and select the database file in your directory. 

 

Server configuration 

To configure your server for remote access launch the SQL Server Configuration Manager
(see image below). 

Then click on the "Protocols for SQLEXPRESS" node. Right click on "TCP/IP" in the list of
Protocols and choose "enable" for TCP/IP.
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Right click on the TCP/IP node and select "Properties" to open a window as shown below. 

In the part IPALL clear out the value for "TCP Dynamic Ports". Give a TCP-Port number to
use when making remote connections e.g. "4321" as shown above. You have to restart the
SQL Server Express service before you can connect to your database. 

If you use a database on a server, make sure that the firewall of the server allows access via
the port you set for the connection (see below). 
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Start the Microsoft SQL Server Managment Studio and attach the database as shown below.
Choose the node "databases" and right-click on it to open the context menu (see below).
Then choose "attach" from the context menu. A window will open where you can choose the
file DiversityCollection_Data.MDF from your database directory and attach it to the database
engine.
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After the installation make sure to get the latest updates from 
http://windowsupdate.microsoft.co m/.

 

Database configuration 

To configure your database use the client as described in Database configuration.
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Configuration of the database

To configure your database choose Administration -> Database -> Rename
database to change the name of the database according to your requirements. During this
renaming all processes in the database will be terminated (you will get a warning if processes
from other hosts are active). 

Afterwards you should adapt the address that is published by the database for access by
other modules. Choose Administration -> Database -> Set published address from
the menu. This will change the published address to the name of the server where your
database is located and provide an identifier for your database, e.g. http://xy.diversityworkbe
nch.de/Collection/ .  

Renaming of the database and adapting of the published address should be done before you
start to use the database and name and address should not be changed afterwards as
data sets from other modules linked to data in the database would otherwise point to
outdated addresses. 
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Connections to the databases and services
The program will automatically try to connect to all the modules within the Diversity
Workbench. To edit these connections choose Connection -> Module connections ... from
the menu. A form (see below) will open where you can edit said connections. 

To edit a connection select it in the tree and click on the button. To requery the
connections use the button. If you want to add a connection to a different server click on
the  button and connect to the database you want to add to the list. Added databases will
be displayed in green. To remove a connection from the list select it and click on the 
button. Webservices like Index Fungorum will be displayed in blue. 
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Database - access
The database engine for DiversityCollection is Microsoft SQL-Server 2005.

When you are connected to a database it is indicated by the icon of the connection button 
in the upper left corner. When you are not connected the following icon will be shown .

To access any database you must specify the server where the database is located. For the
configuration of this connection choose Connection, Database... from the menu or click on
the button. 

If you want to use a database on a central server or remote computer, start the program 
DiversityCollection.exe. In the main window click on the button or choose Connection ->
Database ... from the menu. A window will open as shown below. Here choose the option
Remote database and set the connection parameters as described below. 

Database name, IP-address and Port

A dialog will open to specify the name or IP-address and port number of the server as well as
to select the authentication mode. You can either choose Windows authentication (see left
image below) or SQL-Server authentication (see middle image below).
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The standard port number for SQL-Server is 1433 and will be set as a default. If the database
server is configured using a different port, you must enter its number in the field Port. Click on

the button to connect to the server. If the connection information is valid,
you can choose a database from the server in the combo box at the base of the window (see

right image above). To restart the connecting process click on the button. 

Module connections

The program will automatically try to establish a connection to Diversity Workbench databases
and webservices. For further details see the Connections section. 
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Index
 Analysis

 AnalysisResult

 AnalysisTaxonomicGroup

 Annotation

 Collection

 CollectionAgent

 CollectionEvent

 CollectionEventImage

 CollectionEventLocalisation

 CollectionEventProperty

 CollectionEventSeries

 CollectionEventSeriesImage

 CollectionExternalDatasource

 CollectionImage

 CollectionProject

 CollectionSpecimen

 CollectionSpecimenImage

 CollectionSpecimenPart

 CollectionSpecimenProcessing

 CollectionSpecimenRelation

 CollectionSpecimenTransaction

 Identification

 IdentificationUnit

 IdentificationUnitAnalysis

 IdentificationUnitGeoAnalysis
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 IdentificationUnitInPart

 LocalisationSystem

 Processing

 ProcessingMaterialCategory

 ProjectAnalysis

 ProjectProcessing

 Property

 Transaction

 TransactionDocument

Table Analysis
Analysis types used within the database

Column Data type Description

AnalysisID int ID of the analysis (Primary
key)

AnalysisParentID int

Analysis ID of the parent
analysis if it belongs to a
certain type documented in
this table

DisplayText nvarchar (50) Name of the analysis as e.g.
shown in user interface

Description nvarchar (MAX) Description of the analysis

MeasurementUnit nvarchar (50)
The measurement unit used
for the analysis, e.g. mm,
µmol, kg

Notes nvarchar (MAX) Notes concerning this analysis

AnalysisURI varchar (255) URI referring to an external
documentation of the analysis

OnlyHierarchy bit

If the entry is only used for
the hierarchical arrangement
of the entries
Default value: (0)

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()
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LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table AnalysisResult
Value lists for analysis types with predefined values, e.g. "0, 1, 2, 3, ..." for
Red list category. Includes description etc. for the values in the list.

Column Data type Description

AnalysisID int ID of the analysis (Primary
key)

AnalysisResult nvarchar (255) The categorized value of the
analysis

Description nvarchar (500)
Description of enumerated
object, displayed in the user
interface

DisplayText nvarchar (50)
Short abbreviated description
of the object, displayed in the
user interface

DisplayOrder smallint

The order in which the entries
are displayed. The order may
be changed at any time, but
all values must be unique.

Notes nvarchar (500)
Internal development notes
about usage, definition, etc.
of an enumerated object

LogInsertedBy nvarchar (50)

Name of user who first
entered (typed or imported)
the data.
Default value: user_name()

LogInsertedWhen smalldatetime

Date and time when the data
were first entered (typed or
imported) into this database.
Default value: getdate()

LogUpdatedBy nvarchar (50)
Name of user who last
updated the data.
Default value: user_name()

LogUpdatedWhen smalldatetime
Date and time when the data
were last updated.
Default value: getdate()

Table AnalysisTaxonomicGroup
The types of analysis that are available for a taxonomic group

Column Data type Description
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AnalysisID int Analysis ID, foreign key of
table Analysis.

TaxonomicGroup nvarchar (50)

Taxonomic group the organism
identified by this unit belongs
to. Groups listed in table
CollTaxonomicGroup_Enum (=
foreign key)

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table Annotation
Annotations to datasets in the database

Column Data type Description

AnnotationID int ID of the annotation (Primary
key)

ReferencedAnnotationID int
If an annotation refers to
another annotation, the ID of
the referred annotation

AnnotationType nvarchar (50)

The type of the annotation as
defined in
AnnotationType_Enum, e.g.
Reference

Title nvarchar (50) Title of the annotation

Annotation nvarchar (MAX) The annotation entered by
the user

URI varchar (255)

The complete URI address of
a resource related to the
annotation. May be link to a
module, e.g. for the
annotation type reference

ReferenceDisplayText nvarchar (500)

The title of the reference. If
the entry is linked to an
external module like
DiversityReferences, the
cached display text of the
referenced dataset

ReferenceURI varchar (255)

If the entry is linked to an
external module like
DiversityReferences, the link
to the referenced dataset

SourceDisplayText nvarchar (500)

The name of the source. If
the entry is linked to an
external module like
DiversityAgents, the cached
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display text of the referenced
dataset

SourceURI varchar (255)

If the entry is linked to an
external module like
DiversityAgents, the link to
the referenced dataset

IsInternal bit
If an annotation is restricted
to authorized users of the
database

ReferencedID int The ID of the dataset in the
table the annotation refers to

ReferencedTable nvarchar (500) The name of the table the
annotation refers to

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
RowGUID - Annotation
Default value:
newsequentialid()

Table Collection
The collections where the specimen are stored

Column Data type Description

CollectionID int Unique reference ID for the
collection (= Primary key)

CollectionParentID int

For a subcollection within
another collection:
CollectionID of the collection
to which the subcollection
belongs. Empty for an
independent collection

CollectionName nvarchar (255)

Name of the collection (e. g.
'Herbarium Kew') or
subcollection (e. g. 'cone
collection', 'alcohol
preservations'). This text
should be kept relatively
short, use Description for
additional information

CollectionAcronym nvarchar (10)
A unique code for the
Collection, e.g. the herbarium
code from Index Herbariorum
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AdministrativeContactName nvarchar (500)
The name of the person or
organisation responsible for
this collection

AdministrativeContactAgentUR
I varchar (255)

The URI of the person or
organisation responsible for
the Collection e.g. as provided
by the module DiversityAgents

Description nvarchar (MAX) A short description of the
collection

Location nvarchar (255)

Optionally location of the
collection, e.g. the number
within a file system or a
description of the room(s)
housing the (sub)collection

CollectionOwner nvarchar (255)

The owner of the collection as
e.g. printed on a label, should
be given if CollectionParentID
is null

DisplayOrder smallint

The order in which the entries
are displayed. The order may
be changed at any time, but
all values must be unique.

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionAgent
The collector(s) of collection specimens

Column Data type Description

CollectionSpecimenID int
Refers to ID of
CollectionEvent (= Foreign key
and part of primary key)

CollectorsName nvarchar (255) Name of the Collector

CollectorsAgentURI varchar (255)
The URI of the Agent, e.g. as
stored within the module
DiversityAgents

CollectorsSequence datetime
The order of collectors in a
team. Automatically set by
the database system
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Default value: getdate()

CollectorsNumber nvarchar (50)

Number assigned to a
specimen or a batch of
specimens by the collector
during the collection event (=
'field number')

Notes nvarchar (MAX) Notes about the collector,
e.g. if the name is uncertain

DataWithholdingReason nvarchar (255)
If the dataset is withhold, the
reason for withholding the
data, otherwise null

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionEvent
The collection event where the specimen was collected

Column Data type Description

CollectionEventID int Unique ID for the collection
event (= Primary key)

Version int

The version of the dataset.
Automatically set by the
system.
Default value: (1)

SeriesID int

The ID of the related
expedition. Relates to the PK
of the table
CollectionExpedition (Foreign
key). 

CollectorsEventNumber nvarchar (50)
Number assigned to a
collection event by the
collector (= 'field number')

CollectionDate datetime

The date of the event
calulated from the entries in
CollectionDay, -Month and
-Year.

CollectionDay tinyint
The day of the date of the
event or when the collection
event started
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CollectionMonth tinyint
The month of the date of the
event or when the collection
event started

CollectionYear smallint
The year of the date of the
event or when the collection
event started

CollectionDateSupplement nvarchar (100)

Verbal or additional collection
date information, e.g. 'end of
summer 1985', 'first quarter',
'1888-1892'. The end date if
the collection event comprises
a period. The time of the
event if necessary.

CollectionDateCategory nvarchar (50)

Category of the date of the
identification e.g. "system",
"estimated" (= foreign key,
see in table
CollEventDateCategory_Enum)

CollectionTime varchar (50)
The time of the event or
when the collection event
started

CollectionTimeSpan varchar (50) The time span e.g. in seconds
of the collection event

LocalityDescription nvarchar (MAX)

Locality description of the
locality, exactly as written on
the original label (i.e. without
corrections during data entry)

HabitatDescription nvarchar (MAX)

Geo-ecological description of
the locality, exactly as
written on the original label
(i.e. without corrections
during data entry)

ReferenceTitle nvarchar (255)

The title of the publication
where the collection event
was published. Note this is
only a cached value where
ReferenceURI is present

ReferenceURI varchar (255)

URI (e.g. LSID) of the source
publication where the
collection event is published,
may e.g. refer to the module
DiversityReferences

ReferenceDetails nvarchar (50) The exact location within the
reference, e.g. pages, plates

CollectingMethod nvarchar (MAX)

Description of the method
used for collecting the
samples, e.g. traps, moist
chambers, drag net

Notes nvarchar (MAX) Notes about the collection
event

CountryCache nvarchar (50)

The country where the
collection event took place.
Cached value derived from an
entry in CollectionGeography
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DataWithholdingReason nvarchar (255)
If the dataset is withhold, the
reason for withholding the
data, otherwise null

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionEventImage
The images showing the site of the collection event

Column Data type Description

CollectionEventID int Unique ID for the collection
event (= Primary key)

URI varchar (255)

The complete URI address of
the image. This is only a
cached value if ResourceID is
available referring to the
module DiversityResources

ResourceURI varchar (255)
The URI of the resource (e.g.
see module
DiversityResources)

ImageType nvarchar (50) Type of the image, e.g. map

Notes nvarchar (MAX)
Notes to this image
concerning the collection
event

Description xml (MAX) Description of the image

DataWithholdingReason nvarchar (255)
If the dataset is withhold, the
reason for withholding the
data, otherwise null

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()
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RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionEventLocalisation
The geographic localisation of a collection event

Column Data type Description

CollectionEventID int
Refers to the ID of
CollectionEvent (= Foreign key
and part of primary key)

LocalisationSystemID int
Refers to the ID of
LocalisationSystem (= Foreign
key and part of primary key)

Location1 nvarchar (255)

Either a named location
selected from a thesaurus (e.
g. 'Germany, Bavaria,
Kleindingharting') or altitude
range or other values (e. g.
100-200 m)

Location2 nvarchar (255)
Corresponding value to
Location1 e.g. ID or URI of
gazetteer or thesaurus

LocationAccuracy nvarchar (50) The accuracy of the
determination of this locality

LocationNotes nvarchar (MAX) Notes on the location

DeterminationDate smalldatetime Date of the determination of
the geographical localisation

DistanceToLocation varchar (50)
Distance from the specified
place to the real location of
the collection event (m)

DirectionToLocation varchar (50)

Direction from the specified
place to the real location of
the collection event (Degrees
rel. to north)

ResponsibleName nvarchar (255)

The name of the agent
(person or organization)
responsible for this entry.
Default value:
[dbo].[CurrentUserName]()

ResponsibleAgentURI varchar (255)

URI of the person or
organisation responsible for
the data (see e.g. module
DiversityAgents)

Geography geography The geography of the
localisation

AverageAltitudeCache float Calculated altitude as parsed
from the location fields

AverageLatitudeCache float Calculated latitude as parsed
from the location fields

AverageLongitudeCache float Calculated longitude as parsed
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from the location fields

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

RecordingMethod nvarchar (500)
The method or device used
for the recording of the
localisation

Table CollectionEventProperty
A property of a collection site, e.g. exposition, slope, vegetation. May refer
to Diversity Workbench module DiversityScientificTerms

Column Data type Description

CollectionEventID int
Refers to the ID of
CollectionEvent (= Foreign key
and part of primary key)

PropertyID int
The ID of the descriptor of
the collection event, foreign
key, see table Descriptor

DisplayText nvarchar (255) The text for the property as
shown e.g. in a user interface

PropertyURI varchar (255)
URI referring to an external
datasource e.g.
DiversityTerminology

PropertyHierarchyCache nvarchar (MAX)

A cached text of the
complete name of the
descriptor including superior
categories if present

PropertyValue nvarchar (255)

The value of a captured
feature e.g. temperature, pH,
vegetation etc. If there is a
range this is the lower or first
value

ResponsibleName nvarchar (255)
The name of the agent
(person or organization)
responsible for this entry.

ResponsibleAgentURI varchar (255)

URI of the person or
organisation responsible for
the data (see e.g. module
DiversityAgents)
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Notes nvarchar (MAX) Notes about the property of
the colletion site.

AverageValueCache float
For numeric values - a cached
average value according to
the

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionEventSeries
The series whithin which collection events take place

Column Data type Description

SeriesID int Primary key. The ID for this
expedition (= Primary key)

SeriesParentID int The ID of the superior
expedition

Description nvarchar (MAX)
The description of the
expedition as it will be printed
on e.g. the label

SeriesCode nvarchar (50) The user defined code for an
expedition

Notes nvarchar (MAX) Notes about this expedition

Geography geography The geography of the
collection event series

DateStart datetime The date and time when the
collection event series started

DateEnd datetime The date and time when the
collection event series ended

DateCache datetime

The first date of the
depending events, used for
sorting the expeditions
[controlled by the database]

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime The last time when this
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dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionEventSeriesImage
The images showing the sites of a collection event series, e.g. an
expedition or sampling plot

Column Data type Description

SeriesID int
Unique ID for the collection
event series (= Foreign key
and part of primary key)

URI varchar (255)

The complete URI address of
the image. This is only a
cached value if ResourceID is
available referring to the
module DiversityResources

ResourceURI varchar (255)
The URI of the resource (e.g.
see module
DiversityResources)

ImageType nvarchar (50) Type of the image, e.g. map

Notes nvarchar (MAX)
Notes to this image
concerning the collection
event

Description xml (MAX) Description of the image

DataWithholdingReason nvarchar (255)
If the dataset is withhold, the
reason for withholding the
data, otherwise null

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()
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Table CollectionExternalDatasource
CollectionExternalDatasource document the sources of the names.

Column Data type Description

ExternalDatasourceID int

An ID to identify an external
data collection of collection
specimen (primary key, the ID
has no meaning outside of the
DiversityWorkbench system)

ExternalDatasourceName nvarchar (255)

The name of the data
collection that has been
integrated or can be linked to
for further analysis

ExternalDatasourceVersion nvarchar (255)

The version of this data
collection (either official
version number, or dates
when the collection was
integrated)

Rights nvarchar (500)

A description of copyright
agreements or permission to
use data from the external
database

ExternalDatasourceAuthors nvarchar (200)
The persons or institutions
responsible for the external
database

ExternalDatasourceURI nvarchar (300)
The URI of the database
provider resp. the external
database

ExternalDatasourceInstitution nvarchar (300) The institution responsible for
the external database

InternalNotes nvarchar (1500) Additional notes concerning
this data collection

ExternalAttribute_NameID nvarchar (255)

The table and field name in
the external data collection to
which CollectionExternalID
refers

PreferredSequence tinyint

For selection in e.g. picklists:
of several equal names only
the name from the source
with the lowest preferred
sequence will be provided.

Disabled bit
If this source should be
disabled for selection of
names e.g. in picklists

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionImage
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The images showing the collection

Column Data type Description

CollectionID int
Refers to the ID of Collection
(= Foreign key and part of
primary key)

URI varchar (255) The complete URI address of
the image. 

ImageType nvarchar (50) Type of the image, e.g. label

Notes nvarchar (MAX) Notes about the collection
image

Description xml (MAX) Description of the image

DataWithholdingReason nvarchar (255)
If the dataset is withhold, the
reason for withholding the
data, otherwise null

LogInsertedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogInsertedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
RowGUID - CollectionImage
Default value:
newsequentialid()

Table CollectionProject
The projects within which the collection specimen were placed

Column Data type Description

CollectionSpecimenID int
Refers to the ID of
CollectionSpecimen (= Foreign
key and part of primary key)

ProjectID int

ID of the project to which the
specimen belongs (Projects
are defined in
DiversityProjects)

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()
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LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionSpecimen
The data directly attributed to the collection specimen

Column Data type Description

CollectionSpecimenID int
Unique reference ID for the
collection specimen record
(primary key)

Version int The version of the dataset
Default value: (1)

CollectionEventID int
Refers to the ID of
CollectionEvent (= Foreign key
and part of primary key)

CollectionID int
ID of the Collection as stored
in table Collection (= foreign
key, see table Collection)

AccessionNumber nvarchar (50)
Accession number of the
specimen within the
collection, e.g. "M-29834752"

AccessionDate datetime

The date of the accession
calculated from the entries in
AccessionDay, -Month and
-Year

AccessionDay tinyint
The day of the date when the
specimen was acquired in the
collection

AccessionMonth tinyint
The month of the date when
the specimen was acquired in
the collection

AccessionYear smallint
The year of the date when
the specimen was acquired in
the collection

AccessionDateSupplement nvarchar (255)

Verbal or additional accession
date information, e.g. 'end of
summer 1985', 'first quarter',
'1888-1892'

AccessionDateCategory nvarchar (50)

Category of the date of the
identification e.g. "system",
"estimated" (= foreign key,
see in table
xColl_DateCategory_Enum)

DepositorsName nvarchar (255)

The name of the depositor(s)
(person or organization
responsible for deposition).
Where entire collections are
deposited, this should also
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contain the collection name
(e.g. 'Herbarium P. Döbbler')

DepositorsAgentURI varchar (255)
The URI of the depositor(s)
(person or organization
responsible for deposition)

DepositorsAccessionNumber nvarchar (50)

Accession number of the
specimen within the previous
or original collection, e.g.
'D-23948'

LabelTitle nvarchar (255) The title of the label e.g. for
printing labels.

LabelType nvarchar (50)

Printed, typewritten,
typewritten with handwriting
added, entirely in handwriting,
etc.

LabelTranscriptionState nvarchar (50)

The state of the transcription
of a label into the database:
'Not started', 'incomplete',
'complete'

LabelTranscriptionNotes nvarchar (255)
User defined notes concerning
the transcription of the label
into the database

ExsiccataURI varchar (255)

If specimen is an exsiccata:
The URI of the Exsiccata
series, e.g. as stored within
the DiversityExsiccata module

ExsiccataAbbreviation nvarchar (255)

If specimen is an exsiccata:
Standard abbreviation of the
exsiccata (not necessarily a
unique identifier; editors or
publication places may change
over time)

OriginalNotes nvarchar (MAX)

Notes found on the label of
the specimen, by the original
collector or from a later
revision

AdditionalNotes nvarchar (MAX)

Additional notes made by the
editor of the specimen record,
e. g. 'doubtful
identification/locality'

ReferenceTitle nvarchar (255)

The title of the publication
where the specimen was
published. Note this is only a
cached value where
ReferenceURI is present

ReferenceURI varchar (255)

URI (e.g. LSID) of reference
where specimen is published,
e.g. referring to the module
DiversityReferences

ReferenceDetails nvarchar (50) The exact location within the
reference, e.g. pages, plates

Problems nvarchar (255)
Description of a problem that
occurred during data editing.
Typically these entries should
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be deleted after help has
been obtained. Do not enter
scientific problems here; use
AdditionalNotes for such
permanent problems!

DataWithholdingReason nvarchar (255)
If the dataset is withhold, the
reason for withholding the
data, otherwise null

InternalNotes nvarchar (MAX) Internal notes that should not
be published e.g. on websites

ExternalDatasourceID int

An ID to identify an external
data collection of collection
specimen (primary key, the ID
has no meaning outside of the
DiversityWorkbench system)

ExternalIdentifier nvarchar (100)
The identifier of the external
specimen as defined in the
external datasource

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionSpecimenImage
The images of a collection specimen or of an identification unit within this
specimen

Column Data type Description

CollectionSpecimenID int
Refers to the ID of
CollectionSpecimen (= Foreign
key and part of primary key)

URI varchar (255)

The complete URI address of
the image. This is only a
cached value if ResourceID is
available referring to the
module DiversityResources

ResourceURI varchar (255)
The URI of the image, e.g. as
stored in the module
DiversityResources. 

SpecimenPartID int
Optional: If the dataset is not
related to a part of a
specimen, the ID of a related

Page 323



part (= foreign key)

IdentificationUnitID int

If image refers to only on out
of several identification units
for a specimen, refers to the
ID of an IdentificationUnit for
a CollectionSpecimen (=
foreign key)

ImageType nvarchar (50) Type of the image, e.g.
photograph

Notes nvarchar (MAX) Notes about the specimen
image

Description xml (MAX) Description of the image

DataWithholdingReason nvarchar (255)
If the dataset is withhold, the
reason for withholding the
data, otherwise null

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionSpecimenPart
Parts of a collection specimen. Includes a possible hierarchy of the parts

Column Data type Description

CollectionSpecimenID int
Refers to the ID of
CollectionSpecimen (= Foreign
key and part of primary key)

SpecimenPartID int ID of the collection specimen
part (= part of Primary key). 

DerivedFromSpecimenPartID int

SpecimenPartID of the
specimen from which the
current specimen is derived
from

PreparationMethod nvarchar (MAX)

The method used for the
preparation of the part of the
specimen, e.g. the inoculation
method for cultures

PreparationDate datetime

The date and time when the
part was preparated e.g when
it was separated from the
source object
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AccessionNumber nvarchar (50)

Accession number of the part
of the specimen within the
collection if it is different from
the accession number of the
specimen as stored in the
table CollectionSpecimen, e.g.
"M-29834752"

PartSublabel nvarchar (50)

The label for a part of a
specimen, e.g. if duplicats of
a specimen have a separate
number

CollectionID int
ID of the Collection as stored
in table Collection (= foreign
key, see table Collection)

MaterialCategory nvarchar (50)

Material category of
specimen. Examples:
'herbarium sheets', 'drawings',
'microscopic slides' etc. (=
foreign key, see table
CollMaterialCategory_Enum)
Default value: N'specimen'

StorageLocation nvarchar (255)

A code identifying the place
where the specimen is stored
within the collection.
Frequently the accepted
scientific name is used as
storage location code.

Stock float

Number of stock units if the
specimen is stored in
separated units e.g. several
boxes or vessels (max. 255)

StockUnit nvarchar (50)

If empty the stock is given as
a count, else it contains the
unit in which stock is
expressed, e.g. µl, ml, kg etc.

StorageContainer nvarchar (500) The container in which the
part is stored

Notes nvarchar (MAX) Notes concerning the storage
of the sample

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()
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Table CollectionSpecimenProcessing
The processing that was applied to a collection specimen

Column Data type Description

CollectionSpecimenID int
Refers to ID of
CollectionSpecimen (= Foreign
key and part of primary key)

ProcessingDate datetime
Date and time of the start of
the processing
Default value: getdate()

ProcessingID int

ID of the processing. Refers
to ProcessingID in table
Processing (foreign key)
Default value: (1)

Protocoll nvarchar (100) The label of the processing
protocoll

SpecimenPartID int

Optional: If the dataset is
related to a part of a
specimen, the ID of a related
part (= foreign key, see table
CollectionSpecimenPart)

ProcessingDuration varchar (50)

The duration of the
processing including the unit
(e.g. 5 min) or the end of the
processing starting at the
processingDate (e.g.
23.05.2008)

ResponsibleName nvarchar (255)

Name of the person or
institution responsible for the
determination
Default value:
[dbo].[CurrentUserName]()

ResponsibleAgentURI varchar (255)

URI of the person or
institution responsible for the
determination (= foreign key)
as stored in the module
DiversityAgents.

Notes nvarchar (MAX) Notes about the processing

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()
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Table CollectionSpecimenRelation
The relations of a collection specimen to other collection specimen

Column Data type Description

CollectionSpecimenID int
Unique reference ID for the
collection specimen record
(primary key)

RelatedSpecimenURI varchar (255) URI of the related specimen

RelatedSpecimenDisplayText varchar (255)
The name of a related
specimen as shown e.g. in a
user interface

RelationType nvarchar (50)

Type of the relation between
the specimen (= foreign key,
see table
CollRelationType_Enum)

RelatedSpecimenCollectionID int
ID of the Collection as stored
in table Collection (= foreign
key, see table Collection)

RelatedSpecimenDescription nvarchar (MAX) Description of the related
specimen

Notes nvarchar (MAX) Notes on the relation to the
specimen

IsInternalRelationCache bit

If the relation represents a
connection between specimen
in this database
Default value: (1)

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table CollectionSpecimenTransaction
The transactions in which a specimen was involved

Column Data type Description

CollectionSpecimenID int Refers to ID of
CollectionSpecimen (= Foreign
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key and part of primary key)

TransactionID int
Unique ID for the transaction
(= Foreign key and part of
primary key)

SpecimenPartID int

Optional: If the dataset is
related to a part of a
specimen, the ID of a related
part (= foreign key, see table
CollectionSpecimenPart)

IsOnLoan bit True if a specimen is on loan

LogInsertedBy nvarchar (50)

Name of user who first
entered (typed or imported)
the data.
Default value: user_name()

LogInsertedWhen smalldatetime

Date and time when the data
were first entered (typed or
imported) into this database.
Default value: getdate()

LogUpdatedBy nvarchar (50)
Name of user who last
updated the data.
Default value: user_name()

LogUpdatedWhen smalldatetime
Date and time when the data
were last updated.
Default value: getdate()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table Identification
The identifications of the organisms within a specimen

Column Data type Description

CollectionSpecimenID int
Refers to the ID of
CollectionSpecimen (= Foreign
key and part of primary key)

IdentificationUnitID int
Refers to the ID of
IdentficationUnit (= foreign
key and part of primary key)

IdentificationSequence smallint

The sequence of the
identifications. The last
identification (having the
highest sequence) is regarded
as valid
Default value: (1)

IdentificationDate datetime

The date of the identification
calculated from the entries in
IdentificationDay, -Month and
-Year

IdentificationDay tinyint The day of the identification
event

IdentificationMonth tinyint The month of the
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identification event

IdentificationYear smallint

The year of the identification
event. The year may be
empty if only the day or
month are known.

IdentificationDateSupplement nvarchar (255)

Verbal or additional
identification date information,
e.g. 'end of summer 1985',
'first quarter', '1888-1892'

IdentificationDateCategory nvarchar (50)

Category of the date of the
identification e.g. "system",
"estimated" (= foreign key,
see in table
CollDateCategory_Enum)

VernacularTerm nvarchar (255)

Name or term other than a
taxonomic (= scientific) name,
e.g. 'pine', 'limestone',
'conifer', 'hardwood'

TaxonomicName nvarchar (255)

Valid name of the species
(including the taxonomic
author where available).
Example: 'Rosa canina L.'

NameURI varchar (255)
The URI of the taxonomic
name, e.g. as provided by the
module DiversityTaxonNames.

IdentificationCategory nvarchar (50)

Category of the identification
e.g. 'determination',
'confirmation', 'absence' (=
foreign key, see table
CollIdentificationCategory_Enu
m)

IdentificationQualifier nvarchar (50)

Qualification of the
identification e.g. "cf."," aff.",
"sp. nov." (= foreign key, see
table
CollIdentificationQualifier_Enu
m)

TypeStatus nvarchar (50)

If identification unit is type of
a taxonomic name: holotype,
syntype, etc. (= foreign key,
see table
CollTypeStatus_Enum)

TypeNotes nvarchar (MAX) Notes concerning the
typification of this specimen

ReferenceTitle nvarchar (255)

Publications or authoritative
opinions of scientist used
during the identification
process. Example: enter
'Schmeil-Fitschen 1995' if this
field flora was used.

ReferenceURI varchar (255)
The URI of the reference e.g.
as provided by the module
DiversityReferences

ReferenceDetails nvarchar (50) The exact location within the
reference, e.g. pages, plates
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Notes nvarchar (MAX)
User defined notes, e.g. the
reason for a re-determination
/ change of the name, etc.

ResponsibleName nvarchar (255)

Name of the person or
institution responsible for the
determination
Default value:
[dbo].[CurrentUserName]()

ResponsibleAgentURI varchar (255)

URI of the person or
institution responsible for the
determination (= foreign key)
as stored in the module
DiversityAgents.

LogCreatedWhen datetime
Date and time when the
dataset was created
Default value: getdate()

LogCreatedBy nvarchar (50)
Login of the user who created
the dataset
Default value: user_name()

LogUpdatedWhen datetime
Date and time when the
dataset was changed
Default value: getdate()

LogUpdatedBy nvarchar (50)
Login of the user who
changed the dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table IdentificationUnit
Organism that is present in or on a collection specimen

Column Data type Description

CollectionSpecimenID int
Refers to the ID of
CollectionSpecimen (= Foreign
key and part of primary key)

IdentificationUnitID int

ID of the identification unit (=
part of Primary key). Usually
one of possibly several
organisms present on the
collection specimen. Example:
parasite with hyperparasite on
plant leaf = 3 units,

LastIdentificationCache nvarchar (255) The last identification as
entered in table Identification

FamilyCache nvarchar (255)

A cached value of the family
of the taxon of the last
identification. Can be set by
the editor if NameURI in table
Identification is NULL,
otherwise set by the system.

OrderCache nvarchar (255) A cached value of the order

Page 330



of the taxon of the last
identification. Can be set by
the editor if NameURI in table
Identification is NULL,
otherwise set by the system.

TaxonomicGroup nvarchar (50)

Taxonomic group the organism
identified by this unit belongs
to. Groups listed in table
CollTaxonomicGroup_Enum (=
foreign key)

OnlyObserved bit

True if the organism was only
observed rather than
collected. It is therefore not
present on the preserved
specimen. Example: Tree
under which the collected
mycorrhizal fungus grew.
Default value: (0)

RelatedUnitID int

The IdentificationUnitID of the
organism or substrate, on
which this organism is growing
(= foreign key)

RelationType nvarchar (50)

The relation of an unit to its
substrate, e.g. parasitism,
symbiosis etc. as stored in
CollRelationType_Enum (=
foreign key)

ColonisedSubstratePart nvarchar (255)

If a substrate association
exists: part of the substrate
that is affected in the
interaction (e.g. 'leaves' if a
fungus is growing on the
leaves of an infected plant)

LifeStage nvarchar (255)

Examples: 'II, III' for spore
generations of rusts or 'seed',
'seedling' etc. for higher
plants

Gender nvarchar (50) The gender of the
identification unit, e.g. 'male'

NumberOfUnits smallint
The number of units of this
identification unit, e.g. 400
beetle in a bottle

ExsiccataNumber nvarchar (50)
If specimen is an exsiccata:
Number of current specimen
within the exsiccata series

ExsiccataIdentification smallint

Refers to the
IdentificationSequence in
Identification (= foreign key).
The name under which the
collection specimen resp. this
unit is published within an
exsiccata.

UnitIdentifier nvarchar (50)

An identifier for the
identification of the unit e.g.
a number painted on a tree
within an experimental plot

Page 331



UnitDescription nvarchar (50)

Description of the unit, esp. if
not the an organism but parts
or remnants of it were present
or observed, e.g. a nest of an
insect or a song of a bird

Circumstances nvarchar (50) Circumstances of the
occurence of the organism

DisplayOrder smallint

The sequence in which the
units within this specimen will
appear on e.g. a label where
the first unit may be printed in
the header and others in the
text below. 0 means the unit
should not appear on a label.
Default value: (1)

Notes nvarchar (MAX)

Further information on the
identification unit or
interaction, e. g. infection
symptoms like 'producing galls'

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table IdentificationUnitAnalysis
The analysis values taken from an identification unit

Column Data type Description

CollectionSpecimenID int
Refers to the ID of
CollectionSpecimen (= Foreign
key and part of primary key)

IdentificationUnitID int
Refers to the ID of
IdentficationUnit (= foreign
key and part of primary key)

AnalysisID int Analysis ID, foreign key of
table Analysis.

AnalysisNumber nvarchar (50) Number of the analysis

AnalysisResult nvarchar (MAX) The result of the analysis

ExternalAnalysisURI varchar (255)
An URI for an analysis as
defined in an external
datasoure
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ResponsibleName nvarchar (255)

Name of the person or
institution responsible for the
determination
Default value:
[dbo].[CurrentUserName]()

ResponsibleAgentURI varchar (255)

URI of the person or
institution responsible for the
determination (= foreign key)
as stored in the module
DiversityAgents.

AnalysisDate nvarchar (50) The date of the analysis

SpecimenPartID int

ID of the part of a specimen
(optional, Foreign key) if the
analysis was done with a part
of the specimen (see table
CollectionSpecimenPart).

Notes nvarchar (MAX) Notes concerning this analysis

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table IdentificationUnitGeoAnalysis
The geographical position or region of an organism at a certain time

Column Data type Description

CollectionSpecimenID int
Refers to the ID of
CollectionSpecimen (= Foreign
key and part of primary key)

IdentificationUnitID int
Refers to the ID of
IdentficationUnit (= foreign
key and part of primary key)

AnalysisDate datetime The date of the analysis

Geography geography

The geography of the
identification unit according to
WGS84, e.g. a point (latitide,
longitude and altitude)

Geometry geometry (MAX) The geometry of the
identifiction unit, e.g. an area

ResponsibleName nvarchar (255) Name of the person or
institution responsible for the
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determination

ResponsibleAgentURI varchar (255)

URI of the person or
institution responsible for the
determination (= foreign key)
as stored in the module
DiversityAgents.

Notes nvarchar (MAX) Notes concerning this analysis

LogCreatedWhen datetime The time when this dataset
was created

LogCreatedBy nvarchar (50) Who created this dataset

LogUpdatedWhen datetime The last time when this
dataset was updated

LogUpdatedBy nvarchar (50) Who was the last to update
this dataset

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table IdentificationUnitInPart
The list of the organisms that are found in a part of the specimen

Column Data type Description

CollectionSpecimenID int
Refers to the ID of
CollectionSpecimen (= Foreign
key and part of primary key)

IdentificationUnitID int

ID of the identification unit (=
part of Primary key). Usually
one of possibly several
organisms present on the
collection specimen. Example:
parasite with hyperparasite on
plant leaf = 3 units,

SpecimenPartID int

ID of the part of a specimen
(optional, Foreign key) if the
identification unit is located
on a part of the specimen
(see table
CollectionSpecimenPart).

DisplayOrder smallint

The sequence in which the
units within this part will
appear on e.g. a label where
the first unit may be printed in
the header and others in the
text below. 0 means the unit
should not appear on a label.
Default value: (1)

Description nvarchar (500)

A description of the unit, esp.
if not a whole unit but e.g.
parts of it are stored in the
collection, e.g. a nest of a
bird

LogInsertedBy nvarchar (50) Name of user who first
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entered (typed or imported)
the data.
Default value: user_name()

LogInsertedWhen smalldatetime

Date and time when the data
were first entered (typed or
imported) into this database.
Default value: getdate()

LogUpdatedBy nvarchar (50)
Name of user who last
updated the data.
Default value: user_name()

LogUpdatedWhen smalldatetime
Date and time when the data
were last updated.
Default value: getdate()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table LocalisationSystem
The geographic localisation systems, e.g. coordinates

Column Data type Description

LocalisationSystemID int Unique ID for the localisation
system (= Primary key)

LocalisationSystemParentID int LocalisationSystemID of the
superior LocalisationSystem

LocalisationSystemName nvarchar (100)

Name of the system used for
the determination of the place
of the collection, e. g.
Gauss-Krüger, MTB, GIS

DefaultAccuracyOfLocalisation nvarchar (50)
The default for the accuracy
of values that can be reached
with this method

DefaultMeasurementUnit nvarchar (50)
The default measurement unit
for the localisation system,
e.g. m, geograpic coordinates

ParsingMethodName nvarchar (50)

Internal value, specifying a
programming method used for
parsing text in fields
Location1/Location2 in table
CollectionLocalisation

DisplayText nvarchar (50)
Short abbreviated description
of the localisation system as
displayed in the user interface

DisplayEnable bit

Specifies if this item is
enabled to be used within the
database.
LocalisationSystems can be
disabled to avoid seeing them,
but to keep the definition for
the future.

DisplayOrder smallint The order in which the entries
are displayed. The order may
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be changed at any time, but
all values must be unique.

Description nvarchar (255) Description of the localisation
method

DisplayTextLocation1 nvarchar (50)

Short abbreviated description
of the attribute Location1 in
the table CollectionGeography
as displayed in the user
interface

DescriptionLocation1 nvarchar (255)

Description of the attribute
Location1 in the table
CollectionGeography as
displayed in the user interface

DisplayTextLocation2 nvarchar (50)

Short abbreviated description
of the attribute Location2 in
the table CollectionGeography
as displayed in the user
interface

DescriptionLocation2 nvarchar (255)

Description of the attribute
Location2 in the table
CollectionGeography as
displayed in the user interface

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table Processing
The processings of the specimen

Column Data type Description

ProcessingID int ID of the processing (Primary
key)

ProcessingParentID int The ID of the superior type of
the processing

DisplayText nvarchar (50)
The display text of the
processing as shown e.g. in a
user interface

Description nvarchar (MAX) Description of the processing

Notes nvarchar (MAX) Notes about the processing

ProcessingURI varchar (255)
An URI for a processing as
defined in an external
datasource

OnlyHierarchy bit

If the entry is only used for
the hierarchical arrangement
of the entries
Default value: (0)

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()
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LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table ProcessingMaterialCategory
The processings that are possible for a certain material category

Column Data type Description

ProcessingID int

ID of the processing. Refers
to ProcessingID in table
Processing (foreign key)
Default value: (1)

MaterialCategory nvarchar (50)

Material category of
specimen. Examples:
'herbarium sheets', 'drawings',
'microscopic slides' etc.
Default value: N'specimen'

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table ProjectAnalysis
The types of the analysis that are available for a project

Column Data type Description

AnalysisID int ID of the analysis (Primary
key)

ProjectID int

ID of the project to which the
specimen belongs (Projects
are defined in
DiversityProjects)

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime The last time when this
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dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table ProjectProcessing
The types of processing available within a project

Column Data type Description

ProcessingID int ID of the Processing (Primary
key)

ProjectID int

ID of the project to which the
specimen belongs (Projects
are defined in
DiversityProjects)

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table Property
The list of the properties that can be specified for the collection site

Column Data type Description

PropertyID int Unique ID for the localisation
system (= Primary key)

PropertyParentID int LocalisationSystemID of the
superior LocalisationSystem

PropertyName nvarchar (100)

Name of the system used for
the determination of the place
of the collection, e. g.
Gauss-Krüger, MTB, GIS

DefaultAccuracyOfProperty nvarchar (50) The default for the accuracy
of values that can be reached
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with this method

DefaultMeasurementUnit nvarchar (50)
The default measurement unit
for the characterisation
system, e.g. pH

ParsingMethodName nvarchar (50)

Internal value, specifying a
programming method used for
parsing text in fields
Location1/Location2 in table
CollectionLocalisation

DisplayText nvarchar (50)
Short abbreviated description
of the localisation system as
displayed in the user interface

DisplayEnabled bit

Specifies if this item is
enabled to be used within the
database.
LocalisationSystems can be
disabled to avoid seeing them,
but to keep the definition for
the future.

DisplayOrder smallint

The order in which the entries
are displayed. The order may
be changed at any time, but
all values must be unique.

Description nvarchar (255) Description of the localisation
method

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table Transaction
Transactions like loan, borrow, gift, exchange etc. of specimen if they are
e.g. permanently or temporary transfered from one collection to another

Column Data type Description

TransactionID int Unique ID for the transaction
(= Primary key)

ParentTransactionID int

The ID of a preceeding
transaction of a superior
transaction if transactions are
organized in a hierarchy

TransactionType nvarchar (50)

Type of the transaction e.g.
gift in or out, exchange in or
out, purchase in or out
Default value: N'exchange'

TransactionTitle nvarchar (200)
The title of the transaction as
e.g. shown in an user
interface

ReportingCategory nvarchar (50)

A group defined for the
transaction, e. g. a taxonomic
group as used for exchange
balancing

AdministratingCollectionID int ID of the collection thas is
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responsible for the
administration of the
transaction.

MaterialDescription nvarchar (MAX)

ID of the project to which the
transaction belongs (Projects
are defined in
DiversityProjects)
Default value: ''

MaterialCategory nvarchar (50)

Material category of
specimen. Examples:
'herbarium sheets', 'drawings',
'microscopic slides' etc.
Default value: N'specimen'

MaterialCollectors nvarchar (MAX) The collectors of the material

FromCollectionID int

The ID of the collection from
which the specimen were
transfered, e.g. the donating
collection of a gift

FromTransactionPartnerName nvarchar (255)

Name of the person or
institution from which the
specimen were transfered,
e.g. the donator of a gift

FromTransactionPartnerAgent
URI varchar (255)

The URI of the transaction
partner (see e.g. module
DiversityAgents)

FromTransactionNumber nvarchar (50)

Number or code by which a
transaction may be recorded
by the administration of the
source of the specimen, e.g.
the donating collection of a
gift

ToCollectionID int

The ID of the collection to
which the specimen were
transfered, e.g. the receiver
of a gift

ToTransactionPartnerName nvarchar (255)

Name of the person or
institution to which the
specimen were transfered,
e.g. the receiver of a gift

ToTransactionPartnerAgentUR
I varchar (255)

The URI of the transaction
partner (see e.g. module
DiversityAgents)

ToTransactionNumber nvarchar (50)

Number or code by which a
transaction may be recorded
by the administration of the
destination of the specimen,
e.g. the receiving collection of
a gift

NumberOfUnits smallint
The number of units that were
(initially) included in the
transaction

Investigator nvarchar (50)
The investigator for whose
study a transacted material
was sent
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TransactionComment nvarchar (MAX)
Comments about the
exchanged material addressed
to the transaction partner

BeginDate datetime Date when the transaction
started

AgreedEndDate datetime
End of the transaction period,
e.g. if the time for borrowing
the specimen is restricted

ActualEndDate datetime

Actual end of the transaction
when e.g. the borrowed
specimen were returned to
the owner

InternalNotes nvarchar (MAX)
Internal notes about this
transaction, not to be
published e.g. on a web page

ResponsibleName nvarchar (255) The person responsible for
this transaction

ResponsibleAgentURI varchar (255)

The URI of the person, team
or organisation responsible for
the data (see e.g. module
DiversityAgents)

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table TransactionDocument
The history of transactions resp. the documents connected to the
transactions

Column Data type Description

TransactionID int

Unique ID for the Transaction,
refers to table Transaction (=
Part of primary key and
foreign key)

Date datetime The date of the event of a
transaction

TransactionText nvarchar (MAX) The text of a transaction
document

TransactionDocument image (2147483647) A scanned document
connected to this transaction
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event

InternalNotes nvarchar (MAX) Internal notes about this
transaction event

LogCreatedWhen datetime
The time when this dataset
was created
Default value: getdate()

LogCreatedBy nvarchar (50) Who created this dataset
Default value: user_name()

LogUpdatedWhen datetime
The last time when this
dataset was updated
Default value: getdate()

LogUpdatedBy nvarchar (50)
Who was the last to update
this dataset
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()
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Database - Project related tables
Information concerning the projects and related tables are stored in the tables shown in the
diagram below.

 

 

Index
 CollectionProject

 ProjectAnalysis

 ProjectProcessing

 ProjectProxy

 ProjectUser

 UserProxy

Table CollectionProject
The projects which the collection specimen were placed in

Column Data type Description

CollectionSpecimenID int
ID of the CollectionSpecimen
(= Foreign key and part of
primary key)
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ProjectID int

ID of the project to which the
specimen belongs (Projects
are defined in
DiversityProjects)

LogCreatedWhen datetime
Point in time when this data
set was created
Default value: getdate()

LogCreatedBy nvarchar (50)
Name of the creator of this
data set
Default value: user_name()

LogUpdatedWhen datetime
Point in time when this data
set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50)
Name of the person to update
this data set last
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table ProjectAnalysis
The types of the analysis that are available for a project

Column Data type Description

AnalysisID int ID of the analysis (Primary
key)

ProjectID int

ID of the project to which the
specimen belongs (Projects
are defined in
DiversityProjects)

LogCreatedWhen datetime
Point in time when this data
set was created
Default value: getdate()

LogCreatedBy nvarchar (50)
Name of the creator of this
data set
Default value: user_name()

LogUpdatedWhen datetime
Point in time when this data
set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50)
Name of the person to update
this data set last
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table ProjectProcessing
The types of processing available within a project
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Column Data type Description

ProcessingID int ID of the processing (Primary
key)

ProjectID int

ID of the project to which the
specimen belongs (Projects
are defined in
DiversityProjects)

LogCreatedWhen datetime
Point in time when this data
set was created
Default value: getdate()

LogCreatedBy nvarchar (50)
Name of the creator of this
data set
Default value: user_name()

LogUpdatedWhen datetime
Point in time when this data
set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50)
Name of the person to update
this data set last
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table ProjectProxy
The projects as stored in the module DiversityProjects

Column Data type Description

ProjectID int

ID of the project to which the
specimen belongs (Projects
are defined in
DiversityProjects)

Project nvarchar (50)

Name or title of the project as
shown in a user interface
(Projects are defined in
DiversityProjects)

ImageDescriptionTemplate xml (MAX) Template for the description
of images

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table ProjectUser
The projects a user can access

Column Data type Description

LoginName nvarchar (50)
Login name of the user to
access DivesityWorkbench,
Microsoft domains, etc..
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ProjectID int

ID of the project to which the
specimen belongs (Projects
are defined in
DiversityProjects)

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table UserProxy
The user as stored in the module DiversityUsers

Column Data type Description

LoginName nvarchar (50)
Login name of the user to
access DivesityWorkbench,
Microsoft domains, etc..

CombinedNameCache nvarchar (255)
Short name of the user, e.g.
P. Smith
Default value: NULL

UserURI varchar (255)

URI of the user in a remote
module, e.g. refering to
UserInfo.UserID in database
DiversityUsers

AgentURI varchar (255) AgentURI - UserProxy

Queries xml (MAX) Queries created by the user

RowGUID uniqueidentifier
-
Default value:
newsequentialid()
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Database - Entity tables
Information concerning the entities are stored in the tables shown in the diagram below. 

Table Entity
The entities in an application e.g. the tables and columns in a database

Column Data type Description

Entity varchar (500)

Name of the entity, e.g. Table.Column.Content within
the database or a unique string for e.g. a message
within the DiversityWorkbench (e.g.
"DiversityWorkbench.Message.Connection.NoAccess"),
primary key

DisplayGroup nvarchar (50) Name of the group, if DiversityWorkbench entities should
be displayed in a group.

Notes nvarchar (MAX) Notes about the entity

Obsolete bit True if an entity is obsolete. Obsolete entities may be
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kept to ensure compatibility with older modules

LogCreatedWhen datetime Point in time when this data set was created
Default value: getdate()

LogCreatedBy nvarchar (50) Name of the creator of this data set
Default value: user_name()

LogUpdatedWhen datetime Point in time when this data set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50) Name of the person to update this data set last
Default value: user_name()

RowGUID uniqueidentifier -
Default value: newsequentialid()

Table EntityRepresentation
The description of the entity in a certain context in different languages

Column Data type Description

Entity varchar (500) Name of the entity. Foreign
key, relates to table Entity

LanguageCode nvarchar (50) ISO 639: 2-letter codes for
the language of the content

EntityContext nvarchar (50)

Context for the
representation, e.g.
"Exchange with ABCD",
"collection management" or
"observation" as defined in
table EntityContext_Enum

DisplayText nvarchar (50) Text for the entity as shown
e.g. in a user interface

Abbreviation nvarchar (20) Abbreviation for the entity as
shown e.g. in a user interface

Description nvarchar (MAX) Description of the entity

Notes nvarchar (MAX) Notes about the
representation of the entity

LogCreatedWhen datetime
Point in time when this data
set was created
Default value: getdate()

LogCreatedBy nvarchar (50)
Name of the creator of this
data set
Default value: user_name()

LogUpdatedWhen datetime
Point in time when this data
set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50)
Name of the person to update
this data set last
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()
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Table EntityUsage
The usage of an entity in a certain context, e.g. hidden, read only

Column Data type Description

Entity varchar (500) Name of the entity. Foreign
key, relates to table Entity

EntityContext nvarchar (50)

Context for the
representation, e.g.
"Exchange with ABCD",
"collection management" or
"observation" as defined in
table EntityContext_Enum

Accessibility nvarchar (50)

Whether the access to an
entity is resticted to e.g. read
only or can be edited without
restrictions

Determination nvarchar (50)
Whether a value is determined
e.g. by the system or the
user

Visibility nvarchar (50)
Whether the entity is visible
or hidden from e.g. a user
interface

PresetValue nvarchar (500)

Whether a value resp. SQL
statement for the value is
preset, e.g. 'determination' for
identifications when using a
mobile device during an
expedition

Notes nvarchar (MAX) Notes about the usage of the
entity

LogCreatedWhen datetime
Point in time when this data
set was created
Default value: getdate()

LogCreatedBy nvarchar (50)
Name of the creator of this
data set
Default value: user_name()

LogUpdatedWhen datetime
Point in time when this data
set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50)
Name of the person to update
this data set last
Default value: user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()
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History
To inspect the history of a data set click on the button. A window will open showing all
former states of the data in tables with the current data set at the top. The database
DiversityCollection handles 2 different histories - one for the CollectionSpecimen and one for
the CollectionEvent. The version shown in the header of the main window refers to these

histories . The first number refers to the version of the specimen. If an
event was defined a second number is shown, referring to the version of the CollectionEvent
e.g. 5  3 means version 5 of the specimen and version 3 of the CollectionEvent. 

If you want to restore an old version of a data set, choose the corresponding line in the table
and click on the Restore data as in selected line button.

  

The version will be set automatically. If a data set is changed the version will be increased if
the last changes were done by a different user or the last change is more than 24 hours ago
(for further details see topic Logging).
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Backup
If you want to create a backup of your database, there are 2 options. You may either export
the data as csv files to your local computer or you may create a backup on the server.

Export data as csv

To export your data as csv files to your local computer, choose Data -> Export -> 
CSV(bcp) ... from the menu. A window will open as shown below, where you can select the
tables that should be exported. Click on the Start Export button to export your data. If you
choose the option as shown below 2 files will be created for every table. The first file (*.csv)
contains the data while the second file (*.xml) contains the structure of the table.

Create backup on the server

To create a backup of your database on the server, choose Data -> Backup database
from the menu. This will create a SQL-Server backup on the server where the database is
located. Ensure that there is enough space on the server. 

Another option is to create a direct copy of the database files on the server. For this you
have to use the functions provided by SQL-Server. However, you need administration rights
for the database you want to create a backup of. Open the Enterprise Manager for
SQL-Server, choose the database and detach it from the server as shown in the image below.
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After detaching the database, you can save a copy of the ..._Data.MDF file to keep it as a
backup.

After storing the backup you have to re-attach the database.

A dialog will appear where you have to select the original database file in your directory.
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Logging
Changes within the database will be documented for each data set together with the time and
the responsible user in the columns shown in the image below.

All main tables have a corresponding logging table. If you change or delete a data set, the
orignial data set will be stored in this logging table together with information about by whom
and when changes were made last.
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Version of data sets
The Version of a data set consists of two parts, e.g. 3 / 1 as shown in the header of the
specimen in the main form. The first number refers to the version of the data set as stored in
table CollectionSpecimen. The second number refers to the version as stored in table
CollectionEvent. Both versions will be set to a higher number if the data in the tables
themselves or in dependent tables are changed. Thus, if a new identification is inserted in the
table Identification the specimen number of the version will increase from 3 to 4 resulting in a
version 4 / 1 for the whole data set. The changes in the version will only occur if the last
changes in the data were more than 24 hours ago or a different user is changing the data.
This ensures that a user can change several parts in a data set within 24 hours and the
version will only be increased by 1.

The data is stored in the tables CollectionSpecimen and CollectionEvent.
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Database - Application tables
Information concerning the predefined queries for users are stored in the table shown in the
diagram below. 

Table ApplicationSearchSelectionStrings
Selection strings for customized queries for users

Column Data type Description

UserName varchar (50) Name of the user who created this SQL string
Default value: user_name()

SQLStringIdentifier varchar (50) Identifier for the selection string as shown in a user
interface

ItemTable varchar (50)
Main table from which the data sets should be
selected
Default value: 'TaxonName'

SQLString varchar (MAX) SQL string for selecting data sets from the
database

Description nvarchar (MAX) Description of the results set and the purpose of
the query

LogCreatedWhen datetime Point in time when this data set was created
Default value: getdate()

LogCreatedBy nvarchar (50) Name of the creator of this data set
Default value: user_name()

LogUpdatedWhen datetime Point in time when this data set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50) Name of the person to update this data set last
Default value: user_name()
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Diversity Workbench
The Diversity Workbench is composed of components for building and managing biodiversity
information, each of which focuses on a particular domain. Each component can provide
services to the other components. DiversityCollection can link data to the
modules DiversityExsiccatae, DiversityGazetteer, DiversityScientificTerms,
DiversityTaxonNames, DiversityAgents and DiversityReferences as illustrated in the image
below.

The modules communicate with each other to provide their services for the other modules.
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Modules
The DiversityWorkbench is a set of components for building and managing biodiversity
information, each of which focuses on a particular domain.

Dive
rsity
Age
nts

Administration of the agents, i.e. people and institutions which should be documented with e.g. their addresses

Dive
rsity
Coll
ecti
on

Administration of the scientific collections and specimens within these collections

Dive
rsity
Exsi
ccat
ae

Administration of exsiccatal series

Dive
rsity
Gaze
tteer

A data collection to enable the linking of geographical records with the Getty Thesaurus of Geographical Names (TGN), the German GN250 database and other sources of
geographical names

Dive
rsity
Scie
ntifi
cTer
ms

Data collections of scientific terms from foreign sources like vegetation, stratigraphy, soil science etc. 

Dive
rsity
Refe
renc
es

Administration of references

Dive
rsity
Tax
onN
ame
s

Administration of taxonomic names, their synonyms and hier archical position

Each module provides services for the other modules. To use the service of a module you
require access to the database of the module and optionally the module application placed in
your application directory. 

In the figure shown below the connections to other modules within DiversityCollection are
indicated.
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Module related entry
The DiversityWorkbench is a set of components for building and managing biodiversity
information, each of which focuses on a particular domain. Each module provides services for
the other modules. To use the service of a module you need access to the database of the
module and optionally the module application placed in your application directory. Entries
related to an external module have a standard interface in the main form. There are 3 states
of this interface:

1 - the value is only set in the local database with no connection to the remote module

In this state you may either type the value or select it from the values which are already
available in the database. To get a list of the available values type the beginning of the value

(you may use wildcards) and click on the button. If you wish to set a relation to the
remote module, click on the button. A window will open where you may select an entry
from the foreign database. 

 

2 - the value is related to the remote module

If the value has a relation to the remote module, the interface will appear as shown above. To
release the connection to the remote module click on the button. If you require further
information on the value, click on the button. This will open a form showing an overview of
the related value. 
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If the client application of the module is available, you may inspect the details of the entry.
To start the client application of the remote module simply click on the button.  

 

3 - relation to a webservice

Some modules provide the possibility to link your data to an external webservice. For example,
DiversityTaxonNames gives you access to the taxonomic names of IndexFungorum. To
establish a connection to an external webservice click on the button. As with the link to
modules within the DiversityWorkbench, a window will open where you are able to choose from
either DiversityWorkbench modules or external Webservices. See Webservice for further
details
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Reference
Details about References are stored in the module DiversityReferences. You may choose one
of the entries in this module from the picklist. To directly change to DiversityReferences click

on  . 

For access to the references from other modules you require the application 
DiversityReferences.exe in your application directory. To use the application
DiversityReferences.exe you require access to the database DiversityReferences. For more
information see the DiversityWorkbench Portal. 
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Webservice - foreign sources
Some modules within the DiversityWorkbench provide the possibility to link your data to an
external webservice. For example DiversityTaxonNames gives you access to the taxonomic
names of Index Fungorum. To establish a connection to an external webservice click on the 

button. A window will open where you may choose from either DiversityWorkbench modules
or external Webservices. The provided webservices currently are:

Index Fungorum 

The Palaeontology Database 

The Catalogue of Life 
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Index Fungorum - webservice
Some modules within the DiversityWorkbench provide the possibility to link your data to an
external webservice. For example DiversityTaxonNames gives you access to the taxonomic
names of Index Fungorum. To establish a connection to this webservice, click on the 
button. A window will open where you may choose Index Fungorum from the database list
(see below).  

Enter the query restriction for the name in the Name field in Query conditions. The maximum

number of records you receive may be set in the max. results field (choose a
low number, if you have a slow connection to the internet). Click on the search button to
start the query. In the list in the left upper part the results of the query will be listed. In the
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right part of the window additional information is shown as provided by the webservice. For
certain entries buttons will appear, as e.g. shown above for the basionym and the current
name of a scientific name. Click on these buttons, if you wish to change to one of these
related data sets from the webservice. If available, the information provided on the
corresponding website is shown in the lower part. To include the link from the webservice into
your database choose one of the entries and click OK. The entry will change as shown below.

If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. 

To receive the entire information related to this entry as provided by the webservice click on

the button. A window will open as shown below where information on the webservice is
listed. If available, the lower part will show the corresponding information of a website.

If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 
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Catalogue of Life - webservice 
DiversityWorkbench provides the possibility to link your data to an external webservice. The
webservice provided by the Catalogue of Life is possible through the module
DiversityTaxonNames. To establish a connection to this external webservice click on the 
button. A window will open where you may choose this webservice (see below). 

In the field Name in Query conditions enter your search string and click on the button to
start the query. In the list of the left upper part the results of the query will be listed. In the
right part of the window additional information is shown as provided by the webservice. If
available, the lower part of the window will show the webpage of the related information. 
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For higher taxa and synonyms the accepted name will be shown as e.g. shown above. To
inspect one of these entries click on the linked entry of the ID - in the example above ID: 695
. To include the link from the webservice into your database choose one of the entries in the
list and click OK. The entry will change as shown below.

If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. 

To receive the information related to an entry as provided by the webservice click on the 
button. A window will open as shown below where information on the webservice is listed in
the upper part. If available, additional information provided on a corresponding website will be
shown in the lower part.
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If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 
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The Palaeontolgy Database - webservice 
DiversityWorkbench provides the possibility to link your data to an external webservice. The
webservice provided by the Palaeontology Database is possible through the module
DiversityTaxonNames. To establish a connection to this external webservice click on the 
button. A window will open where you may choose this webservice (see below). 

In the field Name in Query conditions enter you search string and click on the button to
start the query. In the list of the left upper part the results of the query will be listed. In the
right part of the window additional information is shown as provided by the webservice. The
lower part of the window will show the webpage of the related information. 
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For synonyms the accepted name will be shown as well as shown above. To change to the
accepted name click on the linked entry of the ID - in the example above ID: 57254. To
include the link from the webservice into your database choose one of the entries in the list
and click OK. The entry will change as shown below.

If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. 

To receive the information related to an entry as provided by the webservice click on the 
button. A window will open as shown below where information on the webservice is listed in
the upper part. If available, additional information provided on a corresponding website will be
shown in the lower part.
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If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 
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